Verify that you have the most current version of this document. Go to
https://accounts.automatedlogic.com, then select Support > Download > Documents > Software Documents.
Important changes are listed in Document revision history at the end of this document.

© 2015 Automated Logic Corporation. All rights reserved throughout the world.
The contents of this guide and the associated Automated Logic software are property of Automated Logic Corporation and its respective licensors, and are protected by copyright. For more information on the software and licensing, see the About section in the software's Help menu.

Automated Logic, WebCTRL, EIKON, Eco-Screen, and BACview are registered trademarks of Automated Logic Corporation. EnergyReports and Environmental Index are trademarks of Automated Logic Corporation. BACnet is a registered trademark of ASHRAE. All other trademarks are the property of their respective owners.
The content of this guide is furnished for informational use only and is subject to change without notice. Automated Logic Corporation assumes no responsibility or liability for any errors or inaccuracies that may appear in the informational content contained in this guide.
# Contents

What is a WebCTRL® system? ................................................................. 8
  A typical WebCTRL® system ................................................................. 9
  WebCTRL® editions and optional packages ........................................ 10
  WebCTRL® tools ................................................................................ 11

What’s new in v6.0 ................................................................................ 14
  What’s new in the WebCTRL® application ......................................... 14
  What’s new in the EIKON® application ............................................... 18
  What’s new in the SiteBuilder application ......................................... 18
  What’s new in the ViewBuilder application ....................................... 19
  What’s new—Other tools ................................................................. 19

Using a tablet with a WebCTRL® system ............................................ 21

Running WebCTRL® Server ................................................................ 23
  To start the WebCTRL® system ....................................................... 23
  To send a message to logged in operators ........................................ 23
  To log off an operator ..................................................................... 24
  To shut down a system ................................................................. 24

Getting to know the interface ............................................................. 25
  Navigation trees ............................................................................... 26
  Navigating the system .................................................................... 27
  Tree icons and hover text .............................................................. 27
  To show, hide, or resize the navigation tree ...................................... 29
  Zooming in and out ........................................................................ 29
  Using right-click menus .............................................................. 29
  To print the action pane .............................................................. 30
  Colors and status in the WebCTRL® interface .............................. 30
  Colors and setpoints ................................................................. 31

Working with equipment ..................................................................... 32

Graphics pages .................................................................................. 34
  To attach a graphic in the WebCTRL® interface .............................. 35
  To edit a graphic on a WebCTRL® client ........................................ 36
  To organize multiple graphics for a tree item ................................. 36
  To control equipment using an interactive zone sensor .............. 37

Properties pages ............................................................................... 39
  To view or edit properties ............................................................. 39
  Point types ..................................................................................... 40

Logic pages ......................................................................................... 42
  To view a Logic page ..................................................................... 42
  To locate a microblock, section, or label ........................................ 42
  To change properties, alarms, or trends ....................................... 42
  Using a Logic page to troubleshoot .............................................. 43

Changing multiple microblock properties ........................................ 44
  To use Global Modify ..................................................................... 44
  To use Global Copy ...................................................................... 46

Downloading to controllers ................................................................. 47
  Download Options ........................................................................... 48
  To download from the Downloads page .......................................... 48
  To download from a Properties page ............................................ 49
  If a controller fails to download ..................................................... 50

Checking controller status .................................................................. 51
  Status messages ............................................................................ 51
  To resolve a mismatch ................................................................... 54

Setpoints ............................................................................................ 55
  To change programmed setpoints .............................................. 55
  Optimal Start ............................................................................... 56
To create an Equipment Summary report.......................... 122
To create an Equipment Values report.......................... 123
To create a Trend Samples report.............................. 125
To save a custom report’s design for use in another location or system .................. 126
To edit or delete a custom report............................... 127
To organize custom reports ........................................... 128

Operator access .................................................................................................................. 129

Privilege sets ...................................................................................................................... 129
  Privileges ......................................................................................................................... 130
  To add or edit a privilege set ......................................................................................... 133
  To delete a privilege set ................................................................................................. 133

Operators and operator groups .................................................................................. 133
  To add or edit an operator ............................................................................................. 134
  To delete an operator ..................................................................................................... 135
  To add or edit an operator group .................................................................................. 135
  To delete an operator group .......................................................................................... 135

To change My Settings........................................................................................................ 136

Advanced security ........................................................................................................... 138
  Location-dependent operator access .......................................................................... 138
  Recording reasons for edits (21 CFR Part 11) ....................................................... 142
  Advanced password policy ......................................................................................... 142

Cost-saving strategies ...................................................................................................... 144

Advanced topics .............................................................................................................. 145

Manual commands ......................................................................................................... 146

Running the WebCTRL® autopilot ................................................................................. 154
  To set up the WebCTRL® autopilot ............................................................................ 154
  To run the WebCTRL® autopilot ................................................................................. 155
  To run autopilot with Windows Vista ........................................................................... 155

Using WAP devices with the WebCTRL® system ......................................................... 156
  Supported WebCTRL® features ................................................................................. 156
  To dial up a WebCTRL® system using WAP ............................................................... 156
  To navigate the system ................................................................................................. 158
  To view and edit Alarms ............................................................................................... 159
  To view and edit equipment properties ....................................................................... 159

System database maintenance ....................................................................................... 160
  To back up a system ....................................................................................................... 160
  To compact and defragment ......................................................................................... 160
  To minimize the database size ..................................................................................... 161

Setting up WebCTRL® client devices and web browsers ............................................ 162
  Setting up and using a computer with the WebCTRL® system .................................. 163
  Using a tablet with a WebCTRL® system .................................................................... 164
  Setting up and using a web browser to view the WebCTRL® interface ...................... 165
    To set up and use Internet Explorer ........................................................................... 165
    To set up and use Mozilla Firefox ............................................................................. 167
    To set up and use Google Chrome ............................................................................ 168
    To set up and use Safari .............................................................................................. 169

Setting up a system in the WebCTRL® Interface ............................................................. 171
  System Settings ............................................................................................................ 171
    General tab .................................................................................................................. 171
    Security tab ................................................................................................................ 173
    Communications tab ................................................................................................. 175
    Scheduled Tasks tab ................................................................................................. 176
    Daylight Saving tab ................................................................................................. 177
    Add-ons tab ................................................................................................................ 177
  To set up site properties ............................................................................................... 179
  To register your WebCTRL® software ....................................................................... 179
    To replace the license when adding features ............................................................ 180
Adding links or text to the WebCTRL® login page ................................................................. 181
To add links to the login page .............................................................................................. 181
To add text to the login page ................................................................................................. 182

Editing a system remotely .................................................................................................. 183
Editing the Geographic or Network tree ........................................................................ 183
To import a clipping ............................................................................................................ 184
Managing files on a remote WebCTRL® server ............................................................. 186

Running WebCTRL Server as a Windows® service .......................................................... 187
To install WebCTRL® Server service ............................................................................... 187
To start WebCTRL® Server as a Windows service ......................................................... 188
To set up the service for network printing ........................................................................ 188
To remove WebCTRL® Server service ........................................................................... 189
To determine if WebCTRL® Server service is installed .................................................... 189

Working with control programs in the WebCTRL® interface ............................................ 190
To add a control program to a controller ............................................................................ 190
To replace an existing control program ............................................................................ 191
To edit a control program ................................................................................................. 192

Working with drivers in the WebCTRL® interface ............................................................ 193
To change or upgrade a driver .......................................................................................... 193

Working with touchscreen or BACview® files in the WebCTRL® Interface .................... 195
To select a different screen file ......................................................................................... 195
To edit a screen file on a WebCTRL® client ....................................................................... 196

Setting up a system for non-English languages ............................................................... 197
Installing a language pack ................................................................................................. 197
Preparing your workstation for non-English text ............................................................ 197
Creating control programs and translation files for a non-English system ...................... 199
To enter a key term in the EIKON® application .................................................................. 199
Translation files ................................................................................................................. 199
To create and implement a translation file ....................................................................... 200
Creating graphics for a non-English system ..................................................................... 201
Creating a non-English graphic in ViewBuilder ............................................................... 201
Creating a graphic for a multi-language system using WebCTRL® extensions for FrontPage ......................................................................................................................... 202
Creating a non-English system in SiteBuilder .................................................................. 203
To choose the language(s) for your system ..................................................................... 203
To create your system ........................................................................................................ 203
System language ................................................................................................................ 203
To set an operator's language in the WebCTRL® interface ............................................. 204
Editing translation files, control programs, or graphics for a non-English system .......... 204
To edit a bundled resource ............................................................................................... 204
Editing an EIKON® for WebCTRL control program in the EIKON® application ............. 204
Copying translation files to another system ..................................................................... 205

Web services ....................................................................................................................... 206
Using web services to retrieve or change data .................................................................. 206
WebCTRL® privilege requirements .................................................................................... 206
WebCTRL® data access using SOAP .................................................................................. 207
Example using web services to set a value ........................................................................ 211
Step 1: Create a spreadsheet ............................................................................................... 212
Step 2: Create a macro ........................................................................................................ 213
Step 3: Run the macro ......................................................................................................... 214
Example using web services to retrieve values ................................................................. 214
Step 1: Create a spreadsheet ............................................................................................... 214
Step 2: Create a macro ........................................................................................................ 215
Step 3: Run the macro ......................................................................................................... 216
Example using web services to retrieve trend data ............................................................ 217
Step 1: Create a spreadsheet ............................................................................................... 217
Step 2: Create a macro ........................................................................................................ 217
What is a WebCTRL® system?

A WebCTRL® system is a web-based building automation system that can be accessed from anywhere in the world through a web browser, without the need for special software on the workstation. Through the web browser, you can perform building management functions such as:

- adjust setpoints and other control parameters
- set and change schedules
- graphically trend important building conditions
- view and acknowledge alarms
- run preconfigured and custom reports on energy usage, occupant overrides, tenant billing, and much more
A typical WebCTRL® system

A WebCTRL® system uses a network of microprocessor-based controllers to control heating, air conditioning, lighting, and other facility systems. A web-based server communicates with these controllers and generates the WebCTRL® interface that the user can access through a web browser. Through the interface, you can gather information, change operating properties, run reports, and perform other building management functions on a single building, an entire campus, or a network of facilities that stretch around the globe.

A typical WebCTRL® system may include:

- **WebCTRL Server** runs WebCTRL Server application
- **WebCTRL clients** access WebCTRL Server as a website using a standard web browser such as Internet Explorer
- **Web services** allows other applications to access point and trend data from the WebCTRL Server
- **Protocols**
  - ALC Legacy
  - BACnet
  - XML/SOAP
  - HTTP
  - WML/WAP
- **Ethemet TCP/IP**
- **ARCNET 156K baud**
  - ME line multi-equipment controller
  - SE line single-equipment controller
  - BACview6 displays values and allows editing of properties
  - AAR routes communications between ARCNET networks
  - ZN line routes communications between BACNet networks
  - LGR router routes communications between BACnet networks
- **RS Standard**
- **ZN**
- **RS Pro**
- **ME-LGR** communicates with non-BACNet systems and devices
  - To 3rd party network that does not use BACNet—MODBUS, LON, or others
The WebCTRL® client uses a web browser to access the WebCTRL® Server application as a website. Access and security options may include:

- WebCTRL® editions and optional packages
  - WebCTRL® v6.0 supports all the same features and options in systems with fewer than 500 points. Points include all input and output points tied into the system, regardless of vendor.
  - WebCTRL® 500 supports all the same features and options in systems with fewer than 500 points. Points include all input and output points tied into the system, regardless of vendor.

- Unlimited simultaneous users
- Multiple operating systems and databases
- Built-in alarming, trending, and reporting
- International languages (International English, Canadian French, French, German, Italian, Japanese, Korean, Russian, Traditional and Simplified Chinese, Spanish, Swedish, Thai, Vietnamese)
- Third-party integration
- WAP-enabled devices
- Secure server access using TLS
- Optional WebCTRL® packages listed below

WebCTRL® editions and optional packages

A WebCTRL® system supports:

- Unlimited simultaneous users
- Multiple operating systems and databases
- Built-in alarming, trending, and reporting
- International languages (International English, Canadian French, French, German, Italian, Japanese, Korean, Russian, Traditional and Simplified Chinese, Spanish, Swedish, Thai, Vietnamese)
- Third-party integration
- WAP-enabled devices
- Secure server access using TLS
- Optional WebCTRL® packages listed below
### Optional WebCTRL® packages

<table>
<thead>
<tr>
<th>Package</th>
<th>Capabilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Reporting</td>
<td>Configurable report designer for making environmental reports. Available</td>
</tr>
<tr>
<td></td>
<td>report types:</td>
</tr>
<tr>
<td></td>
<td>• Equipment Values (page 123)</td>
</tr>
<tr>
<td></td>
<td>• Trend Samples (page 125)</td>
</tr>
<tr>
<td>Advanced Security</td>
<td>• Location-dependent operator access (page 138)</td>
</tr>
<tr>
<td></td>
<td>• Configurable password policies (page 142)</td>
</tr>
<tr>
<td></td>
<td>• Requirement of operator comments and operator verification prior to</td>
</tr>
<tr>
<td></td>
<td>accepting system changes (page 142)</td>
</tr>
<tr>
<td>Advanced Alarming</td>
<td>The following alarm actions:</td>
</tr>
<tr>
<td></td>
<td>• Send SNMP trap (page 96)</td>
</tr>
<tr>
<td></td>
<td>• Write property (page 97)</td>
</tr>
<tr>
<td></td>
<td>• Write to database (page 98)</td>
</tr>
<tr>
<td></td>
<td>In addition to running an alarm action when an alarm or return-to-normal</td>
</tr>
<tr>
<td></td>
<td>occur, alarm actions can be set to run:</td>
</tr>
<tr>
<td></td>
<td>• After a delay period</td>
</tr>
<tr>
<td></td>
<td>• Based on a schedule group's occupancy status</td>
</tr>
</tbody>
</table>

**NOTE** An optional package is enabled when you *install the license* (page 179) that provides the optional package.

### WebCTRL® tools

A WebCTRL® system includes the following tools.

#### Design Tools

<table>
<thead>
<tr>
<th>Use...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>EIKON®</strong></td>
<td>Create control programs and Properties pages.</td>
</tr>
<tr>
<td><strong>ViewBuilder</strong></td>
<td>Create graphics, touchscreens, and BACview® screens.</td>
</tr>
<tr>
<td><strong>ViewBuilder for WAP</strong></td>
<td>Customize pages for WAP-enabled devices.</td>
</tr>
<tr>
<td><strong>SiteBuilder</strong></td>
<td>Create and modify the system database and associate control programs</td>
</tr>
<tr>
<td></td>
<td>and graphics with equipment.</td>
</tr>
<tr>
<td><strong>Third-Party BACnet Utility</strong></td>
<td>Use discovered BACnet information to choose and address microblocks for third party BACnet integration.</td>
</tr>
<tr>
<td>Use...</td>
<td>To...</td>
</tr>
<tr>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td><strong>EquipmentBuilder</strong></td>
<td>Generate the following files from a library of pre-defined applications.</td>
</tr>
<tr>
<td></td>
<td>• Control program (.equipment)</td>
</tr>
<tr>
<td></td>
<td>• Graphic (.view)</td>
</tr>
<tr>
<td></td>
<td>• BACView® file (.bacview), if applicable to the equipment</td>
</tr>
<tr>
<td></td>
<td>• Sequence of operation (.odt)</td>
</tr>
<tr>
<td></td>
<td>• Visio schematic (.vdx)</td>
</tr>
</tbody>
</table>
# Start-up, Commissioning, and Service Tools

<table>
<thead>
<tr>
<th>Use...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field Assistant</strong></td>
<td>Service or start up and commission a piece of equipment or a partial network of controllers.</td>
</tr>
<tr>
<td><strong>Test &amp; Balance</strong></td>
<td>Calibrate airflow in VAV zone controllers, commission air terminals, and override reheat and terminal fans.</td>
</tr>
<tr>
<td><strong>Virtual BACview®</strong></td>
<td>Let your laptop serve as a local interface to a single piece of equipment.</td>
</tr>
</tbody>
</table>
# What's new in v6.0

## What's new in the WebCTRL® application

<table>
<thead>
<tr>
<th>Feature</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>New look</td>
<td>The WebCTRL® interface has been updated.</td>
</tr>
</tbody>
</table>
| Supports multiple web browsers (page 162) | A WebCTRL® system can now be viewed through the following web browsers on a computer with a Windows®, Linux®, or OS X® operating system:  
  - Internet Explorer® v8 or later  
  - Mozilla® Firefox® v21.0 or later  
  - Safari® v6 or later (Mac only)  
  - Google™ Chrome™ v23.0 or later  
  **NOTE** WebCTRL® v6.0 no longer supports Internet Explorer 6 or 7. |
| Tablet support (page 21) | You can now view and control your WebCTRL® system on tablets that have the following operating systems and web browsers.  
| Operating system | Web browser | Tested tablet* |
| iOS | Safari® | Apple® iPad® |
| Windows® RT | Internet Explorer® 10/11 or Metro-style Internet Explorer® 10/11 | Microsoft® Surface™ |
| Windows® 8 or 8.1 Pro | Internet Explorer® 10/11 or Metro-style Internet Explorer® 10/11 | Microsoft® Surface™ Pro |
| Android™ | Google™ Chrome™ | Google™ Nexus™ 7 and 10 |

* Touch functionality of tablets not tested by Automated Logic® may or may not work for WebCTRL® use. Use at your own risk.  
  Click here (page 21) for information on tablet behavior and limitations. |
| Time-lapse (page 117) | Time-lapse now has its own icon on the WebCTRL® toolbar for easier access. |
| Trends (page 76) | The Trends interface has been revised for improved usability and multiple web browser support. |
| Deleting trend graphs and custom reports | Instead of using the Delete option on the WebCTRL® menu, you now:  
  - Click the Delete Trend Graph button on the trend graph's Configure tab.  
  - Click the Delete Report button on the report's Design tab. |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Improvement</th>
</tr>
</thead>
</table>
| Reports Administration page                 | The **Reports Administration** page in the **System Configuration** tree has been removed. Previously, you could install the following 2 add-in reports from this page:  
  - Historical Trends Report - This report has been removed. The same information can be found in the **Reports > Equipment > Trend Usage** report.  
  - Equipment Sources Report - You can now get this report by right-clicking the navigation tree. |
| Alarms (page 78)                             | The Alarms View interface has been redesigned with many usability improvements including:  
  - Navigate forward and backward 50 alarms at a time and scroll within the 50 currently displayed  
  - Acknowledge, delete, or force normal apply to all selected alarms.  
  - Single-click to expand an alarm instead of double-click.  
  - The alarm category icons have been updated. Level 1 through 5 icons have been added for custom alarm categories (page 107). |
<p>| Email alarm action (page 93)                 | If an Email alarm action is to attach a report, the file name of the attached report will now include the report name, date, and time. For example, <strong>Alarm Sources 2012 Jan 01 1230</strong>. |
| Schedules (page 60)                          | The Schedules interface has been revised for improved usability.                                                                                |
| Automatically download schedules as you create them (page 136) | This field has moved from the <strong>System Settings &gt; General</strong> tab to the <strong>My Settings</strong> page because it is a user choice. |
| Default view (page 35)                       | If a tree item has multiple graphics, you can now change the default view in WebCTRL® that was originally defined in SiteBuilder. |
| Change My Settings privilege (page 130)      | An operator must have this new privilege to edit his preferences on the My Settings page. This new feature lets an administrator set up a guest user that does not have this privilege. Multiple people can use the guest login, but none can change the password or other preferences. |
| Location Audit Log Report                    | You can now include or exclude Schedule Group activity in the Location Audit Log Report.                                                        |
| Saving report designs (page 126)             | You can now save the design of an Equipment Values or Trend Samples report for reuse in another location or another system.                     |
| Properties page &gt; Network Points tab        | The <strong>Com Enabled</strong> column has a new <strong>All</strong> checkbox to let you quickly enable/disable all points in the control program.                     |
| System Settings                              | Some fields have been moved to another tab, and some tabs have been restructured to improve usability.                                          |
| System Settings &gt; Add-ons (page 177)         | The <strong>Web Applications</strong> tab has been renamed to <strong>Add-ons</strong> and redesigned.                                                                 |</p>
<table>
<thead>
<tr>
<th>Feature</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add-ons</td>
<td>Previously-installed versions of EnergyReports, Phasor Graphic, Psychrometric Chart, and Tenant Override Billing must be upgraded to be compatible with v6.0. (The upgraded versions will have a .addon extension which has a different folder structure than previous .war versions.) Other web application add-ons may require an upgrade (check with the add-on author). Add-ons must be installed and enabled on the new System Settings &gt; Add-ons page after upgrade. See &quot;To update an add-on&quot; in help for the System Settings &gt; Add-ons tab (page 177).</td>
</tr>
<tr>
<td>Updates</td>
<td>You can now use the System Configuration tree's <strong>Update</strong> feature to update all drivers, graphic libraries, and Help in addition to patches and service packs.</td>
</tr>
<tr>
<td>View DST Dates (page 179)</td>
<td>If the site's time zone uses Daylight Saving Time, a new <strong>View DST Dates</strong> button on the site's <strong>Properties</strong> page shows DST information and time change dates.</td>
</tr>
<tr>
<td>Import/Export calibration data</td>
<td>You can export I/O point calibration data from a control program and import it into the same control program or another control program with the same I/O point configuration.</td>
</tr>
<tr>
<td>BACnet Discovery</td>
<td>BACnet Discovery is now on the <strong>Advanced</strong> tab of the <strong>Devices</strong> page.</td>
</tr>
<tr>
<td>Downloading an AAR or AMR</td>
<td>An AAR or AMR will now download before any controllers on its downstream ARCNET or MS/TP network.</td>
</tr>
<tr>
<td>bacnet showindex manual command</td>
<td>This new command shows all files (file name, size, date) downloaded to the selected controller.</td>
</tr>
<tr>
<td>BACnet Operator Workstation Protocol Revision 12 Support</td>
<td>BACnet communication and BACnet discovery now allow the WebCTRL® server to be tested by BTL for Protocol Revision 12 support.</td>
</tr>
<tr>
<td>BACnet binding</td>
<td>The WebCTRL® application now uses dynamic binding for communication between devices unless your system uses NAT routing. If using NAT, the WebCTRL® application uses information in its database to bind BACnet devices.</td>
</tr>
</tbody>
</table>

The **Use Static BACnet Bindings** checkbox on the System Settings > Communications tab has been removed. If your system previously used Static binding and does not use NAT routing, it will automatically change to dynamic binding on upgrade. No re-engineering is required. Previously, third-party BACnet integration applications with Display microblocks required static binding and a modeled third-party network tree in SiteBuilder. The above changes eliminated these requirements.

⚠️ **CAUTION** Before upgrading to v6.0, uncheck the **Use Static BACnet Bindings** checkbox, restart the BACnet connection, and then immediately run the Controller Status report to verify that you have no communication problems. If you do, contact Automated Logic® Technical Support.
## Feature | Improvement
--- | ---
**Password security** | Password security has been enhanced, affecting the following:
- If WebCTRL® Server is v6.0 and an Alarm Notification Client (ANC) is an earlier version, clicking the button in ANC that opens the WebCTRL® interface will require you to log in.
- If you are in the process of upgrading hierarchical servers and not all servers are running WebCTRL® v6.0, you will be required to log in when you navigate between the servers.
- During the time that the hierarchical servers are running different WebCTRL® versions, alarm actions and schedules will not propagate between servers, and you must check **Do not synchronize operator and privileges** on the **System Settings > Security** tab.

**Security enhancement** | Apache Tomcat web server has been upgraded to v7.0.30

**Java** | The WebCTRL® application has been upgraded to Java 7.

**FrontPage graphic support for multiple web browsers** | If your system has .jsp graphics that were created with WebCTRL® Extensions for FrontPage, the graphics will be upgraded when you upgrade your system. However, if you edit one of these graphics after you upgrade, you must run one of the **upgradejsp manual commands** (page 146).

**Legacy graphic support for multiple web browsers** | If you upgrade to v6.0 and your system has legacy graphics, you must upgrade your InterOp® graphics in SiteBuilder.

**Custom reports created with Formula One, Report Designer, or e.Spreadsheet** | The WebCTRL® application no longer supports custom reports created with Formula One, Report Designer, or e.Spreadsheet. If needed, you can use WebCTRL® custom reports, create reports using web services, or create an add-on.

**Help changes** | - Help is available only from each application in your WebCTRL® product suite. It is no longer available from your Start menu.
- WebCTRL® Help previously had a section called SuperVision® Support. WebCTRL® Help now includes only what a user can see and do in a converted legacy system. The full SuperVision® Support that includes how to convert and configure a legacy system is now a PDF available at http://accounts.automatedlogic.com/download under **Documents > Manuals**.
- BACnet Basics has been removed from help and is now a PDF available at http://accounts.automatedlogic.com/download under **Training Materials > Networking**.
### What's new in the EIKON® application

<table>
<thead>
<tr>
<th>Feature</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name change</td>
<td>EIKON® LogicBuilder is now just EIKON®.</td>
</tr>
<tr>
<td>COV trending setup in the EIKON® application</td>
<td>COV can now be set at design time in microblocks and in the Microblock Common Properties Editor.</td>
</tr>
<tr>
<td>Trend historian notification setup in the EIKON® application</td>
<td>Historian notification thresholds can now be set at design time in microblocks with trend objects and in the Edit Common Properties dialog box.</td>
</tr>
<tr>
<td>Revised ZN rules</td>
<td>Most of the previous ZN rules have been eliminated.</td>
</tr>
<tr>
<td>Microblock Common Properties Editor</td>
<td>To improve this feature's performance, selecting a point in this window no longer automatically selects the microblock in the control program. You now select the point and then choose the <strong>Select Microblock on Canvas</strong> option to locate the microblock.</td>
</tr>
<tr>
<td>Updates</td>
<td>The <strong>Help &gt; Apply Update</strong> menu now lets you update all drivers, graphic libraries, and Help in addition to patches and service packs.</td>
</tr>
<tr>
<td>Help</td>
<td>You no longer have to specify a web browser to view Help. Help now opens in your default browser.</td>
</tr>
</tbody>
</table>

### What's new in the SiteBuilder application

<table>
<thead>
<tr>
<th>Feature</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP IP addressing</td>
<td>With the v6.0 drivers, our BACnet routers can have IP addresses assigned by a DHCP server. To use DHCP addressing, you must set the router's <strong>Default/Assigned</strong> DIP switch to <strong>Default</strong>. In SiteBuilder, you must select the option <strong>Specify a custom or DHCP IP Address</strong>. (This option is currently called <strong>Specify an IP Address</strong> but may be renamed for v6.0 final release.)</td>
</tr>
<tr>
<td>Point count</td>
<td>Point packs are no longer required for third-party integration using older controllers, so the point count in SiteBuilder no longer includes integration points.</td>
</tr>
<tr>
<td>Upgrade</td>
<td>You can upgrade a v3.0 or later system directly to v6.0. Earlier versions require multiple upgrade steps.</td>
</tr>
<tr>
<td>Updates</td>
<td>The <strong>Help &gt; Apply Update</strong> menu now lets you update all drivers, graphic libraries, and Help in addition to patches and service packs.</td>
</tr>
<tr>
<td>Help</td>
<td>You no longer have to specify a web browser to view Help. Help now opens in your default browser.</td>
</tr>
</tbody>
</table>
### What's new in the ViewBuilder application

<table>
<thead>
<tr>
<th>Feature</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Touch screens</td>
<td>You can create a custom interface for the System Touch, an interactive device that can act as a front-end interface to controllers on a BACnet network.</td>
</tr>
<tr>
<td>Equipment Touch screens</td>
<td>You can create a custom interface for the Equipment Touch, an interactive device that can be attached to a controller to view or change its property values, schedule equipment, view trends, and more without needing a system's server.</td>
</tr>
<tr>
<td>Graphic alignment in the</td>
<td>Cross-browser support required a change to graphic alignment in the WebCTRL® interface. Graphics that previously aligned to the center of the WebCTRL® action pane now align to the top of the action pane. If you upgrade to v6.0 and have a graphic with content outside the top gray line border in ViewBuilder, the content will no longer be visible in the WebCTRL® interface. You must change the size of the graphic for the content to be visible.</td>
</tr>
<tr>
<td>WebCTRL® interface</td>
<td></td>
</tr>
<tr>
<td>Image on top of hotspots</td>
<td>You can place an image on top of another image that has hotspots, such as a floorplan, without blocking the hotspots.</td>
</tr>
<tr>
<td>Exporting an image</td>
<td>You can now export an image from the main ViewBuilder workspace or from the Associations window.</td>
</tr>
<tr>
<td>Font selection</td>
<td>Font selections in ViewBuilder affect only what you see in ViewBuilder. In the WebCTRL® interface, the font will be replaced with a similar web-safe font. However, font size and style (bold, italic, underline) selections in ViewBuilder will apply in the WebCTRL® interface.</td>
</tr>
<tr>
<td>Updates</td>
<td>The Help &gt; Apply Update menu now lets you update all drivers, graphic libraries, and Help in addition to patches and service packs.</td>
</tr>
<tr>
<td>Help</td>
<td>You no longer have to specify a web browser to view Help. Help now launches in your default browser.</td>
</tr>
</tbody>
</table>

### What's new–Other tools

<table>
<thead>
<tr>
<th>Feature</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Assistant</td>
<td>The interface has been updated</td>
</tr>
<tr>
<td>New look</td>
<td>The interface has been updated</td>
</tr>
<tr>
<td>BACnet Discovery</td>
<td>You can now run BACnet Discovery at the system level in the tree to discover BACnet devices. BACnet Discovery is on the Advanced tab of the Devices page.</td>
</tr>
<tr>
<td>Feature</td>
<td>Improvement</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Alarm Notification Client</td>
<td>WebCTRL® password security has been enhanced, affecting the following:</td>
</tr>
<tr>
<td></td>
<td>• After upgrading Alarm Notification Client to v6.0, you will need to reenter your operator name and password in Alarm Notification Client (ANC) while ANC is connected to the WebCTRL Server application.</td>
</tr>
<tr>
<td></td>
<td>• If the WebCTRL Server application is v6.0 and ANC is an earlier version, clicking the button in ANC that opens the WebCTRL® interface will require you to log in.</td>
</tr>
</tbody>
</table>
Using a tablet with a WebCTRL® system

You can view your WebCTRL® system on tablets that have the following operating systems and web browsers, but some functionality may be changed or limited. Issues with each tablet are discussed below.

<table>
<thead>
<tr>
<th>Tablet operating system</th>
<th>Web browser</th>
<th>Tested tablet*</th>
</tr>
</thead>
<tbody>
<tr>
<td>iOS</td>
<td>Safari® v6 or later</td>
<td>Apple® iPad®</td>
</tr>
<tr>
<td>Windows® RT</td>
<td>Internet Explorer® 10/11 or Metro-style Internet Explorer® 10/11</td>
<td>Microsoft® Surface</td>
</tr>
<tr>
<td>Windows® 8 or 8.1 Pro</td>
<td>Internet Explorer® 10/11 or Metro-style Internet Explorer® 10/11</td>
<td>Microsoft® Surface™ Pro</td>
</tr>
<tr>
<td>Android™</td>
<td>Google™ Chrome™ v23.0 or later</td>
<td>Google™ Nexus™ 7 and 10</td>
</tr>
</tbody>
</table>

* Touch functionality of tablets not tested by Automated Logic® may or may not work with WebCTRL®. Use at your own risk.

All tablets

- To access the right-click menu for:
  - The action pane—Touch and hold the item for several seconds.
  - A tree item—Select the item first, then touch and hold the item for several seconds.

- Audible alarms do not generate a sound.
- Firefox currently has many problems supporting touch gestures on tablets.
- To clear the browser's cache, see Setting up and using a web browser to view the WebCTRL® interface (page 165).

iPad

- Double-tap to zoom in/out.

- The Jump To feature does not work in Safari® on an iPad® due to way Safari handles JavaScript on secondary tabs.

- A WebCTRL® feature that opens a pop-up window on a computer (for example, Global Modify) will open in a new tab in Safari.

  **NOTE** Some of these features will present the message *This site is attempting to open a pop-up window*. Select *Allow* to continue.
• iOS restricts access to a file system so WebCTRL® features that upload or download files on a computer client are disabled on an iPad. This applies to the following configuration features:
  ○ Configure > Edit Existing or Add New (views, control programs, screen files, drivers)
  ○ Import clipping
  ○ System Settings > General > Source Files > Export or Import
  ○ System Settings > General > Logs > Download
  ○ System Settings > Security > Permissions > Add
  ○ System Settings > Daylight Saving > Import
  ○ System Settings > Add-ons > Install Add-on
  ○ License Administration > Browse
  ○ Update (patches, service packs, drivers, language packs, graphics libraries, help)
  ○ Reports saved as XLS

• iOS does not support plug-ins (Java Runtime Environment, Flash, etc.) so some WebCTRL® add-on applications will not work on an iPad.

**Microsoft Surface and Surface Pro**

• Pinch-zoom works on individual frames, instead of the whole screen. This means you can zoom and scroll the navigation pane and action pane separately.

• The Surface RT and IE 10 or 11 Metro do not support plug-ins (Java Runtime Environment, Flash, PDF reader, etc.) so the following features will not work.
  ○ Some WebCTRL® add-on applications
  ○ The Reports page PDF button

You can use the Surface Pro with IE 10 or 11 Desktop if you need these features.

• If browser text is too small, use Ctrl + to increase Internet Explorer's zoom level, then reload the page.

**Google Nexus**

• The Nexus does not support plug-ins (Java Runtime Environment, Flash, PDF reader, etc.) so the following features will not work.
  ○ Some WebCTRL® add-on applications
  ○ The Reports page PDF button
Running WebCTRL® Server

The WebCTRL Server application communicates with the system's controllers and accesses and maintains the system database. You view and edit the system in client web browsers. WebCTRL Server must be running for an operator to log in from a web browser.

The application's **Current Users, Connections, and Output** tabs let you monitor the status of the system. Output information is continually archived to `WebCTRLx.x/logs\WEBSERVER.log`.

**NOTE** The instructions below are for a system that has been designed and set up. While designing a system, you can run the WebCTRL® application without communicating with the system's controllers. See Options for running a WebCTRL® system.

To start the WebCTRL® system

1. Click **Start > All Programs > WebCTRL x.x > WebCTRL Server**.

   **TIP** If you run the WebCTRL Server application as a Windows® service, your computer can automatically start the application every time the computer starts. See *Running WebCTRL Server as a Windows service* (page 187).

2. Open a web browser on one or more client computers.

3. Verify that your web browser is set up to display the WebCTRL® interface. See *Setting up WebCTRL® client devices and web browsers* (page 162).

4. Type the WebCTRL® server’s address in the web browser's address field.

   **NOTE** You can type http://localhost if WebCTRL Server and the web browser are running on the same computer.

5. Enter a **Name** and **Password**.

To send a message to logged in operators

Messages are delivered immediately to WebCTRL® client web browsers. You can send multiple messages, but the operator must click **Ok** for the first message before the next message can be delivered. If the web browser window is minimized, the message is not visible.

1. On the WebCTRL Server application's **Current Users** tab, click beside the user you want to send a message to. Or, click **Notify All Users**.

2. Type a message.

3. Click **Ok**.
To log off an operator

From the WebCTRL Server application
NOTE The operator will be logged off without warning.
1 On the WebCTRL Server Current Users tab, right-click the operator, then select Log Off User.
2 Click Yes.

From the WebCTRL® interface
NOTE The operator will be logged off without warning.
1 In the WebCTRL® interface, press Ctrl+M.
2 Type whoson in the manual command field.
3 Obtain the ID number of the operator you want to log off.
4 Press Ctrl+M.
5 Type logoffuser x (where x is the ID number).
6 Click OK.

To shut down a system
1 In the WebCTRL Server application, select Server > Shut Down.
2 Optional: Select a delay option, then edit the Notification message.
3 Click Shut Down.
Getting to know the interface

NOTES

- After you log in, you will see the page defined as your starting location on the **My Settings** page. To change your opening page, see *To change My Settings* (page 136).
- Privileges control what an operator can see or do in the WebCTRL® system. If you cannot see or do something that you read about in Help, ask your System Administrator to check your privileges.
Navigation trees

The WebCTRL® interface has 4 navigation trees.

Geographic tree
This tree lets you navigate through the WebCTRL® interface using the system's geographic layout.

Network tree
This tree lets you navigate through the WebCTRL® interface using the system's network layout.

Schedule Groups tree
On this tree, you can create groups that can consist of areas, equipment, or other groups. You can then assign a schedule to the entire group instead of the individual items. See To apply a schedule to a group of items (page 62).

System Configuration tree
Most of the items on this tree are used for the setup and maintenance of your system.

<table>
<thead>
<tr>
<th>My Settings</th>
<th>Lets you change settings that are specific to you such as your password, viewing preferences and contact information. See To change My Settings (page 136).</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Settings</td>
<td>Contains the system-wide settings that control the way the WebCTRL® system runs. See System Settings (page 171).</td>
</tr>
<tr>
<td>Operators Privilege Sets Operator Groups</td>
<td>Lets your system administrator define operators and what they can see and do in the WebCTRL® interface. See Operator access (page 129).</td>
</tr>
<tr>
<td>Categories</td>
<td>Lets you define categories for schedules (page 67), alarms (page 107), graphics (page 36), properties, trends (page 75), and reports (page 128). Categories allow you to view or control groups of similar items.</td>
</tr>
<tr>
<td>Alarm Templates</td>
<td>See If you upgraded alarms from v2.0 or earlier (page 109).</td>
</tr>
<tr>
<td>Connections</td>
<td>Lets you set up, start/stop, and troubleshoot your network connections. See Setting up networks.</td>
</tr>
<tr>
<td>Services</td>
<td>Shows internal processes of the WebCTRL® application for troubleshooting.</td>
</tr>
<tr>
<td>License Administration</td>
<td>Lets you update your WebCTRL® license. See To register your WebCTRL® software (page 179).</td>
</tr>
<tr>
<td>Update</td>
<td>Click Update to select and apply patch, service packs, drivers, language packs, graphics libraries, and Help updates.</td>
</tr>
<tr>
<td>Hierarchical Servers</td>
<td>If your system has hierarchical servers, this page shows the servers that your server is connected to.</td>
</tr>
<tr>
<td>Client Installs</td>
<td>Lets you install applications that are to run on client computers.</td>
</tr>
</tbody>
</table>
Navigating the system

NOTE Use only the WebCTRL® interface to navigate; do not use the web browser’s navigation buttons.

To navigate to an item in the system

1 Select an item on the Geographic or Network tree.

NOTE The Schedule Groups and System Configuration trees are used to set up your system.

2 Use the action buttons and their drop-down menus to navigate to specific types of information about the selected tree item.

3 Use the tabs to filter the information further.

To navigate using links

Click links to jump to related pages.

<table>
<thead>
<tr>
<th>On a Graphics page</th>
<th>On a Properties page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Graphics Page" /></td>
<td><img src="image2.png" alt="Properties Page" /></td>
</tr>
</tbody>
</table>

Tree icons and hover text

The navigation tree displays an icon to the left of each item to denote the type of item. For example:

- System
- Area
- Equipment

To select custom equipment icons in the WebCTRL® interface, right-click the equipment on the Geographic or Network tree, select Configure, then select the Icon. You can also select custom icons in the EIKON® application.
Optional icons

You can display the following icons to denote locations on the Geographic tree where items were created or assigned.

- Schedules
- Schedule Groups
- Trend Graphs
- Reports
- Alarm Actions
- Privileges

To turn on optional icons:

1. Right-click the Geographic tree.
2. Select Tree Display Options.
3. Select the desired Tree Icons.
4. Click Accept.

Optional hover text

If you turn on hover text, you can hold the cursor over a system, area, or equipment icon to display information about its item. The information displayed depends on which hover text options you select.

To turn on hover text:

1. Right-click the tree.
2. Select Tree Display Options.
3. Select the desired Tree Hover Text.
4. Click Accept.
To show, hide, or resize the navigation tree

Click at the top of the navigation tree to hide or show the tree. Click and drag the tab on the right side of the tree to adjust its width.

Zooming in and out

- To zoom in and out on the WebCTRL® interface:
  - Hold down Ctrl and press + or -. Press Ctrl+0 to return to 100%.
  - Hold down Ctrl while rolling your mouse wheel.
  - Use your web browser's zoom functions.
- If a graphic does not fit in the action pane, right-click it and select Scale to Fit to make it fit the action pane. Select Scale to Fit again to return the graphic to its original size.

Using right-click menus

You can right-click the following items to select options:

<table>
<thead>
<tr>
<th>A tree item</th>
<th>The action pane</th>
</tr>
</thead>
</table>
To print the action pane

Click at the top of the page to print the contents of the action pane. Set the print orientation to Landscape in the Print dialog box.

💡 TIP To print a Graphics page that exceeds the size of the action pane, right-click the graphic and select Scale to Fit.

Colors and status in the WebCTRL® interface

The following colors indicate equipment status on floor plans, equipment property pages, and some reports.

<table>
<thead>
<tr>
<th>Color</th>
<th>Color Name</th>
<th>Status Code</th>
<th>Condition Indicated</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Mustard Color" /></td>
<td>Mustard none</td>
<td></td>
<td>In equipment when running WebCTRL Design Server</td>
</tr>
<tr>
<td><img src="image" alt="Purple Color" /></td>
<td>Purple 0 or 15</td>
<td></td>
<td>In a controller—non-operational or no communications</td>
</tr>
<tr>
<td><img src="image" alt="Charcoal Color" /></td>
<td>Charcoal 14</td>
<td></td>
<td>In a controller—a download is required or is already in progress</td>
</tr>
<tr>
<td><img src="image" alt="Coral Color" /></td>
<td>Coral 13</td>
<td></td>
<td>In equipment—a controller has stopped</td>
</tr>
<tr>
<td><img src="image" alt="Red Color" /></td>
<td>Red 2 or 9</td>
<td></td>
<td>Control program error</td>
</tr>
<tr>
<td><img src="image" alt="Orange Color" /></td>
<td>Orange 8</td>
<td></td>
<td>Maximum cooling</td>
</tr>
</tbody>
</table>

**NOTE** If a zone controlled by a U line controller shows coral on a floor plan, the controller may be offline.
Colors and setpoints

Thermographic colors indicate how much a zone's actual temperature differs from its setpoints.

Five conditions may affect a zone's thermographic color:

- Setpoint adjust
- Timed local override (TLO)
- Optimal start
- Demand level
- Hysteresis

In the examples below, a zone's heating occupied setpoint is 70° and its cooling occupied setpoint is 74°.

<table>
<thead>
<tr>
<th>If you normally see...</th>
<th>when the zone temp is...</th>
<th>but...</th>
<th>then you will see...</th>
</tr>
</thead>
<tbody>
<tr>
<td>green</td>
<td>72.5°</td>
<td>someone adjusts the setpoints (for example, with a setpoint adjust of two degrees, the new setpoints would be 68 and 72°)</td>
<td>yellow</td>
</tr>
<tr>
<td>gray</td>
<td>73° (unoccupied)</td>
<td>someone presses the Override button on a zone sensor to use the occupied setpoints</td>
<td>green</td>
</tr>
<tr>
<td>gray</td>
<td>77° (unoccupied)</td>
<td>the zone is in optimal start and is ramping up to its occupied setpoint in the few hours before occupancy</td>
<td>an occupied color</td>
</tr>
<tr>
<td>yellow</td>
<td>75°</td>
<td>the zone's electric meter is in demand level 2 with relaxed setpoints of 68 and 76°</td>
<td>green</td>
</tr>
<tr>
<td>green</td>
<td>73.5°</td>
<td>cooling began when the temperature rose above 74° and the temperature has not yet dropped beyond the 1° hysteresis (to 73°)</td>
<td>yellow</td>
</tr>
</tbody>
</table>
Working with equipment

You can view and adjust equipment operation from the following pages:

Graphics pages (page 34)
You can view and adjust your essential building controls on most Graphics pages.

- **Thermographic floor plans** indicate the temperature of zones compared to their effective setpoints.

- **Equipment graphics** show the current status of mechanical equipment and often include an adjustable setpoint control or other editable properties.
Properties pages (page 39)
Each piece of equipment and each microblock has a Properties page. You can view and adjust more equipment properties on a Properties page than on its corresponding Graphics page.

Logic pages (page 42)
Logic pages show the control program for a piece of equipment. Use the sequence of control and yellow status values on the Logic pages for troubleshooting your mechanical equipment.

Microblock pop-ups
To open a microblock pop-up where you can view and change properties:
- Click a microblock on a Logic page.
- Click the bold, underlined microblock name on a Properties page.
- Right-click a value and then select Details.
Graphics pages

You can view and adjust your system from Graphics pages, which include navigation maps, floor plans, and equipment.

Some typical controls that may appear on a graphics page are:

- Button or switch to turn equipment on or off
- Input field to set a property value
- Drop-down list to select a state
- Interactive zone sensor to override an unoccupied schedule
- Setpoint graph to adjust setpoints
- Trend graph to view trend information
- Link to jump to another WebCTRL® page or to the Internet

NOTES

- Right-click a value, then select Details to view and change properties in the microblock pop-up.
- Right-click a value, then select Global Modify (page 44) to view and change the property in other control programs.

- A yellow dashed box around a value indicates the value is locked.
- If a graphic does not fit in the action pane, right-click it and select Scale to Fit to make it fit the action pane. Select Scale to Fit again to return the graphic to its original size.
To attach a graphic in the WebCTRL® interface

1. On the navigation tree, right-click the item that you want to attach a graphic to, then select Configure.

2. Equipment graphic only: If the system has other control programs of this type, select which control programs you want to change.

   - Change this control program only.
   - Change for all control programs of this type on this network only.
   - Change for all control programs of this type.

**NOTES**
- If the control program is in an IP router, the second option will change the graphic for all control programs of this type only on the IP network.
- If the control program is on the network below an IP router, the second option will not change the graphic for the router's control programs of this type.

3. Do one of the following:

   **If the graphic is...**
   
   - **In the Views Available list**
     a. Select the graphic, then click **Attach**.
     b. Click **Accept**.
   
   - **Not in the Views Available list**
     a. Click **Add New**.
     b. Browse to select the view file.
     c. Click **Open**.
     d. Click **Continue**.
     e. Click **Close**.
     f. Click **Close** again.

**NOTES**
- Select a graphic in the Attached list to edit the following information for the graphic:
  - **Display Name**—The name that appears in the Graphics button drop-down list
  - **Category**—The name of the category that multiple graphics may be sorted into in the Graphics button drop-down list
    
    **NOTE** Changes to Display Name or Category apply only in the WebCTRL® interface and are not retained if you export source files.
  - **Reference Name**—The name that is used to create links to the graphic in ViewBuilder
  - **Default View**—Sets the selected graphic as the default view if the tree item has multiple graphics. The default graphic is bolded in the Attached list.
    
    **NOTE** The default graphic is initially set in SiteBuilder.
  - **Included in download**—Equipment graphics only. Select to have the .view file included in an All Content download so that it can be uploaded by Field Assistant. The graphic will have beside it in the Attached list. Requires 4.x or later drivers.

- You can click **Delete Unused** at the bottom of the Views section to delete all unattached graphic files from your system.
To edit a graphic on a WebCTRL® client

On a WebCTRL® client, you can get a copy of a graphic from the server, edit it, then put it back on the server.

To get the graphic

1. On the WebCTRL® Geographic tree, right-click the item that the graphic is attached to, then select Configure.
2. At the bottom of the Views section, click Edit Existing.
3. Select the graphic you want to edit.
4. Click Save.
5. Browse to the folder you want to put the file in.
6. Click Save.
7. Click Close.
8. Click Close again.

To put the edited graphic back on the server

1. On the WebCTRL® Geographic tree, right-click the item that the graphic is attached to, then select Configure.
2. At the bottom of the Views section, click Add New.
3. Browse to select the .view file.
4. Click Open.
5. Click Continue.
6. Click Close.
7. Click Close again.

To organize multiple graphics for a tree item

In the WebCTRL® interface, you can create categories and assign graphics to them so that the Graphics button drop-down menu has the graphics arranged by category. This is typically done in ViewBuilder or SiteBuilder. See "To define WebCTRL® navigation" in ViewBuilder Help and "To attach graphic files" in SiteBuilder Help.

To add a Graphics category in the WebCTRL® interface

1. On the System Configuration tree, click to the left of the Categories folder, then select Graphic.
2. Click Add.
3. Type the Category Name and Reference Name.
Optional: Select a privilege so that only operators with that privilege can access graphics in the category.

Click Accept.

NOTES

- To edit a category, select the category, make your changes, then click Accept.
- To delete a category, select the category, click Delete, then click Accept.

To assign a graphic to a category in the WebCTRL® interface

1. On the Geographic tree, right-click the item that the graphic is attached to, then select Configure.
2. Under Views, select the graphic in the Attached list.
3. Select the category in the Category field.
4. Click Accept.

To control equipment using an interactive zone sensor

An equipment graphic may include an interactive zone sensor that provides you with the following control.

<table>
<thead>
<tr>
<th>If the sensor is a...</th>
<th>You can...</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Click ▲ to raise the setpoint or ▼ to lower the setpoint.</td>
</tr>
<tr>
<td></td>
<td>• Click ✿ to override the schedule and put the zone in an occupied state. To cancel an override, continue clicking ✿ until the display shows 0.</td>
</tr>
<tr>
<td></td>
<td>• See that the zone is in an occupied state when the green LED is lit.</td>
</tr>
</tbody>
</table>
### If the sensor is a...  
#### You can...

**RS Standard, Plus, or Pro**

- Click the **WARMER** or **COOLER** button to adjust the setpoint.
- Click the **MANUAL** button to override the schedule and put the zone in an occupied state.
- Click the **INFO** button to cycle through the following information:
  - Outside air temperature, if enabled in the control program
  - Override time remaining
  - Heating setpoint
  - Cooling setpoint
- See the **Occupied/Unoccupied** state in the display.

**RS Pro-F**

- Click the **WARMER** or **COOLER** button to adjust the setpoint.
- Click the **MANUAL** button to override the schedule and put the zone in an occupied state.
- Click the **INFO** button to cycle through information such as:
  - Outside air temperature
  - Override time remaining
  - Heating setpoint
  - Cooling setpoint
- Click the **FAN** button to adjust the fan speed.
- Click the **MODE** button to perform customer-specific functions.
- See the **Occupied/Unoccupied** state in the display.

**LogiStat**

- Click ▲ to raise the setpoint or ▼ to lower the setpoint.
- Click [light bulb] to override the schedule and put the zone in an occupied state.
- See that the zone is in an occupied state when the red LED is lit.
Properties pages

Properties pages are automatically generated from control programs created in the EIKON® application. Use Properties pages to:

- View the status of a piece of equipment. See Colors and status in the WebCTRL® interface (page 30).
- View or change the equipment or microblock properties currently stored in the controller
- Commission equipment

To view or edit properties

1. Select a piece of equipment or a microblock on the Geographic or Network tree, then click Properties.
   
   **NOTE** You must resolve any condition described in red text at the top of the page before a Properties page can obtain current information from its controller.

2. To change a property:
   - Click to show or hide a section as needed
   - Click microblock name to open its pop-up where you can change properties
   - Select or clear checkbox
   - Select item in drop-down list
   - Change text in text field

3. Click Accept.

NOTES

- Right-click a value, then select Details to view and change properties in the microblock pop-up.
- Right-click a value, then select Global Modify (page 44) to view and change the property in other control programs.
- A yellow dashed box around a value indicates the value is locked.
Point types

A point name on the Properties page is followed by a code that tells you the point type. The table below describes each code.

<table>
<thead>
<tr>
<th>Code</th>
<th>Point type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Al</td>
<td>Analog Input</td>
</tr>
<tr>
<td>ANI</td>
<td>Analog Network Input</td>
</tr>
<tr>
<td>ANI2</td>
<td>Analog Network Input 2</td>
</tr>
<tr>
<td>ANO</td>
<td>Analog Network Output</td>
</tr>
<tr>
<td>ANO2</td>
<td>Analog Network Output 2</td>
</tr>
<tr>
<td>A0</td>
<td>Analog Output</td>
</tr>
<tr>
<td>ASVI</td>
<td>BACnet Analog Sensed Value Input</td>
</tr>
<tr>
<td>AV</td>
<td>Analog Value</td>
</tr>
<tr>
<td>BAI</td>
<td>BACnet Analog Input</td>
</tr>
<tr>
<td>BALM</td>
<td>BACnet Alarm</td>
</tr>
<tr>
<td>BAO</td>
<td>BACnet Analog Output</td>
</tr>
<tr>
<td>BAV</td>
<td>BACnet Analog Value</td>
</tr>
<tr>
<td>BBI</td>
<td>BACnet Binary Input</td>
</tr>
<tr>
<td>BBO</td>
<td>BACnet Binary Output</td>
</tr>
<tr>
<td>BBV</td>
<td>BACnet Binary Value</td>
</tr>
<tr>
<td>BFM</td>
<td>Floating Motor</td>
</tr>
<tr>
<td>BI</td>
<td>Binary Input</td>
</tr>
<tr>
<td>BLSTAT</td>
<td>LogiStat Zone Sensor with Optional OAT Display</td>
</tr>
<tr>
<td>BMSV</td>
<td>BACnet Multi-State Value</td>
</tr>
<tr>
<td>BNI</td>
<td>Binary Network Input</td>
</tr>
<tr>
<td>BNI2</td>
<td>Binary Network Input 2</td>
</tr>
<tr>
<td>BNO</td>
<td>Binary Network Output</td>
</tr>
<tr>
<td>BNO2</td>
<td>Binary Network Output 2</td>
</tr>
<tr>
<td>Code</td>
<td>Point type</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>BO</td>
<td>Binary Output</td>
</tr>
<tr>
<td>BPTA</td>
<td>Pulse to Analog Input</td>
</tr>
<tr>
<td>BPWM</td>
<td>Pulse-Width Output</td>
</tr>
<tr>
<td>BRS</td>
<td>RS Sensor</td>
</tr>
<tr>
<td>BRSF</td>
<td>RS Sensor Fan</td>
</tr>
<tr>
<td>BSVI</td>
<td>BACnet Binary Sensed Value Input</td>
</tr>
<tr>
<td>BTLO</td>
<td>Timed Local Override</td>
</tr>
<tr>
<td>BTRN</td>
<td>Trend Log</td>
</tr>
<tr>
<td>BV</td>
<td>Binary Value</td>
</tr>
<tr>
<td>DI</td>
<td>Digital Input</td>
</tr>
<tr>
<td>DO</td>
<td>Digital Output</td>
</tr>
<tr>
<td>EVT</td>
<td>BACnet Alarm</td>
</tr>
<tr>
<td>LAN AI</td>
<td>LAN Analog Input</td>
</tr>
<tr>
<td>LAN AO</td>
<td>LAN Analog Output</td>
</tr>
<tr>
<td>LAN DI</td>
<td>LAN Digital Input</td>
</tr>
<tr>
<td>LAN DO</td>
<td>LAN Digital Output</td>
</tr>
<tr>
<td>LSTAT</td>
<td>LogiStat Zone Sensor</td>
</tr>
<tr>
<td>POLLAVG</td>
<td>Average Analog Properties</td>
</tr>
<tr>
<td>POLLMAX</td>
<td>Maximum Analog Properties</td>
</tr>
<tr>
<td>POLLMIN</td>
<td>Minimum Analog Properties</td>
</tr>
<tr>
<td>POLLTOT</td>
<td>Total Analog Properties</td>
</tr>
<tr>
<td>PTA</td>
<td>Pulse to Analog Input</td>
</tr>
<tr>
<td>TLO</td>
<td>Timed Local Override</td>
</tr>
</tbody>
</table>
Logic pages

The Logic page shows the control program for a piece of equipment. The live data (yellow text) is updated every few seconds and when you click the Logic button. The control program uses exact property values for its calculations, but values are rounded to 2 decimal places when displayed on the Logic page.

💡 TIP Click anywhere on the Logic page, then use your keyboard’s Page Up, Page Down, and arrow keys to scroll through the page.

NOTE If you find an unexpected value on a Properties page or a Logic page, you can use the Logic page to troubleshoot.

To view a Logic page

1. Select a piece of equipment on the Geographic or Network tree.
2. Click Logic.
3. Click a microblock to view its details.

To locate a microblock, section, or label

1. Right-click the Logic page, then select Jump To.
2. Do one of the following:
   - On the Microblock or Section tab, select an item to have it located and highlighted.
   - On the Label tab, select a label to display a reduced logic page outlined in yellow that shows all instances of the label. A red box indicates an output label; a yellow box indicates an input label. Click a red or yellow box to jump to that label in the full-size logic page.

   **NOTE** You can also click a label on the full-size logic page to display the reduced logic page.

To change properties, alarms, or trends

1. Click a microblock on the equipment’s Logic page.
2. In the microblock pop-up, click the Properties, Alarms, or Trends button.
3. Change properties, alarms, or trends for that microblock in the same way that you would make changes on a regular Properties (page 39), Alarms (page 103), or Trends (page 71) page.
4. Click Accept.

**NOTE** Right-click a value, then select Global Modify (page 44) to view and change the property in other control programs.
Using a Logic page to troubleshoot

The WebCTRL® application monitors your system and provides feedback. If you get unexpected feedback, you can use a Logic page as a troubleshooting tool. On the Logic page, work your way backward (right to left) through the sequence in the control program to discover what caused the problem. See Microblock Reference to understand what each microblock in the sequence is doing.

<table>
<thead>
<tr>
<th>Unexpected feedback</th>
<th>Possible cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space temperature reads excessively high or low</td>
<td>• The sensor has a short (or open) circuit. Verify wires are properly connected at the sensor and controller.</td>
</tr>
<tr>
<td></td>
<td>• A sensor is missing or configured incorrectly. Open the sensor or input microblock from the Logic page to verify its configuration.</td>
</tr>
<tr>
<td>Equipment displays an unexpected color - effective</td>
<td><strong>NOTE</strong> Equipment operates using effective setpoints. Open the Setpoint microblock from the Logic page and check the following:</td>
</tr>
<tr>
<td>setpoints are different than the programmed setpoints</td>
<td>• Hysteresis</td>
</tr>
<tr>
<td></td>
<td>• Demand Level</td>
</tr>
<tr>
<td></td>
<td>• Optimal Start</td>
</tr>
<tr>
<td></td>
<td>• Timed Local Override (TLO)</td>
</tr>
<tr>
<td></td>
<td>• Setpoint Adjust</td>
</tr>
<tr>
<td>Gaps in trend data on trend graph</td>
<td>Usually gaps result if network communication was disrupted or a point was temporarily disabled.</td>
</tr>
<tr>
<td></td>
<td>If the gap is not the result of interrupted communication, send reports more frequently. From the Logic page, open the trend microblock</td>
</tr>
<tr>
<td></td>
<td>that displayed the gap in data, then decrease the notification threshold so that it is approximately 40% of the buffer size (allocated</td>
</tr>
<tr>
<td></td>
<td>memory size) for that microblock.</td>
</tr>
<tr>
<td>The WebCTRL® application is not receiving alarms from a</td>
<td>Locate the microblock on the Logic page. If the color square on the microblock is black, the alarm is disabled. To enable it:</td>
</tr>
<tr>
<td>BACnet alarm microblock</td>
<td>1 Click the microblock.</td>
</tr>
<tr>
<td></td>
<td>2 In the microblock pop-up, click the Alarms button.</td>
</tr>
<tr>
<td></td>
<td>3 On the Enable/Disable tab, select Potential alarm source.</td>
</tr>
<tr>
<td>The equipment is on when I expect it to be off, or off</td>
<td>Use the Logic page to determine whether the program is sending an unexpected signal and why, or if the problem is with the physical</td>
</tr>
<tr>
<td>when I expect it to be on</td>
<td>equipment. For example, the On-Off-Auto (OOA) switch on the controller for that equipment may be locked in the On (Hand) position.</td>
</tr>
<tr>
<td>Sensor value on the Properties page does not match the</td>
<td>Calibrate the sensor.</td>
</tr>
<tr>
<td>reading from handheld sensor</td>
<td>On the Logic page, check to see if the output point is locked on.</td>
</tr>
</tbody>
</table>


## Changing multiple microblock properties

Two WebCTRL® features, **Global Modify** and **Global Copy**, allow you to view and change multiple microblock properties at the same time.

⚠️ **CAUTION** Global Modify and Global Copy are convenient for making widespread changes in your system. But, because they do not take into account the operation of individual equipment, your changes could produce undesired results in your equipment or system operation. Use with caution because these features do not have an Undo function.

💡 **TIP** Click 📋 to copy a microblock’s reference path to the clipboard so you can paste it into another field or application.

### To use Global Modify

Use the Global Modify feature to:

- View a microblock’s full path, control program name, and the privileges required to change its properties.
- View or change a single property in several control programs at one time.
- View errors on Graphics and Properties pages.

1. Browse to any page that displays the property you want to view or change.
2. Right-click the property, then select **Global Modify**.
3. Make changes to the **Control Program** field, if needed.

**NOTES**
- Use wildcards in the **Control Program** field to broaden the search. For example:
  - `vav*` matches vav, vav1, vavx, vav12345
  - `vav*z` matches vavz, vav1z, vavxz, vav12345z
  - `vav*1*2` matches vav12, vavabc1xyz2
  - `vav??` matches vav11, vav12, vavzz, but does not match vav, vav1, vav123
- `*` matches any control program
○ Click **Show Advanced** to view the location, value, and privileges associated with this property.

4. Select the tree item that you want to search under for every occurrence of that microblock in other control programs.

5. Click **Find All**.

6. Select the properties in the list that you want to change.

7. Do one of the following:
   a) Type a **New Value** to the right of each selected item.
   b) Select **Enable All**, type a new value in b, then click **Set All To**.
c) Select **Enable All**, type a new value in c, then click **Change All By**.

8 Click **Apply Changes**.

**NOTE** To modify several properties in multiple control programs at the same time, use **Global Copy**.

To use Global Copy

Use **Global Copy** to copy any or all of the following from one control program to other equipment using the same control program:

- Embedded trend graph settings
- Custom trend graphs
- Custom reports
- Other editable properties to other pieces of equipment using the same control program.

1 On the **Geographic** or **Network** tree, right-click the piece of equipment that has the properties you want to copy, then select **Copy Control Program Properties**.

2 In the **Global Copy** dialog box, select the items that you want to copy.

3 Select the area on the tree containing similar control programs that you may want to copy these properties to, then click **Search**.

   All instances at that level and below are listed in the expanded lower window.

4 Check or uncheck items as needed.

5 Do one of the following:
   - Check **Skip bad values** to copy all values except a bad value (it cannot be copied because you do not have the necessary privilege, the property to be copied is undefined, etc.).
   - Uncheck this field to prevent any values from being copied if a bad value is found.

6 Click **Apply Changes**, then close the **Global Copy** dialog box.
**Downloading to controllers**

If you make any of the following changes, you must download the new data from the WebCTRL® application to the affected controllers.

<table>
<thead>
<tr>
<th>In the WebCTRL® interface</th>
<th></th>
<th></th>
</tr>
</thead>
</table>
| • Change or reload a control program | • Change or reload a driver | • Change a schedule  
  **NOTE** A schedule change automatically downloads unless you uncheck *Automatically download schedules on each change* on the My Settings page.  
• Change a touchscreen or BACview® file  
• Check or uncheck a .view file's **included in download** option |

<table>
<thead>
<tr>
<th>In SiteBuilder</th>
<th></th>
<th></th>
</tr>
</thead>
</table>
| • Add a device  
• Add equipment  
• Change or reload a control program  
• Set an object instance  
• Change or reload a driver  
• Assign or unassign equipment  
• Check or uncheck a .view file's **included in download** option |

The WebCTRL® application automatically marks the affected controllers as requiring a download. You can download these controllers from the Downloads page (page 48) or Properties page (page 49) for the controller, the equipment, or a microblock.

When the WebCTRL® application marks a controller for download, it determines what information needs to be downloaded based on the type of information that changed. See Download Options (page 48).

**NOTES**

- A property change in the WebCTRL® interface is automatically downloaded to the controller. If the download fails, the controller is added to the Downloads page with the reason for the failure.

- To see who downloaded a controller last, go to the Network tree, select the controller, then do one of the following:
  - Go to **Reports > Network > Controller Status**, then click **Run**.
  - View **Downloaded by** on the Properties page.
  - Click **Module Status** on the Properties page.
Download Options

When the WebCTRL® application marks a controller for download, it determines what information needs to be downloaded based on the type of information that changed. Below are the options that can be downloaded.

<table>
<thead>
<tr>
<th>This option...</th>
<th>Downloads...</th>
</tr>
</thead>
</table>
| All Content    | • Only the executable portion of the driver and control programs  
                 • The names of all .equipment, .touch, .bacview, and .driver source files  
                 • The names of any .view files that are marked to be included in a download  
                 • Parameters  
                 • Schedules  

**NOTE** An All Content download also:  
• Synchronizes the controller's time to the WebCTRL® server.  
• Overwrites trends in the controller.  
• Restarts the controller.

| Only Schedules | All schedules that are not set for automatic download |
| Only Parameters| All editable properties |
| Only BBMDs     | BBMD tables (.bdt file) that you have updated but have not yet written to the controller |

**NOTES**

- An **All Content** download clears trend, history, and alarm data from the affected controllers. At the beginning of the download process, trends that have the Trend Historian enabled are saved to the system database.
- If Field Assistant will be used with your system, you can choose to have the **All Content** option download the full source files instead of only their names. On the WebCTRL® **Network** tree, select a controller, then enable **Download Source Files** on the **Properties** page. See Commissioning equipment using Field Assistant.

To download from the Downloads page

The **Downloads** page shows any controllers that the WebCTRL® application marked for download. But if needed, you can add other controllers to the list.

To download:

1. On the **Network** tree, select an item to download controllers at and below that item.
2. Click **Downloads**.
3. Click **»** to the left of a **Location** to see controllers that require a download.
4  Optional: To add controllers to the list:
   a)  Click Add.
   b)  Select the controller(s).
       NOTE  Use Ctrl+click or Shift+click to select multiple controllers.
   c)  Select a Download Option (page 48).
   d)  Click Add, then click Close.
5  Select the controllers that you want to download.
   NOTES
   ○  Use Ctrl+click, Shift+click, or the Select All checkbox to select multiple controllers.
   ○  A network’s controllers download in the order shown. To change the order, select a
     controller(s), then drag and drop or click Move to Top or Move to Bottom.
     EXCEPTION  If a controller’s router requires a download, it will download first regardless of its
     position on the Download page.
6  Click Start.
   NOTES
   •  Click Hold to stop pending downloads. Active downloads cannot be stopped.
   •  Up to 5 routers can download simultaneously.
   •  A controller is removed from the list when its download is complete.
   •  Icons in the Tasks column indicate the following:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📈</td>
<td>Active—The WebCTRL® application is downloading to the controller.</td>
</tr>
<tr>
<td>🔄</td>
<td>Pending—You initiated the download, and the controller is waiting for its turn to download.</td>
</tr>
<tr>
<td>✖</td>
<td>Failed—The download failed. See If a controller fails to download (page 50).</td>
</tr>
</tbody>
</table>
   | 🛑   | On Hold—Indicates either of the following:
   |      | •  The controller requires a download |
   |      | •  You clicked Hold to stop a pending download. |
   •  Click 📋 in the upper left-hand corner to view a log of download activity in the current session.
   Copy to Clipboard lets you copy the text to paste it into another application.
   •  To remove an item from the download list, right-click the item, then select Remove selected tasks.

To download from a Properties page

If a controller requires a download, a red download message and a Download button appear at the top of the Properties page for the controller, the equipment, or a microblock. Click the button to start the download.

Downloading from the Properties page downloads All Content to the controller.
If a controller fails to download

A controller that fails to download appears on the Downloads page with this icon ✗.

1. Review the reason for the failure:
   - Hold your cursor over the failed task to see hover text giving the reason.
   - Click ✗ in the upper left-hand corner of the page to see information on all failed downloads.
   - Copy to Clipboard lets you copy the text to paste it into another application.

2. Correct the problem that caused the failure.

3. Select the controller on the Downloads page, then click Start.
Checking controller status

On the WebCTRL® Network tree, you can select a network, router, site, or the system, and then click the Devices button to:

- View the status of controllers (page 51)
- View controller information such as address, model, driver, and .view files included in download
- Download or upload to resolve a mismatch (page 54)
- Troubleshoot network communication
- Download or upload files for Field Assistant

NOTES

- Use Ctrl+click, Shift+click, or the Select All checkbox to select multiple controllers.
- Click Hold to stop pending downloads or uploads. Active downloads or uploads cannot be stopped.
- Icons in the Tasks column indicate the following:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Active Icon" /></td>
<td>The WebCTRL® application is downloading to the controller.</td>
</tr>
<tr>
<td><img src="image" alt="Active Icon" /></td>
<td>The WebCTRL® application is uploading from the controller.</td>
</tr>
<tr>
<td><img src="image" alt="Pending Icon" /></td>
<td>You initiated the download, and the controller is waiting for its turn to download.</td>
</tr>
<tr>
<td><img src="image" alt="Failed Icon" /></td>
<td>The download failed. See If a controller fails to download (page 50).</td>
</tr>
<tr>
<td><img src="image" alt="On Hold Icon" /></td>
<td>Indicates you clicked Hold to stop a pending download.</td>
</tr>
</tbody>
</table>

- Click ![Info Icon](image) in the upper left-hand corner to view a log of activity on the Devices page in the current session. Copy to Clipboard lets you copy the text to paste it into another application.

Status messages

On the WebCTRL® Network tree, you can select a router, network, site, or the system to view the status of controllers. On the Devices page, the Status column shows a description of the controller's current state. Hold your cursor over that description to see hover text with a more detailed description.

If multiple conditions exist, WebCTRL® displays the message with the highest priority.
The table below shows all possible messages. The message color indicates the following:
Black—In process
Red—An error occurred
Blue—Requires action from the user

<table>
<thead>
<tr>
<th>Status column message</th>
<th>Hover text message</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black messages:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Downloading</td>
<td>The controller is downloading, communications may be disabled.</td>
<td></td>
</tr>
<tr>
<td>Pending</td>
<td>This controller is waiting to be processed.</td>
<td></td>
</tr>
<tr>
<td>Processing clipping</td>
<td>Clipping operation is in progress. Do not make changes as they may corrupt your system.</td>
<td></td>
</tr>
<tr>
<td>Uploading</td>
<td>The controller is uploading, communications may be disabled.</td>
<td></td>
</tr>
<tr>
<td>Red messages:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Communications Error</td>
<td>Cannot communicate with this controller.</td>
<td></td>
</tr>
<tr>
<td>Connection Disabled</td>
<td>The connection for this controller has been disabled.</td>
<td>Occurs if someone stopped the connection. This includes stopping a connection, using the No Connect connection, or running WebCTRL Design Server.</td>
</tr>
<tr>
<td>Connection Error</td>
<td>The connection for this controller failed to start.</td>
<td>Occurs if the connection is misconfigured or failed to start.</td>
</tr>
<tr>
<td>Download Failed</td>
<td>(Message depends on the cause of the failure.)</td>
<td></td>
</tr>
<tr>
<td>Error</td>
<td>An unknown error has occurred.</td>
<td></td>
</tr>
<tr>
<td>Missing Files</td>
<td>Upload failed. Server is missing source files.</td>
<td></td>
</tr>
<tr>
<td>Not Uploadable</td>
<td>This controller is not configured for content upload.</td>
<td>Occurs if you attempt to upload a controller with a pre-4.x driver.</td>
</tr>
<tr>
<td>Out of Service</td>
<td>This controller is out of service.</td>
<td>Out of Service is checked on the controller’s Properties page.</td>
</tr>
<tr>
<td>Unsupported controller</td>
<td>Controller does not support content upload.</td>
<td></td>
</tr>
<tr>
<td>Status column message</td>
<td>Hover text message</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Blue messages:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Controller Replaced</td>
<td>This controller has been replaced by another controller of the same type in the field.</td>
<td>4.x driver only</td>
</tr>
<tr>
<td>Download All Content</td>
<td>Please download all content to the controller.</td>
<td></td>
</tr>
<tr>
<td>Download Parameters</td>
<td>To download parameters, highlight row and select &quot;Parameters&quot; from the Download Action menu and click &quot;Download&quot;.</td>
<td></td>
</tr>
<tr>
<td>Download Schedule</td>
<td>To download schedules, highlight row and select &quot;Schedules&quot; from the Download Action menu and click &quot;Download&quot;.</td>
<td></td>
</tr>
<tr>
<td>Driver Parameter Mismatch</td>
<td>Driver parameter differences detected. Upload parameters from the controller or download parameters to the controller.</td>
<td></td>
</tr>
<tr>
<td>Parameter Mismatch</td>
<td>Control Program parameter differences detected. Upload parameters from the controller or download parameters to the controller.</td>
<td></td>
</tr>
<tr>
<td>Program Mismatch</td>
<td>Content differences detected. Upload all content from the controller or download all content to the controller.</td>
<td>4.x driver only</td>
</tr>
<tr>
<td>Unprogrammed controller</td>
<td>This is a programmable controller. To add control programs, click on the &quot;Add Control Program&quot; button at the top of the screen.</td>
<td></td>
</tr>
<tr>
<td>Upload All Content</td>
<td>Please upload all content from the controller.</td>
<td></td>
</tr>
<tr>
<td>General messages:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✓</td>
<td>This controller is ok.</td>
<td></td>
</tr>
<tr>
<td>Cancelled</td>
<td>The last operation on this controller was cancelled.</td>
<td></td>
</tr>
</tbody>
</table>
To resolve a mismatch

A mismatch occurs when a value in a controller does not match the value in the WebCTRL Server application. Use either of the following methods to handle mismatches in your system.

- Check *Always upload properties from controllers to WebCTRL Server on mismatch* on the **System Settings > Communications** tab to have the WebCTRL® application upload automatically.

- Uncheck *Always upload properties from controllers to WebCTRL Server on mismatch* so that you can evaluate every mismatch to determine the correct value. When a mismatch occurs:

  1. On the **Network** tree, select the controller's network.
  2. Click **Devices**.
  3. On the **Manage** tab, select a controller with a mismatch.
  4. Do one of the following:
     - Click **Upload** to upload parameters from the controller to WebCTRL Server.
     - Click **Download** to download parameters from WebCTRL Server to the controller.

**NOTE** Click the mismatch message in the **Status** column to view details.
Setpoints

Use setpoints to set temperature values that control the HVAC equipment. The WebCTRL® interface shows the color green when a zone is within the desired temperature range determined by the heating and cooling setpoints.

- **Programmed setpoints** are set and changed by operators. See To change programmed setpoints (page 55).
- **Effective setpoints** reflect the impact of other system conditions on the programmed setpoints, such as setpoint adjustments, demand reduction adjustments, and hysteresis. Effective setpoints control the equipment.

Besides manually adjusting setpoints, you can use the following cost-saving strategies (page 144) to adjust setpoints automatically:

- Optimal Start
- Demand Control
- Setpoint Optimization

To change programmed setpoints

1. Navigate to a setpoint control in one of the following places:
   - The zone temperature section of a Properties page
   - The setpoint microblock pop-up on a Logic page
   - A Graphics page (Click a setpoint trend graph control to access the editable setpoint bar.)

2. On a programmed setpoint bar, click the segment or the gap between segments you want to change.

3. Type new values in the Heating and Cooling fields.

   **TIP** You can click and drag a segment or a gap between segments to change setpoints.

4. Click Accept.
Optimal Start

Optimal Start gradually moves the unoccupied setpoints toward the occupied setpoints as the occupied time approaches. The actual equation that a controller uses to calculate Optimal Start is nonlinear. An approximation of the equation is shown below.

\[
\text{calculated capacity} = \frac{\text{design temp} - \text{OAT}}{\text{design temp} - 65^\circ} \times \text{capacity at 65}^\circ
\]

Refining Optimal Start saves energy in the following ways:

- Removing guesswork from preheating or precooling zones
- Ensuring that zones reach the ideal comfort range just as people arrive
- Preventing equipment from running unnecessarily during unoccupied periods

You can adjust the Optimal Start routine in the control program's setpoint microblock.

1. On the Geographic tree, select the equipment that you want to change.
2. Click Properties.
3. Adjust the following fields located below the setpoint graph.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Heating Capacity</strong></td>
<td>The maximum rate (in °F/hr) that the zone temperature could be changed by heating or cooling if the outside temperature were 65 °F.</td>
</tr>
<tr>
<td><strong>Cooling Capacity</strong></td>
<td>For example, if it takes 2 hours for a zone to warm up from 65 °F to 72 °F, the heating capacity is 3.5 °F/hr</td>
</tr>
<tr>
<td><strong>Heating Design Temp</strong></td>
<td>The most extreme outside winter and summer temperatures at which the equipment must run 100% of the time to maintain the zone temperature at a comfortable level. ASHRAE determines design temperatures based on the geographic location of the building.</td>
</tr>
<tr>
<td><strong>Cooling Design Temp</strong></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** A Setpoint microblock with Learning Adaptive Optimal Start functionality automatically adjusts the heating and cooling capacities to optimize efficiency.
Learning Adaptive Optimal Start

If you are using the Learning Adaptive Optimal Start feature and a zone does not reach the ideal temperature range by the time occupancy begins or reaches it too soon, then the heating or cooling capacities of the equipment are automatically adjusted up or down for the next unoccupied period.

When the Learning Adaptive Optimal Start routine runs, adjustments are made based on the color that is achieved when occupancy begins. Adjustment amounts are defined for thermographic colors in the control program’s setpoint microblock.

For example, the heating capacity for a zone is 5° per hour. When the zone becomes occupied, the zone temperature is 1° below the occupied setpoint, indicating a need for additional heat. Because the zone temperature was low by 1°, the learned heating capacity will be decreased by the Less than Heating setpoint value. If the value is 0.06, the learned heating capacity will be adjusted to 4.94° for the next optimal start period. The setpoint adjustment will begin sooner in the next unoccupied period.

If you need to change the adjustment values in the Learning Adaptive Optimal Start routine:

1. On the Geographic tree, select the equipment that you want to change.
2. Click Properties.
3. Adjust the color fields between the Zone Setpoints graph and the Effective Setpoints graph.

⚠️ CAUTION When using Learning Adaptive Optimal Start, be sure that all equipment is properly maintained so that your system does not “learn” to compensate for dirty filters or loose fan belts.

💡 TIP After your system has run for at least a year, you may want to turn off learning in your control program, and change the Heating Capacity and Cooling Capacity in your control program to match the learned heating or cooling capacity shown on the Properties page.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color fields</td>
<td>The amount of adjustment the system makes for the color that is achieved at the beginning of occupancy.</td>
</tr>
<tr>
<td>Learned cooling and heating capacity</td>
<td>The rate (in °F/hr) that the zone temperature can change by heating or cooling at an outside temperature of 65 °F.</td>
</tr>
<tr>
<td>Actual or adjusted capacity</td>
<td>The actual heating or cooling capacity of the equipment at an outside temperature of 65 °F.</td>
</tr>
</tbody>
</table>
Demand Control

Demand Control is a cost-saving strategy that saves energy while maintaining comfort in the following ways:
- Controlling energy use to avoid peak demand, ratchet, or time of use utility charges
- Maintaining ventilation at relaxed setpoints rather than shutting down equipment (as with load shedding or duty cycling)

Before you can use Demand Control effectively, you must:
- Obtain details regarding past energy usage and peak demand, ratchet, and time of use charges from your energy provider.
- Understand the demand profiles of the zones you are controlling.

Demand Control can be customized at the zone level. For example, you may relax the setpoints in some zones, like break rooms and closets, by a few degrees, but you may not want to relax setpoints in computer rooms at all.

A Setpoint microblock that has the Demand Limiting enabled uses a demand control strategy to conserve energy by relaxing setpoints as the demand level rises. In the EIKON® application, you define the amount that setpoints will be adjusted or relaxed based on the demand level.

To define Demand Control properties

1. On the Geographic or Network tree, select the electric meter.
2. On the Properties page, expand the Demand Level Parameters section.
3. Type the Start and End time to define the time period that you want demand control to be in effect for this zone.
4. Type kilowatts per hour (kW/hr) in the Level columns to define the amount of power that the demand must exceed before the WebCTRL® system calls for a higher demand level.
**NOTE** Levels are defined in the electric meter control program in the EIKON® application. You can test the Demand Levels by locking the meter to a value.

In the example below, during Period 4, defined as 12:00 (noon) to 16:00 (4:00 p.m.), if the demand exceeds 800 kW/hr, the WebCTRL® system will use Demand Level 1 setpoints. If the demand exceeds 1000 kW/hr, the WebCTRL® system will use Demand Level 2 level setpoints and so on.

![Demand Level Parameters Table]

### Setpoint Optimization

Setpoint Optimization, also known as Trim and Respond, saves energy by calculating the setpoint of a piece of equipment based on the number of heating or cooling requests it receives from other equipment.

You must put a Setpoint Optimization microblock in a control program to receive Total, Average, Minimum, or Maximum microblock outputs from linked equipment.
Using schedules, your equipment can maintain one set of setpoints during occupied periods to provide comfort, and it can maintain a different set of setpoints during unoccupied periods to reduce energy consumption. Schedules are a WebCTRL® system’s most effective cost-saving strategy (page 144). You can apply a schedule to a tree item or to a group of tree items.

When you apply a schedule to a tree item, the schedule affects equipment at and below the area or equipment where the schedule was added.

When you apply a schedule to a schedule group, the schedule affects all pieces of equipment in the group.

For example, a school board meets every third Tuesday of the month and uses the lobby, main conference room, break room, and restrooms. You can create a schedule group to control these different areas with a single schedule.

NOTES

- When multiple schedules affect a tree item, the net result is the *Effective schedule* (page 65).
- Do not include preheating or precooling time in your schedules. *Optimal Start* (page 56), another cost-saving strategy, automatically calculates and controls precise preheating and precooling routines.
- If you are using hierarchical servers, when you add or change a schedule on the parent server, the schedule is automatically downloaded to the corresponding location on the child server(s).
To view schedules

1. Select a Geographic tree item.
2. Click Schedules, then the View tab.
3. Optional: Click a white Effective bar to view all the schedules that contribute to the resulting schedule. If the item has multiple schedules, the schedule closest to the Effective bar has the highest priority. You set a schedule's priority when you create the schedule.

NOTES

- You can display icons and hover text on the Geographic tree that show where schedules have been created. See Tree icons and hover text (page 27).
- You can also view schedules on the following detailed, printable schedule reports. These reports are accessible from the Schedules page Reports tab or from the Reports button drop-down menu.

<table>
<thead>
<tr>
<th>This report...</th>
<th>allows you to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule Instances</td>
<td>Find every schedule with its location that is entered at and below a selected tree item. This report can help you discover newly added and conflicting schedules.</td>
</tr>
<tr>
<td>Effective Schedules</td>
<td>View all equipment that may be scheduled and the net result of all schedules in effect for a selected date and time. See Effective schedules (page 65).</td>
</tr>
</tbody>
</table>

Setting up schedules

To apply a schedule to equipment

WebCTRL® schedules are typically based on zone occupancy. See Using schedule categories (page 67) if you want to create a schedule based on conditions other than occupancy.

1. On the Geographic tree, select the area or equipment you want to schedule.
2. Select Schedules > Configure tab.
3. Click Add.
4. Select a Priority. A schedule's priority determines whether affected zones will use occupied or unoccupied setpoints.

<table>
<thead>
<tr>
<th>Select...</th>
<th>For...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>A typical occupied period</td>
</tr>
<tr>
<td>Holiday</td>
<td>An unoccupied period that overrides a Normal schedule</td>
</tr>
<tr>
<td>Override</td>
<td>An occupied period that overrides a Holiday schedule</td>
</tr>
</tbody>
</table>

5. Select a Type. See table below.
6 Type a schedule name in the **Description** field.

7 Enter desired values in the fields below **Description**.

8 On the graph, change a time segment's **Start** and **End** times by doing one of the following:
   - Click the segment, then type the times in the **Start** and **End** fields.
   - Click and drag either end of the segment or the entire segment.

9 Optional: Click **Add Time Period** to add one or more segments to the schedule. Or, select a segment and click **Delete Time Period** to delete that segment.

10 Click **Accept**.

<table>
<thead>
<tr>
<th><strong>Select this Type...</strong></th>
<th><strong>To use the schedule...</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Weekly</td>
<td>Every week on the specified days</td>
</tr>
<tr>
<td>Date</td>
<td>On a single, specified date</td>
</tr>
<tr>
<td>Date Range</td>
<td>Between 2 specified dates</td>
</tr>
<tr>
<td>Date List</td>
<td>On multiple, specified dates</td>
</tr>
<tr>
<td>Wildcard</td>
<td>For a repeating pattern (For example, the second Tuesday of every month)</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> Wildcard schedules do not work with Automated Logic® legacy equipment. The WebCTRL® interface will indicate if you apply a schedule to legacy equipment.</td>
</tr>
<tr>
<td>Continuous</td>
<td>Continuously between 2 specified dates/times</td>
</tr>
<tr>
<td>Dated Weekly</td>
<td>On specified weekdays between a start date and an end date (for example, the summer break in the school year)</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> To use a Dated Weekly schedule with an ExecB controller, you must use the 1.71:032 (or later) ExecB driver.</td>
</tr>
</tbody>
</table>

**NOTES**

- To automatically download all schedules that you create or change, go to **My Settings** (page 136) and check **Automatically download schedules as you create them**. If you want to manually download schedules, uncheck **Automatically download...** and then see **Downloading system changes to controllers** (page 47).

- When you apply a schedule to an item on the **Geographic** tree, the schedule affects that item and all children of that item. If you do not want an item to be affected by schedules from a higher level, check **Ignore Schedules above this level** on the **Schedules > Configure** tab.

**To apply a schedule to a group of items**

You must create a group, then add members (areas, equipment, or other groups) to the group before you can apply a schedule to it.

1 On the **Schedule Groups** tree, select **Scheduling Groups**.
   Optional: If you have created folders to organize your groups, select the appropriate folder. See "To organize groups using folders" below.

2 Click **Add Group**.

3 Type a name for the new schedule group in the **Name** field.
4 Optional: Change the default Reference name. A group's reference name must be unique throughout the system.

5 Click Accept.

6 Click Add Members to Group.

7 On the Members page, select the areas, equipment, or other groups that you want to add to the group from the tree on the right. Use Ctrl+click, Shift+click, or both to select multiple items.

8 Click Add.

   **TIP** Use the Raise and Lower buttons to reorder items in the Members list. Changing the order is for your viewing convenience and does not affect the system.

9 Click Accept.

10 Click the Schedules button, then Configure.

11 Add a schedule to the group. See To apply a schedule to equipment (page 61).

**NOTE** When using hierarchical servers, you can place a server link in a schedule group on the parent server. This automatically creates a schedule group with the same name on the child server(s). This group includes only the top-most area node of the child server. However, from the child server you can edit the group to add other members.

**To organize groups using folders**

You can create folders and sort your groups into them to organize the Schedule Groups tree. For example, a large school system that has a group for each school may want to create an Elementary School folder, a Middle School folder, and a High School folder, and put the appropriate groups in each folder.
To create folders and add groups to them:

1. On the **Schedule Groups** tree, select **Scheduling Groups**.
2. Click **Add Folder**.
3. Type a name for the new folder in the **Name** field.
4. Optional: Change the default **Reference name**.
5. Click **Accept**.
6. Repeat steps 1–4 for each folder that you want to add.
7. Do one of the following to add a group to a folder:
   - If you have already created the group, drag and drop it into the appropriate folder in the tree on the **Scheduling Groups** page, then click **Accept**.
   - Select the folder in the tree on the **Scheduling Groups** page, then click **Add Group** to add a new group inside the folder.

**NOTE** You can also add a folder to a folder, or drag and drop a folder into another folder.

**To edit or delete a schedule**

1. Do one of the following:
   - On the **Geographic** tree, select the tree item where the schedule was defined, then select **Schedules > Configure** tab.
   - On the **Schedule Groups** tree, expand **Scheduling Groups**, then select the group that has the schedule you want to edit or delete.
2. Select the schedule you want to edit or delete.
3. Edit the fields you want to change or click **Delete**.
4. Click **Accept**.

**NOTE** Expired dated schedules are automatically deleted from the database at 3:30 AM every day. But expired schedules remain in the controller until the next time schedules are downloaded to the controller. You can change the deletion time on the **Scheduled Tasks** tab of the System Settings (page 171) page.
Effective schedules

The effective schedule that you see on the Schedules > View tab can be the result of multiple overlapping schedules.

The following schedule features can influence an item's effective schedule.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| Hierarchy | A schedule applied to an item on the WebCTRL® tree affects that item and all of its children. A child item's effective schedule could be the result of multiple schedules applied at different levels above it. To change a child item's effective schedule:  
- Add a schedule at the child that overrides the current schedule. See the Priority feature below.  
- Set the child to ignore the parent schedules. To do this, select the child item on the tree, then go to Schedules > Configure. Select the schedule, then click Ignore Schedules above this level. You can then add a different schedule for the child. |

Any schedule change that you make to an item affects it and all of its children.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>You must assign one of the following priorities to every schedule.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use...</th>
<th>For...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>A typical occupied period</td>
</tr>
<tr>
<td>Holiday</td>
<td>An unoccupied period that overrides a Normal schedule</td>
</tr>
<tr>
<td>Override</td>
<td>An occupied period that overrides a Holiday time</td>
</tr>
</tbody>
</table>

**EXAMPLE** For a school, you define:
- A **Normal** schedule that has it occupied every Monday–Friday, 6 am–5 pm
- A **Holiday** (unoccupied) schedule for the week of Spring Break
- An **Override** schedule on the first day of Spring Break from 9 am–1 pm for the cafeteria only where a teacher’s meeting will be held.

<table>
<thead>
<tr>
<th>Type</th>
<th>You must assign one of the following types to every schedule.*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weekly</td>
<td>Wildcard</td>
</tr>
<tr>
<td>Date</td>
<td>Continuous</td>
</tr>
<tr>
<td>Date Range</td>
<td>Dated Weekly</td>
</tr>
<tr>
<td>Date List</td>
<td></td>
</tr>
</tbody>
</table>

See **To apply a schedule to equipment** (page 61) for a description of each type.

**EXAMPLE** For a school, you define the following 3 schedules:
- Full calendar year: Normal, Weekly, Monday–Friday, 6am–5pm
- Summer months: Holiday, Continuous, 12am June 1st –11:59pm August 31st
- Work days in summer months: Override, Dated Weekly, Monday–Thursday, 9am–2pm

* If you do not see one of the types listed above, on the **System Configuration** tree, select **Categories > Schedule**. Select the **Occupancy** category, then the **Priority**. Under **Schedule Types**, select the missing type, then click **Accept**.

Using the **Priority** and **Type** options, you can often accomplish the effective schedule you need in several different ways. For example, the effective schedule resulting from the 3 schedules described above for **Type** could also be accomplished with the following schedules:

School year: Normal, Dated Weekly, Monday–Friday, September 1st–May 31st, 6am–5pm
Summer months: Normal, Dated Weekly, Monday–Thursday, June 1st–August 31st, 9am–2pm
Using schedule categories

Occupancy is the only default schedule category. It is a binary schedule category that allows a zone or piece of equipment to be defined as On when a space is occupied and Off when it is unoccupied.

You can add custom schedule categories to handle other conditions if the equipment’s control program includes a Time Clock microblock. For example, you can add a multi-state schedule category to control lights: on during work hours, off at night, and dim for janitorial work.

Creating a custom schedule category

1. Create the custom schedule category in the EIKON® application. See "To use custom alarm and schedule categories" in EIKON® Help.
2. In the EIKON® application, select the new category from the Schedule Category droplist in a Time Clock microblock.
3. Create the same custom schedule category in the WebCTRL® interface. The Reference Name must be identical to the category’s name in the EIKON® application. See "To add a custom schedule category in the WebCTRL® interface" below.

To add a custom schedule category in the WebCTRL® interface

💡 TIP  Study the default Occupancy category to understand the various properties you need to set when adding a new schedule category.

PREREQUISITES

• Add the custom schedule category in the EIKON® application. See "To use custom alarm and schedule categories" in EIKON® Help.
• In the EIKON® application, select the new category from the Schedule Category droplist in a Time Clock microblock.

1. On the System Configuration tree, click ➔ to the left of the Categories folder, then click Schedule.
2. Click Add.
3. Enter values or add items for the fields in each section of the page. See table below.
   
   **NOTE**  The fields that you see depend on selections you made in previous sections.
4. Click Accept.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category Name</td>
<td>The name used in the WebCTRL® interface</td>
</tr>
<tr>
<td>Reference Name</td>
<td>• Must be unique in the database, be lowercase, and not contain any spaces.</td>
</tr>
<tr>
<td></td>
<td>• This name must be identical to the name of the custom schedule category that you added in the EIKON® application.</td>
</tr>
<tr>
<td></td>
<td>• Do not use occupancy as the reference name.</td>
</tr>
<tr>
<td>Field</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Allowed Type</strong></td>
<td>Replace <strong>Undefined</strong> with one of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Boolean</strong>: binary (on/off, true/false) condition</td>
</tr>
<tr>
<td></td>
<td>• <strong>Multi State</strong>: list of integer-defined states. For example, 1=off, 2=on, 3=dim</td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td>Displays what schedule value is in effect for times not specified by the schedule. To set this value, in the <strong>Allowed Values</strong> table, select the value that you want to use as the default, then click the <strong>Make Default OK</strong> button.</td>
</tr>
<tr>
<td><strong>Allowed Values</strong></td>
<td>If you selected <strong>Boolean</strong> above, select <strong>True Value</strong> or <strong>False Value</strong>.</td>
</tr>
<tr>
<td></td>
<td>If you selected <strong>Multi State</strong>, click the <strong>Add Value</strong> button to create each schedule state.</td>
</tr>
<tr>
<td><strong>Allowed Value Description</strong></td>
<td>The name used in the WebCTRL® interface.</td>
</tr>
<tr>
<td><strong>Pattern</strong></td>
<td>Type <strong>none</strong>, <strong>dark</strong>, or <code>/common/lvl5/graphics/patterns/xxx.gif</code>, where <strong>xxx.gif</strong> is any .gif file in the <strong>webroot_common\lvl5\graphics\patterns</strong> folder.</td>
</tr>
<tr>
<td><strong>Priority Description</strong></td>
<td>The name used in the WebCTRL® interface.</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>Represents this priority’s relative level of importance within this schedule category. The WebCTRL® application automatically assigns the priority index, which is zero for the first priority level. The higher the index value, the higher the priority of the schedule type relative to other schedules. BACnet limits the number of priority indices to 16.</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>Color of the schedule bar on the <strong>Schedules</strong> page.</td>
</tr>
<tr>
<td><strong>Schedule Types</strong></td>
<td>The <strong>Weekly</strong> type is available for Index 0 only.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Allow Wildcards</strong> and <strong>Partial Day</strong> options affect all selected schedule types.</td>
</tr>
<tr>
<td><strong>Default Schedule</strong></td>
<td>The default schedule used when this category is selected. Create the schedule by adding segments for each state until every hour in the 24-hour schedule is covered by a segment. <strong>EXCEPTION</strong> If you selected <strong>Partial Day</strong> in the <strong>Schedule Types</strong> field, you do not have to add segments for the entire 24-hour period.</td>
</tr>
</tbody>
</table>
To view, edit, or delete a schedule category

1. On the **System Configuration** tree, click ⚙ to the left of the **Categories** folder, then click **Schedule**.
2. In the table, select the category you want to edit or delete.
3. Edit the fields or click **Delete**.
4. Click **Accept**.
The WebCTRL® system can read and store equipment status values over time and then display this information in a trend graph to help you monitor the equipment's operation.

You can collect trend data for any point value in the WebCTRL® system. The controller reads point values at intervals that you define and then stores that data in the controller. A controller has limited memory for storing trend data, so you can set up historical trending to archive the trend data from the controller to the WebCTRL® database. A trend graph can display data from the controller and the database, or it can display only data stored in the database.

After you set up the desired points for trend data collection (page 71), you can:

- View built-in trend graphs that show a single point (page 72)
- Create custom trend graphs with multiple points (page 73)
To collect trend data for a point

Before you can see a point's trend graph, you must enable trending for that point and then define how you want the controller to collect the point's data. This can be done in the EIKON® application or you can do it in the WebCTRL® interface using the instructions below.

**NOTE** I/O microblocks have trending capability built-in, and you enable trend logging in the I/O microblock. Any other microblock value must have a trend microblock attached in the control program, and you enable trend logging of the value in the trend microblock.

To set up a point's trending in the WebCTRL® interface:

1. On the Geographic tree, select the equipment that has the point you want to trend.
2. Click the Trends button drop-down arrow, select Disabled Points, then select the point.
4. Enter information in the appropriate fields. See table below.
5. Click Accept.

**TIP** You can set up all trends for a piece of equipment at once on the Trend Sources tab of the equipment's Properties page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
</table>
| **Sample every _:_:_ (_hh:mm:ss)_** | Records the point's value at this interval.  
  **NOTE** Set trend intervals for U line controllers to one minute or greater. U line controllers are designed to meet low end, high volume terminal control applications and are not suited to very short trend intervals. |
| **Sample on COV (change of value)** | Records the point's value only when the value changes by at least the amount of the COV Increment.  
  **NOTE** Use this method for a binary point or for an analog point that has infrequent changes in value. |
| **Max samples**                    | The maximum number of samples that you want the controller to store.  
  **CAUTION** Changing the value in Max samples will delete all of the point's trend samples currently stored in the controller. Click the Store Trends Now button before changing the value to transfer the trend data from the controller to the system database.  
  **NOTES**  
  - Trending consumes memory in the controller. The amount of memory available depends on the type of controller. Each trended point consumes 48 bytes of memory plus 10 bytes for each trend sample. Each trend microblock consumes 416 bytes of memory plus 10 bytes for each trend sample.  
  - Click Reset to delete all samples currently stored in the controller. |

The above sample and memory allocation fields together define trend data storage in the controller in terms of hours.

**EXAMPLE** If you set these fields so that samples are collected every 5 minutes for a maximum of 120 samples, the controller will store 600 minutes (5 x 120) or 10 hours of trend data.
**Field** | **Notes**
---|---
**Stop When Full** | Check this field to stop trend sampling when the maximum number of samples is reached.

**Enable trend log at specific times only** | Collects trend data for the specific period of time you define in the time and date fields.

**Enable Trend Historian** | Archives trend data to the system database.

**Store Trends Now** | Writes all trend data in the controller to the system database without having to enable trend historian.

**Write to historian every __ trend samples** | Writes all trend data in the controller to the system database each time the controller collects the number of samples that you enter in this field. This number must be greater than zero and less than the number entered in the field Max samples. The number of trends specified must be accumulated at least once before the historical trends can be viewed.

**Trend samples accumulated since last notification** | Shows the number of samples stored in the controller since data was last written to the database.

**Last Record Written to Historian** | Shows the number of trend samples that were last written to the database.

**Keep historical trends for __ days** | This is based on the date that the sample was read. Select the first option to use the system default that is defined on the System Settings > General tab. Select the second option to set a value for this trend only.

**Delete** | Deletes all trend samples stored in the database for the item selected on the Geographic tree.

**BACnet Configuration** | The Object Name is a unique alphanumeric string that defines the BACnet object. Although the Object Name field can be edited, it is not recommended. The Notification Class field is set to 1 to receive alarms generated by Automated Logic® controllers.

**NOTES**
- You can use Global Copy (page 44) to copy trend properties to other pieces of equipment that use the same control program.
- Run a Trend Usage report (page 119) to view trend configurations.

### Viewing a built-in, single-point trend graph

1. On the Geographic tree, select the equipment whose trend you want to view.
2. Click the Trends button drop-down arrow, select Enabled Points, and then select the graph you want to view.
3. Select the View tab. See Using trend graphs (page 76).
NOTE On the Configure tab, you can:

- Enable/disable the grid.
- Set the time range for the X axis. For example, enter 7 days to see the data for the last week.
- Turn off autoscaling so that you can define a range for the Y-axis.
- Type a Y-axis label that will appear on the right side of the graph.

Creating a custom trend graph

When creating a custom trend graph, you can select up to 16 points. If you select more than 4 points or points with different units, the WebCTRL® application splits the data into subgraphs. Each subgraph can show a maximum of 4 points with similar units.

To create a custom trend graph

1. On the Geographic tree, select the area or equipment where you want to see the graph.
2. Click the Trends button drop-down arrow, then select New Trend Graph.

   NOTE If the Trends button does not have a drop-down arrow, the New Trend Graph page is already displayed.

NOTES

- You must enable trending for points that you want to include in the custom trend graph. See To collect trend data for a point (page 71).

- You can display icons and hover text on the Geographic tree that show where custom trend graphs were created. See Tree icons and hover text (page 27).
In the tree on the **New Trend Graph** page, use **Ctrl+click** or **Shift+click** to select the points (16 maximum) that you want to see on a graph.

**NOTE** The tree shows only points that have trending enabled. See *To collect trend data for a point* (page 71).

4  Click **Save**.

5  Optional: If your system has trend categories defined, you can select a **Category** for this trend. For more information on trend categories, see *Adding trend categories* (page 75).

6  Type a **Name** for the graph that will appear at the top of the graph and in the **Trends** button drop-down list.

7  Click **OK**.

8  Select:
   - The **View** tab to see the custom trend graph. See *Using trend graphs* (page 76).
   - The **Configure** tab to edit the trend graph. See *To edit a custom trend graph* (page 74).

### To edit a custom trend graph

1  On the **Geographic** tree, select the area or equipment where you created the graph.

2  Select the **Trends > Configure** tab. On this page, you can:
   - Change the name of the custom trend graph
   - Enable/disable the grid
   - Set the time range for the X axis
   - Edit a subgraph's Y-axis label that will appear on the right side of the graph
   - Turn off autoscaling so that you can define a range for the Y-axis
   - Add/delete subgraphs (see instructions below)
   - Add/delete points (see instructions below)
   - Change a point's name on the graph
   - Change a binary point's active/inactive text on the graph
   - Click **Delete Trend Graph** to delete the entire custom trend graph

### To add a subgraph to a custom trend graph

1  Click **Add** below the **Subgraphs** list.

2  Type a Y-axis label.

3  Click **Add** below the **Points** list.

4  Select a point in the **Data source** tree.

   **NOTE** The tree shows only points that have trending enabled. See *To collect trend data for a point* (page 71).

5  Repeat steps 3 and 4 to add up to 4 points to the subgraph.

6  Click **Accept**.

   **NOTE** To delete a subgraph, select it in the **Subgraphs** list, click **Delete** below the list, and then click **Accept**.
To add a point to a subgraph
1. Select the subgraph in the Subgraphs list.
2. Click Add below the Points list.
3. Select a point from the Data source tree.
   **NOTE** The tree shows only points that have trending enabled. See To collect trend data for a point (page 71).
4. Click Accept.
   **NOTE** To delete a point, select the appropriate subgraph, select the point, click Delete below the Points list, and then click Accept.

Adding trend categories
A point trend graph is in the Enabled or Disabled category in the Trends button drop-down menu.

1. On the System Configuration tree, click ➢ to the left of Categories, then select Trend.
2. Click Add.
3. Type the Category Name and Reference Name.
4. Optional: Select a privilege so that only operators with that privilege can access trends in the category.
5. Click Accept.

**NOTES**
- To edit a category, select the category, make your changes, then click Accept.
- To delete a category, select the category, click Delete, then click Accept.
Using trend graphs

NOTES

- A gray triangle at the top of a graph indicates a note from the system. Hover your cursor on the triangle to see which of the following occurred:
  - Equipment received a time synchronization from its network router or from the WebCTRL® application.
  - Trend Historian has been enabled or disabled.
  - Trend Log has been enabled or disabled.
  - The trend object ID of a third-party trend source has been changed. For information only, you do not need to do anything.

- Click 📌 at the top of the WebCTRL® page to print the graph. You may need to set your printer's orientation to Landscape.

- Toolbar options are also accessible by right-clicking a trend graph.
An alarm is a message sent from an alarm source (usually a microblock in a control program) to the WebCTRL® application to notify you that certain conditions exist, such as a piece of equipment has stopped running or a temperature is too high. When the WebCTRL® application receives an alarm, it displays information about the alarm on the Alarms page. It can also perform alarm actions to inform personnel of the condition and to record information about the alarm. An alarm source can also send a return-to-normal message when the alarm condition returns to its normal state.

Alarm sources and the alarms they generate are assigned to categories, such as HVAC Critical or HVAC Maintenance, to help you work with related alarms.

The application engineer usually sets up alarm sources in the EIKON® application. In the WebCTRL® interface, you can:

- View, troubleshoot, acknowledge, and delete alarms (page 78)
- Set up the alarm actions that the WebCTRL® application performs (page 83)
- Edit alarm sources that were set up in the EIKON® application or set up new alarm sources to generate alarms (page 103)
- Customize alarms by changing the category or message (page 106)
NOTE Besides the alarms that you set up, the WebCTRL® application has built-in system and equipment alarms.

Viewing, troubleshooting, acknowledging, and deleting alarms

The WebCTRL® Alarms page displays alarms as they are received. If desired, an operator can set options on the My Settings page to have the WebCTRL® application play an audio file when an alarm is received.

An alarm's setup may require that it be acknowledged and/or the alarm condition returned to normal. The alarm, its return to normal, and any other alarms related to the incident are referred to as an alarm incident group. The WebCTRL® application closes an alarm incident group when all of the following have occurred:

- You acknowledge the alarm (if required)
- The WebCTRL® application receives a return-to-normal (if required)
- The WebCTRL® application performs all alarm actions defined for the group

You should delete alarms from your system as they are closed because large quantities of stored alarms can reduce the efficiency of your system.

To view alarms in the WebCTRL® interface

- Click at the top of the page to see all alarms in the system.
  or
- Click the Alarms button and then select an item on the navigation tree to see all alarms at and below that level.
NOTES

- The WebCTRL® tree can show 10 levels. If an alarm source is deeper than 10 levels, the alarm is reassigned to the system level.
- Alarms generated by the WebCTRL® application appear at the system level.
- Alarms generated by controllers appear at the system level on the Geographic tree, but in the
network hierarchy on the Network tree.

- An alarm's details include a path to the alarm source. Each section of the path is a link to that location. For example, in the path East Wing/RTU-4/SSP_LO, East Wing links to the East Wing graphic, RTU-4 links to the equipment graphic, and SSP_LO links to the microblock's Properties page.

To control which alarms you see

<table>
<thead>
<tr>
<th>Use these tools...</th>
<th>To control the Alarms list</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Next" /> <img src="image2" alt="Next" /></td>
<td>Click the arrow buttons to display other alarms.</td>
</tr>
<tr>
<td>Oldest alarms</td>
<td>Previous 50 alarms</td>
</tr>
<tr>
<td>Next 50 alarms</td>
<td>Newest alarm</td>
</tr>
</tbody>
</table>

Type a date and time or click ![Calendar](image3) to select a date. Then click Go to show up to 50 alarms since that date/time.

When finished, click ![Next](image4) to display the 50 newest alarms or ![Previous](image5) to display the oldest 50 alarms.

View By: Date

- Date—Sorts list by date/time the alarms were generated with the most recent at the top.
- To Do—Shows only alarms that require one or more actions before they are closed.
- Incident Group—Sorts alarms by incident. For example, an alarm and its return-to-normal form an incident group. Brackets indicate a group.

Select the alarm categories that you want to see in the alarms list. Use Ctrl+click, Shift+click, or both to select multiple categories, or check Show all categories.
To troubleshoot an alarm

You can select an alarm’s checkbox and then click \( \text{ Alarm } \) to open the Alarms time-lapse showing the 1-hour period in which the alarm occurred. You can step backward or forward through the time-lapse at 1-minute intervals to see what other alarms occurred at each minute during that hour. You can also go to the Graphics or Trends time-lapse to see what else happened when the alarm occurred. See Time-lapse (page 117) for information on this feature.

To acknowledge alarms

You must acknowledge alarms that have been set up to require acknowledgment. An alarm shows if it needs to be acknowledged. Below is a table showing the number of alarms that need acknowledgment at the current location (Here) and in the entire system (Total). This table also shows how many alarms need a return-to-normal and how many are closed.

<table>
<thead>
<tr>
<th>Count</th>
<th>Here</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Need Ack</td>
<td>637</td>
<td>637</td>
</tr>
<tr>
<td>Need Rtn</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>Closed</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

To acknowledge an alarm

1. On the Alarms page > View tab, select the checkbox of an alarm that shows Acknowledge.
2. Click the Acknowledge button.

To acknowledge all alarms in the alarms database for selected categories

1. On the Alarms page > View tab in the left-hand column, select the categories whose alarms you want to acknowledge.
   - **NOTE** Use Ctrl+click, Shift+click, or both to select multiple categories, or select the Select All checkbox.
2. Click Advanced.
3. Click Acknowledge All.
4. **TIP** Acknowledging many alarms simultaneously can take a long time. Acknowledge alarms as they occur to avoid long waits.
To delete alarms

You should delete alarms from your system as they are closed because large quantities of stored alarms can reduce the efficiency of your system. To save alarm information before deleting, select **Alarms > Reports** tab > **Alarms**, then click the **Run** button.

To delete an alarm

1. On the **Alarms** page > **View** tab, select an alarm’s checkbox.
2. Click **Delete**.

To delete all alarms in the alarms database for selected categories

1. On the **Alarms** page > **View** tab in the left-hand column, select the categories whose alarms you want to delete.
   
   **NOTE** Use Ctrl+click, Shift+click, or both to select multiple categories, or select the **Select All** checkbox.

2. Click **Advanced**.
3. Click **Delete All**.

To delete all closed alarm incident groups in the alarms database

An incident group is all alarms related to a particular incident. For example, an alarm and its return-to-normal form an alarm incident group. An incident group is considered closed when all alarms in the group are closed.

1. On the **Alarms** page > **View** tab in the left-hand column, select the categories whose alarms you want to delete.
   
   **NOTE** Use Ctrl+click, Shift+click, or both to select multiple categories, or select the **Select All** checkbox.

2. Click **Advanced**.
3. Click **Delete Closed Incidents**.

**NOTES**

- To have the WebCTRL® application automatically delete alarm incident groups a specified number of days after the groups close, select this option on the **System Settings** > **Scheduled Tasks** (page 176) tab.
- Also on the **System Settings** > **Scheduled Tasks** tab, you can set the WebCTRL® application to archive alarm information to a text file as alarms are deleted.
- An alarm source may be set up to generate an alarm and a return-to-normal. If an alarm occurs but the WebCTRL® application never receives the return-to-normal, you can select the alarm and then click **Force Normal** so that the alarm can be closed. **Force Normal** has no effect on the alarm condition that generated the alarm.
**To receive audible notification of alarms**

You can set up the WebCTRL® application to play an audio file on your workstation when it receives a critical or non-critical alarm.

1. On the **System Configuration** tree, select **My Settings**. See **To change My Settings** (page 136).
2. On the **Settings** tab, select **Non-critical alarms** or **Critical alarms** to be notified of each type of alarm.
3. In the **Sound File** field, type the path to the sound file.

When an alarm triggers the audio file to play, you can temporarily silence the sound by clicking and selecting **Silence**. The alarm is silenced for a period of about 5 minutes or until another alarm that triggers a sound is received.

**Setting up alarm actions**

The WebCTRL® application can perform alarm actions listed below to notify personnel of an alarm or to record information about the alarm. You can assign alarm actions to an alarm source, a category of alarm sources, alarm sources from a certain location, or a combination of these criteria.

The alarm actions are:
- Alarm Popup
- Print
- Propagate To Server
- Run External Program
- Send Alphanumeric Page
- Send E-Mail
- Write to File

If your system has the Advanced Alarming package, the WebCTRL® application can also perform the following alarm actions:
- Send SNMP Trap
- Write Property
- Write to Database

See the following topics for a description of each alarm action.

**To assign alarm actions to alarm sources**

**To assign alarm actions to multiple alarm sources**

Although you can assign an alarm action to a single alarm source, you typically assign an action to multiple alarm sources at the area or equipment level. The alarm action applies to all instances of the alarm sources at the selected location and below. Click an action’s **Edit** button to make any changes.

To assign an alarm action to alarm sources:

1. On the **Geographic** or **Network** tree, select the area, equipment, or controller containing the alarm sources.
2. On the **Alarms** page > **Actions** tab, follow the 3 steps on the screen.

**NOTE** Use **Ctrl+click**, **Shift+click**, or both to select multiple items.
3 Click **Add**.

4 Set up the alarm action by editing the fields on the alarm action page. See the appropriate alarm action below for field descriptions.

5 Click **Accept**.

After you have assigned alarm actions to an alarm source, *simulate the alarm* (page 106) to check your work. If an alarm action fails, the WebCTRL® application receives an alarm for the failed action.

**NOTES**

- Click **View Selected Sources** to view or change settings for each alarm.

- You can display icons and hover text on the **Geographic** tree that show where alarm actions have been created. See *Tree icons and hover text* (page 27).

---

### To assign an alarm action to a single alarm source

1 On the **Geographic** or **Network** tree, select the alarm source (microblock).
2 On the **Alarms** page > **Actions** tab, click the drop-down arrow, then select an alarm action.
3 Click **Add**.
4 Set up the alarm action by editing the fields on the alarm action page. See the appropriate alarm action below for field descriptions.
5 Click **Accept**.

---

### Alarm Popup

The **Alarm Popup** alarm action pops up a message on any computer with a Windows® operating system that is running the WebCTRL® Alarm Notification Client application.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Operator</td>
<td>Select individual operators or operator groups who should receive alarm notification.</td>
</tr>
<tr>
<td>To Group</td>
<td></td>
</tr>
<tr>
<td>Generate alarm if delivery fails</td>
<td>Check this field to generate a System Info alarm if the popup recipient is not currently running the Alarm Notification Client application.</td>
</tr>
<tr>
<td>Message text</td>
<td>Use punctuation, spaces, or returns after the entries to format the text. To add live data to the text, select <em>field codes</em> (page 110) from the <strong>Append Field Code</strong> list.</td>
</tr>
<tr>
<td>Append Field Code</td>
<td>Add <em>field codes</em> (page 110) to the message text if desired.</td>
</tr>
</tbody>
</table>
Perform Action

By default, the WebCTRL® application performs an alarm action when the alarm source generates an alarm and when it returns to normal. Under **Perform Action**, you can choose to run the alarm action:

- Only when the alarm source generates an alarm or when it returns to normal.
- After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this option for alarm escalation. *
- If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the unoccupied hours defined for a schedule group. *

**EXAMPLE** To have one alarm action performed during work hours and a different alarm action performed after work hours:

1. Create a *schedule group* (page 62), but do not assign members to it.
2. Create a schedule for the group. Set the occupied hours to be the same as the work hours.
3. Create the alarm action that is to be performed during work hours. Under **Perform Action**, select *If schedule group <your new group> is Occupied*.
4. Create the alarm action that is to be performed after work hours. Under **Perform Action**, select *If schedule group <your new group> is Unoccupied*.

* Available only if you have the Advanced Alarming package.

---

Using the Alarm Notification Client application

The Alarm Notification Client application must be running on each client computer (Windows only) that should receive popup notifications. Keep the application minimized to the right side of the Windows task bar. The window will pop up with a message when an alarm occurs.

Select an alarm message, then click ![Silence!] to open the WebCTRL® interface displaying the piece of equipment that generated the alarm. A grayed out alarm indicates that it was acknowledged in the WebCTRL® interface.

If the Alarm Notification Client is set up to play a continuous alarm sound, you can silence an alarm by clicking **Silence!**, by pressing `Ctrl+S`, or by acknowledging the alarm in the WebCTRL® interface.
<table>
<thead>
<tr>
<th>Button</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Opens the WebCTRL® interface displaying the equipment that generated the alarm.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTES</strong></td>
</tr>
<tr>
<td></td>
<td>• If WebCTRL Server is to use https (SSL), you must do the following to enable communication between the server and Alarm Notification Client. In SiteBuilder, go to Configure &gt; Preferences &gt; Web Server. For <strong>Enabled Web Server Ports</strong>, select <strong>Both HTTP and SSL</strong> or <strong>SSL only</strong>. In the Server Connection field described below, enter the number of the SSL port.</td>
</tr>
<tr>
<td></td>
<td>• If WebCTRL Server is v6.0 and an Alarm Notification Client is an earlier version, you will have to log in when you click 🗝.</td>
</tr>
<tr>
<td></td>
<td>Copies the selected alarm information to the clipboard.</td>
</tr>
<tr>
<td></td>
<td>Removes the alarm information from the alarm popup list. Removing items from this list has no effect on the alarms list in the WebCTRL® interface.</td>
</tr>
<tr>
<td></td>
<td>View information about the server connection.</td>
</tr>
<tr>
<td></td>
<td><strong>On this tab...</strong> <strong>You define...</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Server Connection</strong></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you upgraded Alarm Notification Client to v6.0, you will need to reenter your operator name and password on this tab while Alarm Notification Client is connected to the WebCTRL Server application.</td>
</tr>
<tr>
<td></td>
<td>• The default port is TCP 47806. If you change this, you must also change the <strong>Port</strong> field in the WebCTRL® System Settings. See “To set up the WebCTRL Server application to support Alarm Popup clients” below.</td>
</tr>
<tr>
<td></td>
<td><strong>Browse To</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Notification Sounds</strong></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
To set up the WebCTRL Server application to support Alarm Popup clients

1. On the System Configuration tree, select System Settings.
2. On the General tab, select Enable support for Alarm Notification Clients to connect to this server.
3. If the server has more than one network interface adapter, type in the Restrict to IP Address field the IP address that the Alarm Notification Client application will connect to. You must specify the same IP address in the Server field in the Alarm Notification Client.
4. Use the default port or specify a different port. You must specify the same port in the Port field in the Alarm Notification Client.
5. Click Accept.

NOTE If the Alarm Notification Client application is not on the local network and will access WebCTRL® alarms through a NAT router, you must port forward the TCP port you defined in step 4 above.

To install the Alarm Notification Client application

Follow the steps below on each client computer that should receive alarm popups.

PREREQUISITE Enable support for Alarm Popup client in System Settings. See above topic.

1. On the System Configuration tree, click Client Installs.
2. Select Alarm Notification Client.
3. Click Run, then follow the on-screen instructions to install the Alarm Notification Client application. After you click Done, the application starts automatically.
4. In the Settings dialog box, enter appropriate values. You can also click to open this box. See the table above for a description of each setting.

NOTE You can lock the Settings so that a user cannot edit them. See To lock a client’s Settings feature below.

5. Click OK.

To lock a client’s Settings feature

To prevent a user from editing the Settings:

1. Right-click Alarm Notification Client in the Windows Start menu.
2. Select Properties.
On the **Shortcut** tab, type `-lockconfig` at the end of the **Target** path.

---

**Print**

The **Print** alarm action prints alarm information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
</table>
| **Text Printing** | Select to use the WebCTRL® server's local dot-matrix printer. Text Printing will not print to a network printer.  
In the **Port Name** field, type the computer port that the printer is connected to.  
In the **Line Width** field, type the number of characters to be printed per line.  
Prints multiple alarms per page.                                                                                     |
| **Graphics Printing** | Select to use the WebCTRL® server's default printer (local or network printer). Prints one alarm per page to the WebCTRL® server's default printer.                 |
| **Text to Print**  | Use punctuation, spaces, or returns after the entries to format the text.  
To add live data to the text, select **field codes** (page 110) from the **Append Field Code** list.                                                   |
| **Perform Action** | By default, the WebCTRL® application performs an alarm action when the alarm source generates an alarm and when it returns to normal.  
Under **Perform Action**, you can choose to run the alarm action:  
• Only when the alarm source generates an alarm or when it returns to normal.  
• After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this option for alarm escalation. *  
• If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the unoccupied hours defined for a schedule group. * |
EXAMPLE  To have one alarm action performed during work hours and a different alarm action performed after work hours:

1. Create a schedule group (page 62), but do not assign members to it.
2. Create a schedule for the group. Set the occupied hours to be the same as the work hours.
3. Create the alarm action that is to be performed during work hours. Under **Perform Action**, select **If schedule group <your new group> is Occupied**.
4. Create the alarm action that is to be performed after work hours. Under **Perform Action**, select **If schedule group <your new group> is Unoccupied**.

* Available only if you have the Advanced Alarming package.

**Propagate To Server**

The **Propagate To Server** alarm action sends the selected alarm to the parent server in a system with hierarchical servers.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Message text</strong></td>
<td>The alarm message that is sent to the parent server.</td>
</tr>
<tr>
<td><strong>Append Field Code</strong></td>
<td>Add field codes (page 110) to include live data in the <strong>Message text</strong> field.</td>
</tr>
<tr>
<td><strong>Perform Action</strong></td>
<td>By default, the WebCTRL® application performs an alarm action when the alarm source generates an alarm and when it returns to normal. Under <strong>Perform Action</strong>, you can choose to run the alarm action:</td>
</tr>
<tr>
<td></td>
<td>• Only when the alarm source generates an alarm or when it returns to normal.</td>
</tr>
<tr>
<td></td>
<td>• After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this option for alarm escalation. *</td>
</tr>
<tr>
<td></td>
<td>• If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the unoccupied hours defined for a schedule group. *</td>
</tr>
</tbody>
</table>
|                | EXAMPLE  To have one alarm action performed during work hours and a different alarm action performed after work hours:
|                | 1. Create a schedule group (page 62), but do not assign members to it.
|                | 2. Create a schedule for the group. Set the occupied hours to be the same as the work hours.
|                | 3. Create the alarm action that is to be performed during work hours. Under **Perform Action**, select **If schedule group <your new group> is Occupied**.
|                | 4. Create the alarm action that is to be performed after work hours. Under **Perform Action**, select **If schedule group <your new group> is Unoccupied**. |
|                | * Available only if you have the Advanced Alarming package. |
The **Run External Program** alarm action starts a program or batch file on the server.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Command Line</strong></td>
<td>The path of the executable file on the WebCTRL® server followed by the path of the output file.</td>
</tr>
<tr>
<td></td>
<td><strong>EXAMPLE:</strong></td>
</tr>
<tr>
<td></td>
<td>c:\windows\notepad.exe c:\WebCTRL\webroot\alarms.txt</td>
</tr>
<tr>
<td><strong>Append Field Code</strong></td>
<td>Add field codes (page 110) to the <strong>Command Line</strong> field.</td>
</tr>
<tr>
<td></td>
<td><strong>EXAMPLE:</strong></td>
</tr>
<tr>
<td></td>
<td>c:\reports\run_report.bat $Generation_time$$To_State$</td>
</tr>
<tr>
<td></td>
<td>This starts a batch file on the server and uses the alarm’s generation time and state as values.</td>
</tr>
<tr>
<td><strong>Synchronize</strong></td>
<td>Tells the WebCTRL® application to wait for the external program to finish running before initiating the next <strong>Run External Program</strong> alarm action.</td>
</tr>
<tr>
<td><strong>Perform Action</strong></td>
<td>By default, the WebCTRL® application performs an alarm action when the alarm source generates an alarm and when it returns to normal. Under <strong>Perform Action</strong>, you can choose to run the alarm action:</td>
</tr>
<tr>
<td></td>
<td>• Only when the alarm source generates an alarm or when it returns to normal.</td>
</tr>
<tr>
<td></td>
<td>• After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this option for alarm escalation. *</td>
</tr>
<tr>
<td></td>
<td>• If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the unoccupied hours defined for a schedule group. *</td>
</tr>
<tr>
<td></td>
<td><strong>EXAMPLE</strong> To have one alarm action performed during work hours and a different alarm action performed after work hours:</td>
</tr>
<tr>
<td></td>
<td>1. Create a schedule group (page 62), but do not assign members to it.</td>
</tr>
<tr>
<td></td>
<td>2. Create a schedule for the group. Set the occupied hours to be the same as the work hours.</td>
</tr>
<tr>
<td></td>
<td>3. Create the alarm action that is to be performed during work hours.</td>
</tr>
<tr>
<td></td>
<td>Under <strong>Perform Action</strong>, select <strong>If schedule group &lt;your new group&gt; is Occupied</strong>.</td>
</tr>
<tr>
<td></td>
<td>4. Create the alarm action that is to be performed after work hours.</td>
</tr>
<tr>
<td></td>
<td>Under <strong>Perform Action</strong>, select <strong>If schedule group &lt;your new group&gt; is Unoccupied</strong>.</td>
</tr>
<tr>
<td></td>
<td>* Available only if you have the Advanced Alarming package.</td>
</tr>
</tbody>
</table>
The **Send Alphanumeric Page** alarm action sends a page to one or more alphanumeric pagers or sends text messages to cell phones. The pager or phone must be able to accept e-mail.

### Field Notes

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td>Type the address(es) that you want to send the alarm to. To enter multiple addresses, type a space or press <strong>Enter</strong> after each address.</td>
</tr>
<tr>
<td><strong>From</strong></td>
<td>Enter a valid address if required by your mailserver.</td>
</tr>
<tr>
<td><strong>Mail Host</strong></td>
<td>The mailserver's address. This can be an IP address or a system name, such as mail.mycompany.com.</td>
</tr>
<tr>
<td><strong>Mail Host Port</strong></td>
<td>Change this field if using a port other than the default port 25.</td>
</tr>
<tr>
<td><strong>Mail Host Security Options</strong></td>
<td>Select the type of security the mailserver uses.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Cleartext</strong> – Uses the SMTP protocol to send as clear text over TCP/IP</td>
</tr>
<tr>
<td></td>
<td>• <strong>Secure SSL</strong> – Uses SSL, a communication protocol that provides data encryption</td>
</tr>
<tr>
<td></td>
<td>• <strong>Secure TLS</strong> – Uses TLS, but does not begin encryption until the WebCTRL® application issues STARTTLS command</td>
</tr>
<tr>
<td><strong>Specify Mail User For Mail Host Authentication</strong></td>
<td>Select if your mailserver requires a username and password.</td>
</tr>
<tr>
<td><strong>Send mail as MIME attachment</strong></td>
<td>Select if your mailserver allows only MIME attachments.</td>
</tr>
<tr>
<td><strong>Message Text</strong></td>
<td>Use punctuation, spaces, or returns after the entries to format the text. To add live data to the text, select <strong>field codes</strong> (page 110) from the <strong>Append Field Code</strong> list.</td>
</tr>
<tr>
<td><strong>Perform Action</strong></td>
<td>By default, the WebCTRL® application performs an alarm action when the alarm source generates an alarm and when it returns to normal. Under <strong>Perform Action</strong>, you can choose to run the alarm action:</td>
</tr>
<tr>
<td></td>
<td>• Only when the alarm source generates an alarm or when it returns to normal.</td>
</tr>
<tr>
<td></td>
<td>• After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this option for alarm escalation. *</td>
</tr>
<tr>
<td></td>
<td>• If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the unoccupied hours defined for a schedule group. *</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>To have one alarm action performed during work hours and a different alarm action performed after work hours:</td>
</tr>
</tbody>
</table>
1. Create a schedule group (page 62), but do not assign members to it.
2. Create a schedule for the group. Set the occupied hours to be the same as the work hours.
3. Create the alarm action that is to be performed during work hours. Under Perform Action, select If schedule group <your new group> is Occupied.
4. Create the alarm action that is to be performed after work hours. Under Perform Action, select If schedule group <your new group> is Unoccupied.

* Available only if you have the Advanced Alarming package.

**NOTE** You should not assign this alarm action to frequently-occurring alarms as this may cause problems on your network or the Internet.

To secure mailserver communication using SSL or TLS
Before the WebCTRL® application sends an email using SSL or TLS, it requests an SSL certificate from the mailserver. If the certificate that the WebCTRL® application receives is in its list of trusted certificates, it sends the email. If the certificate is not in the list, the WebCTRL® application generates a system alarm indicating that the email alarm action failed. If this occurs, you will need to add the mailserver’s certificate to the WebCTRL® application’s list of trusted certificates.

1. Get a copy of the certificate file from the mailserver. Ask your Network Administrator for help.
2. Put the file on the WebCTRL® server.
3. On the WebCTRL® server, click the Windows® Start button.
4. In the Search programs and files field, type the following command:

   C:\WebCTRL<x.x>\bin\java\jre\bin\keytool.exe -import -trustcacerts -alias smtpserver -keystore webserver\keystores\certkeys -file <file_path>

   replacing:
   <x.x> with the system’s version number
   <file_path> with the full path and file name of the certificate file

5. The information for the smtpserver key is displayed and you are prompted to trust this certificate. Type yes.

**NOTE** If your mailserver is using SSL or TLS, the WebCTRL® server is running antivirus software, and the email alarm action fails because it cannot find an SSL certificate, do one of the following:

- Disable scanning of outgoing SMTP traffic in the antivirus software. See your antivirus software's Help for assistance.
- Obtain the antivirus software's SSL certificate and install it on the WebCTRL® server using the above procedure.
To set up a dial-up networking connection
The WebCTRL® application can use a dial-up internet connection through a modem to deliver e-mail for the Send E-mail or Send Alphanumeric Page alarm action.

To set up the dial-up connection:

1. Set up your modem to dial out to your Internet Service Provider. See your modem documentation.
2. On the WebCTRL® server, open Internet Explorer®.
3. Select Tools or 🗼 > Internet Options.
4. On the Connections tab, click Setup.
5. Follow the instructions in the wizard. See Windows Help for assistance.
6. In a text editor such as Windows Notepad, open WebCTRLx.x\webroot\<system>\system.properties.
7. At the end of the file, type the following line:
   
   repactions.connection.name=<name of connection>
   
   where <name of connection> is the ISP name you entered in the wizard in step 2.
8. Open Internet Explorer, then select Tools > Internet Options > Connections tab.
9. If the box under Dial-up and Virtual Private Network settings shows more than one connection, select the connection that you just created, then click Set Default.
10. Select Always dial my default connection.

Send E-mail

The Send E-mail alarm action sends a message to one or more e-mail accounts. The alarm action can also run a report and attach it to the e-mail as a PDF, HTML, or XLS file.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td>Type the address(es) that you want to send the alarm to. To enter multiple addresses, type a space or press <strong>Enter</strong> after each address.</td>
</tr>
<tr>
<td><strong>From</strong></td>
<td>Enter a valid address if required by your mailserver.</td>
</tr>
<tr>
<td><strong>Mail Host</strong></td>
<td>The mailserver's address. This can be an IP address or a system name, such as mail.mycompany.com.</td>
</tr>
<tr>
<td><strong>Mail Host Port</strong></td>
<td>Change this field if using a port other than the default port 25.</td>
</tr>
<tr>
<td><strong>Mail Host Security Options</strong></td>
<td>Select the type of security the mailserver uses.</td>
</tr>
<tr>
<td>• <strong>ClearText</strong></td>
<td>Uses the SMTP protocol to send as clear text over TCP/IP</td>
</tr>
<tr>
<td>• <strong>Secure SSL</strong></td>
<td>Uses SSL, a communication protocol that provides data encryption</td>
</tr>
<tr>
<td>• <strong>Secure TLS</strong></td>
<td>Uses TLS, but does not begin encryption until the WebCTRL® application issues STARTTLS command</td>
</tr>
<tr>
<td><strong>Specify Mail User For Mail Host Authentication</strong></td>
<td>Select if your mailserver requires a username and password.</td>
</tr>
<tr>
<td><strong>Send mail as MIME attachment</strong></td>
<td>Select if your mailserver allows only MIME attachments.</td>
</tr>
<tr>
<td>Field</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Message Text</strong></td>
<td>Use punctuation, spaces, or returns after the entries to format the text. To add live data to the text, select <strong>field codes</strong> (page 110) from the <strong>Append Field Code</strong> list.</td>
</tr>
</tbody>
</table>
| **Attach Report**     | Select to attach a report to the e-mail, then select the **Report** and the **Format**. The attached report will include the date and time. For example, **Alarm Sources 2012 Jan 01 1230**.  
**NOTE** The Report Name field shows a custom report only if it was created at the current system level.  
**Run as** shows the name and login name of the operator creating the alarm action. The report will be run using the privileges and report options of this operator.  
**TIP** You may want to create a new operator with limited privileges for this purpose. |
| **Perform Action**    | By default, the WebCTRL® application performs an alarm action when the alarm source generates an alarm and when it returns to normal. Under **Perform Action**, you can choose to run the alarm action:  
- Only when the alarm source generates an alarm or when it returns to normal.  
- After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this option for alarm escalation. *  
- If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the unoccupied hours defined for a schedule group. *  
**EXAMPLE** To have one alarm action performed during work hours and a different alarm action performed after work hours:  
1. Create a **schedule group** (page 62), but do not assign members to it.  
2. Create a schedule for the group. Set the occupied hours to be the same as the work hours.  
3. Create the alarm action that is to be performed during work hours. Under **Perform Action**, select **If schedule group <your new group> is Occupied**.  
4. Create the alarm action that is to be performed after work hours. Under **Perform Action**, select **If schedule group <your new group> is Unoccupied**.  
* Available only if you have the Advanced Alarming package. |

**NOTE** You should not assign this alarm action to frequently-occurring alarms as this may cause problems on your network or the Internet.  

**To secure mailserver communication using SSL or TLS**  
Before the WebCTRL® application sends an email using SSL or TLS, it requests an SSL certificate from the mailserver. If the certificate that the WebCTRL® application receives is in its list of trusted certificates, it sends the email. If the certificate is not in the list, the WebCTRL® application generates
a system alarm indicating that the email alarm action failed. If this occurs, you will need to add the
mailserver's certificate to the WebCTRL® application's list of trusted certificates.

1. Get a copy of the certificate file from the mailserver. Ask your Network Administrator for help.
2. Put the file on the WebCTRL® server.
3. On the WebCTRL® server, click the Windows® Start button.
4. In the Search programs and files field, type the following command:

   C:\WebCTRL<x.x>\bin\java\jre\bin\keytool.exe -import -trustcacerts
   -alias smtpserver -keystore webserver\keystores\certkeys -file <file_path>

   replacing:
   <x.x> with the system's version number
   <file_path> with the full path and file name of the certificate file
5. The information for the smtpserver key is displayed and you are prompted to trust this certificate.
   Type yes.

   NOTE If your mailserver is using SSL or TLS, the WebCTRL® server is running antivirus software, and
   the email alarm action fails because it cannot find an SSL certificate, do one of the following:
   • Disable scanning of outgoing SMTP traffic in the antivirus software. See your antivirus software's
     Help for assistance.
   • Obtain the antivirus software's SSL certificate and install it on the WebCTRL® server using the
     above procedure.

To set up a dial-up networking connection
The WebCTRL® application can use a dial-up internet connection through a modem to deliver e-mail
for the Send E-mail or Send Alphanumeric Page alarm action.
To set up the dial-up connection:
1. Set up your modem to dial out to your Internet Service Provider. See your modem documentation.
2. On the WebCTRL® server, open Internet Explorer®.
3. Select Tools or Internet Options.
4. On the Connections tab, click Setup.
5. Follow the instructions in the wizard. See Windows Help for assistance.
6. In a text editor such as Windows Notepad, open WebCTRLx.x\webroot<system>\system.properties.
7. At the end of the file, type the following line:

   repactions.connection.name=<name of connection>

   where <name of connection> is the ISP name you entered in the wizard in step 2.
8. Open Internet Explorer, then select Tools > Internet Options > Connections tab.
9. If the box under Dial-up and Virtual Private Network settings shows more than one connection,
   select the connection that you just created, then click Set Default.
10. Select Always dial my default connection.
Send SNMP Trap

### Optional WebCTRL Package

**NOTE** To see if your system has this optional package, click **About**. You have this package if Enabled Features shows Adv. Alarming.

The Send SNMP Trap alarm action sends an SNMP trap in response to receiving an alarm. Traps contain the text created in the **Text to send as the SNMP Trap** field in the alarm action dialog box. You can configure up to five SNMP servers to receive traps.

**NOTES**

- WebCTRL® supports SNMP v1.
- Each SNMP server you want to receive these traps must have SNMP monitoring equipment installed. If problems arise with your SNMP connection or receiving traps, contact your IS department.
- This alarm action uses Port 162 to send SNMP traps. To use a different port, open WebCTRL\x.webroot\<system_name>\system.properties in a text editor such as Notepad. In the line `#snmp.trap.port = 162`, delete `#` at the beginning of the line and change 162 to the port you want to use. If you make this change while the WebCTRL Server application is running, you must restart it to have the change take effect.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network Address</strong></td>
<td>The network address of the SNMP server receiving the SNMP trap.</td>
</tr>
<tr>
<td><strong>Community Name</strong></td>
<td>The community name that the SNMP server belongs to.</td>
</tr>
<tr>
<td><strong>Comment</strong></td>
<td>The physical location of the SNMP server. This field is optional.</td>
</tr>
<tr>
<td><strong>Trap number</strong></td>
<td>If the network administrator has configured trap numbers, type a unique number from 1 to 127. <strong>NOTE</strong> The same trap number is used for all messages from this alarm action.</td>
</tr>
<tr>
<td><strong>Text to send as the SNMP Trap</strong></td>
<td>255 character limit. Type punctuation, spaces, or returns after the entries to format the message. You can customize this text by selecting field codes (page 110) from the Append Field Code list.</td>
</tr>
</tbody>
</table>
| **Perform Action** | By default, the WebCTRL® application performs an alarm action when the alarm source generates an alarm and when it returns to normal. Under Perform Action, you can choose to run the alarm action:  
  - Only when the alarm source generates an alarm or when it returns to normal.  
  - After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this option for alarm escalation. *  
  - If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the unoccupied hours defined for a schedule group. * |
EXAMPLE To have one alarm action performed during work hours and a different alarm action performed after work hours:
   1. Create a schedule group (page 62), but do not assign members to it.
   2. Create a schedule for the group. Set the occupied hours to be the same as the work hours.
   3. Create the alarm action that is to be performed during work hours. Under **Perform Action**, select **If schedule group <your new group> is Occupied**.
   4. Create the alarm action that is to be performed after work hours. Under **Perform Action**, select **If schedule group <your new group> is Unoccupied**.

* Available only if you have the Advanced Alarming package.

** Ask your network administrator for this information.

### Write Property

**Optional WebCTRL Package**

NOTE To see if your system has this optional package, click , then select **About**. You have this package if **Enabled Features** shows **Adv. Alarming**.

The **Write Property** alarm action writes a specified value to a BACnet property. You typically set up 2 alarm actions, the first writes a value when the alarm occurs and the other writes a value when the return-to-normal occurs.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
</table>
| **Expression** | Type the path to the target property. To get the path, right-click the property on a Properties page, then select **Global Modify**. The Geographic Location field in the **Advanced** section shows the path. Click to copy it. **NOTES**
|                | • A BACnet Parameter microblock's present value cannot be written to directly. However, you can change the present value by writing to the relinquish_default property, or to the priority_array/priority16 property. For example, change 
|                |   #rtu-1/vfd_ovrde/present_value to 
|                |   #rtu-1/vfd_ovrde/relinquish_default, or 
|                |   #rtu-1/vfd_ovrde/priority_array/priority16. 
|                | • Do not use a BACnet address in this field. |
| **Value to Write** | Type the value you want to write to the microblock property. Type 0 or 1 for a binary property. |
| **Append field code to value** | Select field codes (page 110) to add this information to the Value to Write field. |
Perform Action

By default, the WebCTRL® application performs an alarm action when the alarm source generates an alarm and when it returns to normal. Under **Perform Action**, you can choose to run the alarm action:

- Only when the alarm source generates an alarm or when it returns to normal.
- After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this option for alarm escalation. *
- If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the unoccupied hours defined for a schedule group. *

**EXAMPLE** To have one alarm action performed during work hours and a different alarm action performed after work hours:

1. Create a schedule group (page 62), but do not assign members to it.
2. Create a schedule for the group. Set the occupied hours to be the same as the work hours.
3. Create the alarm action that is to be performed during work hours. Under **Perform Action**, select **If schedule group <your new group> is Occupied**.
4. Create the alarm action that is to be performed after work hours. Under **Perform Action**, select **If schedule group <your new group> is Unoccupied**.

* Available only if you have the Advanced Alarming package.

---

**Write to Database**

**Optional WebCTRL Package**

**NOTE** To see if your system has this optional package, click , then select **About**. You have this package if **Enabled Features** shows **Adv. Alarming**.

The **Write to Database** alarm action stores alarm information in a table in the WebCTRL® alarm database or in a custom database. Third-party applications can access the alarm information for building maintenance management or alarm analysis. For example, an application can perform actions such as triggering a stored procedure or running a report.

**Writing to the WebCTRL® alarm database**

When you add the **Write to Database** alarm action, by default the WebCTRL® application writes alarm information to the **write_db_ra** table in the WebCTRL® alarm database. The following table describes the information that is written to the database and gives the column name and data type that you will need to access the alarm information from a third-party application.
<table>
<thead>
<tr>
<th>Description</th>
<th>Column Name</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm generation time</td>
<td>EVENT_TIME_</td>
<td>Datestamp</td>
</tr>
<tr>
<td>Path to the alarm source Example: #slm/m073</td>
<td>SOURCE_PATH_</td>
<td>String</td>
</tr>
<tr>
<td>Display name path to the alarm source Example:</td>
<td>DISPLAY_NAME_</td>
<td>String</td>
</tr>
<tr>
<td>Atlanta Office/R&amp;D Facility/Second Floor/VA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>V 2-1/Z one Temp</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm state Example: OFF NORMAL, LOW LIMIT,</td>
<td>EVENT_STATE_</td>
<td>String</td>
</tr>
<tr>
<td>HIGH LIMIT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm text as defined in the Text to write to</td>
<td>RA_TEXT_</td>
<td>String</td>
</tr>
<tr>
<td>the database field on the alarm action page. You</td>
<td></td>
<td></td>
</tr>
<tr>
<td>can add live data to the text by selecting</td>
<td></td>
<td></td>
</tr>
<tr>
<td>field codes (page 110) from the Append Field</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code list.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Perform Action**

By default, the WebCTRL® application performs an alarm action when the alarm source generates an alarm and when it returns to normal. Under **Perform Action**, you can choose to run the alarm action:

- Only when the alarm source generates an alarm or when it returns to normal.
- After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this option for alarm escalation. *
- If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the unoccupied hours defined for a schedule group. *

**EXAMPLE** To have one alarm action performed during work hours and a different alarm action performed after work hours:

1. Create a schedule group (page 62), but do not assign members to it.
2. Create a schedule for the group. Set the occupied hours to be the same as the work hours.
3. Create the alarm action that is to be performed during work hours. Under **Perform Action**, select **If schedule group <your new group> is Occupied**.
4. Create the alarm action that is to be performed after work hours. Under **Perform Action**, select **If schedule group <your new group> is Unoccupied**.

* Available only if you have the Advanced Alarming package.

**NOTES**

- To keep the database table from growing too large, you must delete old entries using a third-party database application. You cannot view, edit, or delete entries in the WebCTRL® interface.
- If your system uses an Access or Derby database, you cannot open the database in a third-party application while the WebCTRL® or SiteBuilder application is running.
Writing to a custom database

The WebCTRL® application can write alarm information to the following types of custom databases. The custom database does not have to be the same type as the WebCTRL® database.

- SQL Server
- MySQL
- PostgreSQL
- Oracle

You may create a table in an existing third-party database or create a new database.

Using your database management tool, create a table in your custom database that includes fields for each alarm field code to be written to the table. Each field length in the table should be as long as the longest value to be written to that field.

To set up writing to a custom database instead of the WebCTRL® alarm database, check Specify Custom Database on the Alarms page Actions tab, then enter information in the remaining fields. See table below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text to write to the database</td>
<td>The text is made up of field codes (page 110) that add live data to the text. You can select additional field codes from the Append Field Code list. NOTE To write the text in this field to the custom database, you must include the Report Text field code ($report_text$) in the Database Insert String field described below.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Database Connect String</th>
<th>For database type...</th>
<th>The connect string format is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Server</td>
<td>jdbc:odbc:&lt;odbc_alias&gt;</td>
<td></td>
</tr>
<tr>
<td>MySQL</td>
<td>jdbc:mysql://&lt;host&gt;:&lt;port&gt;/&lt;instance&gt;</td>
<td></td>
</tr>
<tr>
<td>PostgreSQL</td>
<td>jdbc:postgresql://&lt;host&gt;:&lt;port&gt;/&lt;instance&gt;</td>
<td></td>
</tr>
<tr>
<td>Oracle</td>
<td>jdbc:oracle:thin@&lt;host&gt;:&lt;port&gt;/&lt;instance&gt;</td>
<td></td>
</tr>
</tbody>
</table>

where:
- <host> is the database server name/IP address
- <port> is the port number for the database
- <instance> is the database name in the database server
- <odbc_alias> is the name of the ODBC data source

| Database Login and Password | The login and password to connect to the database. |
**Database Insert String**

Use the following format:

Insert into <TABLE_NAME> (<column1_name>, <column2_name> ...) values
($field_code1$, $field_code2$, ...)

Example:

Insert into WebCTRL_ALARMS (TIME_, LOCATION_, TO_STATE_, TEXT_) values
($generation_time$, $location_path$, $to_state$, $report_text$)

**NOTES**

- You can add field codes (page 110) to the Insert String using the Append Field Code list.
- If you add a timestamp type field code (for example, $generation_time$), you should have the data go into a timestamp data type field in the custom database. Otherwise, you must use field code formatting (page 110) to format the time.
- You can add only one Database Insert String per alarm action.

**Perform Action**

By default, the WebCTRL® application performs an alarm action when the alarm source generates an alarm and when it returns to normal. Under Perform Action, you can choose to run the alarm action:

- Only when the alarm source generates an alarm or when it returns to normal.
- After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this option for alarm escalation. *
- If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the unoccupied hours defined for a schedule group. *

**EXAMPLE**

To have one alarm action performed during work hours and a different alarm action performed after work hours:

1. Create a schedule group (page 62), but do not assign members to it.
2. Create a schedule for the group. Set the occupied hours to be the same as the work hours.
3. Create the alarm action that is to be performed during work hours. Under Perform Action, select If schedule group <your new group> is Occupied.
4. Create the alarm action that is to be performed after work hours. Under Perform Action, select If schedule group <your new group> is Unoccupied.

* Available only if you have the Advanced Alarming package.
**Write to File**

The **Write to File** alarm action can do either of the following:

- Record alarm information in a standard ASCII text file that you can view and edit using a text editor such as Windows® Notepad.
- Write a WebCTRL® report to a file.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>Path name for the file you want to write to such as <code>c:\WebCTRLx.x\webroot\alarms.txt</code>.</td>
</tr>
<tr>
<td></td>
<td>- If you do not specify a path, the file is written to the system folder.</td>
</tr>
<tr>
<td></td>
<td>- If you type a path that does not exist, the WebCTRL® application will create the necessary folders.</td>
</tr>
<tr>
<td></td>
<td>- You can write to one of the following:</td>
</tr>
<tr>
<td></td>
<td>- a file on the server</td>
</tr>
<tr>
<td></td>
<td>- a networked computer if you map the network drive. Use the drive mapping in the path from the server to the computer.</td>
</tr>
<tr>
<td></td>
<td>- The path name may contain <strong>field codes</strong> (page 110).</td>
</tr>
<tr>
<td>Write as File</td>
<td>Select to record alarm information in a text file.</td>
</tr>
<tr>
<td>Append</td>
<td>Select to append new alarm information to the end of the file instead of writing over existing data.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> Because you can append new alarm information to the end of the file, this file can become very large. You must back up and delete this file frequently if you are using this alarm action with many alarms.</td>
</tr>
<tr>
<td>Text to write to the file</td>
<td>Use punctuation, spaces, or returns after the entries to format the text. To add live data to the text, select <strong>field codes</strong> (page 110) from the <strong>Append Field Code</strong> list.</td>
</tr>
<tr>
<td>Write as Report</td>
<td>Select to write a WebCTRL® report to a file, then select the <strong>Report</strong> and the <strong>Format</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> The Report Name field shows a custom report only if it was created at the current system level.</td>
</tr>
<tr>
<td></td>
<td><strong>Run as</strong> shows the name and login name of the operator creating the alarm action. The report will be run using the privileges and report options of this operator.</td>
</tr>
<tr>
<td></td>
<td><strong>💡 TIP</strong> You may want to create a new operator with limited privileges for this purpose.</td>
</tr>
</tbody>
</table>
### Field Notes

**Perform Action**

By default, the WebCTRL® application performs an alarm action when the alarm source generates an alarm **and** when it returns to normal. Under **Perform Action**, you can choose to run the alarm action:

- Only when the alarm source generates an alarm **or** when it returns to normal.
- After a specified amount of time if the alarm has not been acknowledged or has not returned to normal. Use this option for alarm escalation. *
- If the alarm occurs during the occupied hours defined for a schedule group or run if the alarm occurs during the unoccupied hours defined for a schedule group. *

**EXAMPLE** To have one alarm action performed during work hours and a different alarm action performed after work hours:

1. Create a **schedule group** (page 62), but do not assign members to it.
2. Create a schedule for the group. Set the occupied hours to be the same as the work hours.
3. Create the alarm action that is to be performed during work hours. Under **Perform Action**, select **If schedule group <your new group> is Occupied**.
4. Create the alarm action that is to be performed after work hours. Under **Perform Action**, select **If schedule group <your new group> is Unoccupied**.

* Available only if you have the Advanced Alarming package.

---

**Setting up an alarm source in the WebCTRL® interface**

The application engineer usually sets up alarm sources in the EIKON® application. In the WebCTRL® application, you can:

- Edit an existing alarm source’s settings or set up a new alarm source to generate alarms.
- Set up all alarms for a piece of equipment at once on the **Alarm Sources** tab of the equipment’s **Properties** page.
- Simulate an alarm to test its setup.

Two types of microblocks generate alarms in control programs.

- Alarm microblocks include logic that takes into account conditions such as space occupancy.
- I/O point microblocks can generate an alarm when the present value exceeds defined limits (analog) or when the present value changes to an off-normal state (binary). This type of microblock is typically set up for analog points to generate alarms for sensor failure.
Alarm microblocks and I/O microblocks can have similar names. So, when you are going to enable an alarm source, first look for an alarm microblock on the Geographic or Network tree.

This type of microblock... Appears on the Geographic or Network tree as...

<table>
<thead>
<tr>
<th>ALARM ACTIVATE</th>
<th>HI ZONE TEMP</th>
</tr>
</thead>
</table>

| All point name | Zone TEMP |

To set up, edit, or disable alarm sources

To set up, edit, or disable a single alarm source

1. On the Geographic or Network tree, select the alarm source (microblock).
2. Click Alarms, then select the Enable/Disable tab.
3. Make changes to the fields as needed. The fields can vary for different types of alarm sources. See table below.
4. Click Accept.

💡 TIP To set up all the alarms for a piece of equipment at once, click Properties, then select Alarm Sources.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Potential alarm source</td>
<td>Check to enable the alarm source to generate alarms. Uncheck to disable the alarm source.</td>
</tr>
<tr>
<td>Alarm</td>
<td>Check to have the alarm source generate an alarm when the specified conditions occur.</td>
</tr>
<tr>
<td></td>
<td>• For a binary input, enter the conditions for generating an alarm.</td>
</tr>
<tr>
<td></td>
<td>• For an analog input, type the low and high limits that, when exceeded, will generate an alarm.</td>
</tr>
<tr>
<td>Deadband</td>
<td>The amount inside the normal range by which an alarm condition must return before a return-to-normal notification is generated.</td>
</tr>
<tr>
<td>EXAMPLE</td>
<td>High = 225&lt;br&gt;215&lt;br&gt;&lt;br&gt;10 = Deadband&lt;br&gt;&lt;br&gt;Low = -25&lt;br&gt;-15&lt;br&gt;&lt;br&gt;10 = Deadband</td>
</tr>
<tr>
<td></td>
<td>• Alarm is generated&lt;br&gt;• Return-to-Normal is generated</td>
</tr>
<tr>
<td>NOTE</td>
<td>If Status is checked, the alarm condition currently exists.</td>
</tr>
<tr>
<td>Return to Normal</td>
<td>Check to have the alarm source generate a return-to-normal when the alarm condition returns to a normal state.</td>
</tr>
<tr>
<td>Field</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Alarm requires acknowledgment</td>
<td>Check to have the WebCTRL® application require that an operator acknowledge the alarm.</td>
</tr>
<tr>
<td>Return requires acknowledgment</td>
<td>Check to have the WebCTRL® application require that an operator acknowledge the return-to-normal.</td>
</tr>
<tr>
<td>Classified as critical</td>
<td>This property determines the color of the system-wide alarm button when the alarm comes in.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Critical" /> = Critical <img src="image" alt="Non-critical" /> = Non-critical</td>
</tr>
<tr>
<td>Event State</td>
<td>The current state of the alarm source can be:</td>
</tr>
<tr>
<td></td>
<td>• Normal—the value is normal</td>
</tr>
<tr>
<td></td>
<td>• Off normal—the value is not normal (binary only)</td>
</tr>
<tr>
<td></td>
<td>• Fault—the alarm source microblock may be misconfigured</td>
</tr>
<tr>
<td></td>
<td>• High Limit—the value exceeds the normal range (analog only)</td>
</tr>
<tr>
<td></td>
<td>• Low Limit—the value is below the normal range (analog only)</td>
</tr>
<tr>
<td>BACnet Configuration:</td>
<td></td>
</tr>
<tr>
<td>Dial on alarm</td>
<td>Check to have this alarm immediately delivered through a modem connection.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> When monitoring your system through a modem connection, non-critical alarms are stored in the gateway until one of the following happens:</td>
</tr>
<tr>
<td></td>
<td>• a critical alarm occurs</td>
</tr>
<tr>
<td></td>
<td>• the gateway is contacted by the WebCTRL® application</td>
</tr>
<tr>
<td></td>
<td>• the gateway buffer is full, at which time all alarms are sent to the WebCTRL® application</td>
</tr>
<tr>
<td>Notification Class</td>
<td>Do not change this field.</td>
</tr>
</tbody>
</table>

To set up, edit, or disable multiple alarm sources simultaneously

1. On the **Geographic** or **Network** tree, select the area, equipment, or controller containing the alarm sources.
2. Click **Alarms**, then select the **Enable/Disable** tab.
3. In step 1, select the categories that contain the alarm sources.
   **NOTE** In step 1 and step 2, **Ctrl+click**, **Shift+click**, or both to select multiple items, or check **Select All**.
4. In step 2, select the alarm sources.
5. Make appropriate changes in step 3.
6. Click **Accept**.
   **NOTE** Click **View Selected Sources** to view or change settings for each alarm.
To simulate an alarm  
To test the setup of an alarm source and its alarm actions (page 83), you can simulate an alarm or its return-to-normal.

1. On the Geographic tree, select the alarm source (but not ) whose alarm you want to simulate.
2. On the Alarms > Enable/Disable tab, check Enable next to Alarm or Return to Normal.
3. Click Simulate next to Alarm or Return to Normal.
4. Select the equipment on the tree, then select the View tab to see the alarm.

To view all instances of an alarm source  
To find all instances of an alarm source at and below a selected area:

1. On the Geographic or Network tree, select an area.
2. Select the Message, Actions, Enable/Disable, or Category tab.
3. Select an alarm source from the list in step 2.
4. Click View Selected Sources.
   Each path in the dialog box links to the alarm source microblock.
   NOTE You may be able to change settings that relate to the tab you selected.

Customizing alarms  
Each alarm source has an alarm message, category, and template defined in the EIKON® application. You can change messages and categories in the WebCTRL® application.

Alarm messages  
An alarm message is the information that appears on the Alarms page View tab for an alarm. An alarm message can consist of 3 parts.

Prefix and Text make up the alarm message you see without double-clicking the alarm

Message = Prefix (optional) + Text (alarm or return) + Details (optional)

Text defined in the control program

You can edit Text only at the alarm source in the EIKON® application. Prefix and Details are hierarchical. They apply at the location where they are added and to all its children. For example, you could enter Details at the system level to show the acknowledge time for alarms in the HVAC Critical category. The acknowledge time would then be in any HVAC critical alarm message in the system.
NOTE  An alarm action can have a different message from the alarm message seen on the View tab. To edit the message for a particular alarm action, see Setting up alarm actions (page 83).

To edit the message for an alarm source

1  On the Geographic tree, select the alarm source (microblock).
2  Click Alarms, then select the Messages tab.
   NOTE  Sample Alarm Message and Sample Return Message show the messages as they are currently defined.
3  Do the following as needed:
   ○  Edit the Text for Alarm or Return. You can add live data to the text by selecting field codes (page 110) from the Append Field Code list.
   ○  Click the Edit button to edit Message Prefix or Message Details.
   ○  In the drop-down list to the right of Message formation, select Add new prefix to beginning of message or Add new details to end of message, then click Add.
4  Click Accept.

To add a Prefix or Details for multiple alarm sources

1  On the Geographic or Network tree, select the area, equipment, or controller containing the alarm sources.
2  Click Alarms, then select the Messages tab.
3  In step 1, select the categories that contain the alarm sources whose messages you want to edit.
   NOTE  In step 1 and step 2, Ctrl+click, Shift+click, or both to select multiple items, or check Select All.
4  In step 2, select the alarm sources.
5  In step 3, select Add new prefix to beginning of message or Add new details to end of message.
6  Click Add.
7  Type text and add field codes as needed.
8  Click Accept.

Alarm categories

Alarm categories sort related alarm sources and their alarms into groups such as HVAC Critical and Access Control General. Alarm categories let you:

•  View, acknowledge, or delete selected categories of alarms (page 78) received by the WebCTRL® application
•  Assign alarm actions (page 83) to selected categories of alarm sources
•  Set up alarm sources (page 103) in selected categories

Each alarm source is assigned to an alarm category in the EIKON® application, but you can change the category assignment in the WebCTRL® application. The WebCTRL® application has a number of default alarm categories, but you can create custom categories, if needed.
To assign alarm sources to a different category

1. On the Geographic or Network tree, select the area, equipment, or controller containing the alarm sources.
2. Click Alarms, then select the Category tab.
3. In step 1, select the category that currently contains the alarm sources.
   NOTE: In step 1 and step 2, Ctrl+click, Shift+click, or both to select multiple items, or check Select All.
4. In step 2, select the alarm sources whose category you want to change.
5. In step 3, select a category from the drop-down list, then click Change.
6. Click Accept.

To add a custom alarm category

PREREQUISITE: Add the custom alarm category in the Eikon® application. See "To use custom alarm and schedule categories" in Eikon® Help.

1. On the System Configuration tree, click to the left of Categories.
2. Click Alarm.
3. Click Add. See table below.
4. Click Accept.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Name</td>
<td>Must be unique in the database, be lowercase, and not contain any spaces. This name must be identical to the name of the custom alarm category that you added in the Eikon® application.</td>
</tr>
<tr>
<td>Icon</td>
<td>Type /_common/1v15/graphics/event_categories/&lt;file_name&gt;.gif, replacing &lt;file_name&gt; with the name of the icon file you want to use. The event_categories folder contains all alarm icons used by WebCTRL® plus the following icons that you can use for a custom category.</td>
</tr>
<tr>
<td></td>
<td>• boilerplant_*.png</td>
</tr>
<tr>
<td></td>
<td>• electricpower_*.png</td>
</tr>
<tr>
<td></td>
<td>• level_1_*.png</td>
</tr>
<tr>
<td></td>
<td>• level_2_*.png</td>
</tr>
<tr>
<td></td>
<td>• level_3_*.png</td>
</tr>
<tr>
<td></td>
<td>• level_4_*.png</td>
</tr>
<tr>
<td></td>
<td>• level_5_*.png</td>
</tr>
</tbody>
</table>
* represents closed, critical, general, or maintenance

NOTE: You can create your own 24 x 24 pixel icon (.gif or .png) and store it in the event_categories folder. However, your custom file will not be transferred during a WebCTRL® upgrade, so you will need to copy the file to the new install directory after the upgrade.
If you upgraded alarms from v2.0 or earlier

All v2.5 and later alarms use one template called Universal. This template lets you define your alarm message text, the critical setting, and the required acknowledgments at the alarm source in the EIKON® or WebCTRL® application.

Templates in upgraded systems

If you upgraded your system from v2.0 or earlier, the alarm sources retained their existing templates and existing alarm settings. If the existing alarm sources contain little or no customization to the alarm settings, Automated Logic® recommends that you change all of the alarms to use the Universal template. If the alarm sources had customized alarm settings, continue using the existing templates.

To assign a different template to alarm sources

PREREQUISITE The Alarms Template tab must be visible. If it is not, on the System Configuration tree, select Privilege Sets, then check Maintain Alarm Templates.

1. On the Geographic tree, select the piece of equipment containing the alarm sources to be changed.
2. Click Alarms, then select the Template tab.
3. Follow the 3 steps on the screen.
   
   NOTE Use Ctrl+click, Shift+click, or both to select multiple items.
4. Click Change.
5. Click Accept.

TIP To change all alarms in the system simultaneously, go to the system level and then select all categories and all alarm sources on the Templates tab.

To add an alarm template

1. On the System Configuration tree, select Alarm Templates.
2. Click Add.
3. Select Source-based (a v2.5 template) or Stand-alone (a pre-v2.5 template), then click OK.
4. Edit the template fields as needed. See table below.
5. Click Accept.

<table>
<thead>
<tr>
<th>Field</th>
<th>Template Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Name</td>
<td>All</td>
<td>Must be unique in the database, be lowercase, and not contain any spaces. This name must be identical to the name of the template in the EIKON® application.</td>
</tr>
<tr>
<td>Display Name</td>
<td>All</td>
<td>The name that will appear in the WebCTRL® interface for this template.</td>
</tr>
<tr>
<td>Alarm Message</td>
<td>Source-based</td>
<td>The message text displayed on the View tab or in the alarm action when an Alarm requires acknowledgment.</td>
</tr>
</tbody>
</table>
## Using field codes

Use field codes to insert live data into:

- The message on an alarm action
- Text displayed on the Alarms page > View tab
- Alarm information archived to a text file when an alarm is deleted

You can customize the setup of each of these items by appending field codes. For example, to have the message in an alarm action include the device that generated the alarm, append the Device field code to the action’s message.

### Formatting field codes

You can type a formatting command after a field code to format the field code in one of the following 3 ways:

- Format a number field code (Example: `##.##`)
- Format a date/time field code (Example: `MM/dd/yyyy hh:mm:ss`)
- Left, right or center align a field code and set the field width
A formatting command must have the following syntax:
$
\text{fieldcode}\%\text{format\_type}:\text{style}$

Use the table below to determine the format\_type and style for a formatting command.

<table>
<thead>
<tr>
<th>format_type</th>
<th>style</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>To format a number</td>
<td>N</td>
<td>The actual formatting, such as ###.###. The basic format uses the pound sign (#) to represent a number. See Other numerical formatting System Options <a href="http://java.sun.com/j2se/1.4.2/docs/api/java/text/DecimalFormat.html">http://java.sun.com/j2se/1.4.2/docs/api/java/text/DecimalFormat.html</a>.</td>
</tr>
<tr>
<td>To format date/time</td>
<td>D</td>
<td>The actual formatting, such as MM/dd/yyyy hh:mm:ss. See Date time formatting System Options <a href="http://java.sun.com/j2se/1.4.2/docs/api/java/text/SimpleDateFormat.html">http://java.sun.com/j2se/1.4.2/docs/api/java/text/SimpleDateFormat.html</a>.</td>
</tr>
<tr>
<td>To set alignment and field width</td>
<td>L for left align, R for right align, C for center align</td>
<td>Indicate the field width by number of characters.</td>
</tr>
</tbody>
</table>

Using multiple formatting commands
You can type multiple formatting commands for a field code. For example, you can format a number and then set the alignment and field width. The syntax for multiple formatting commands is:
$
\text{fieldcode}\%\text{format\_type1:style}:\text{format\_type2:style}$

**EXAMPLE** To format the alarm date and time, center it and set the field at 20 characters, the field code is:
$\text{generation\_time}\%D:MM/dd/yyyy hh:mm:ss%C:20$ 

**NOTE** You must enter the date/time or number formatting command before the alignment/field width command.
### Field Codes

<table>
<thead>
<tr>
<th>Field Code Name</th>
<th>Field Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledge Operator</td>
<td>$acknowledge_operator$</td>
<td>The operator who acknowledged the alarm.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> John Doe</td>
</tr>
<tr>
<td>Acknowledge Time</td>
<td>$acknowledge_time$</td>
<td>The time when the operator acknowledged the alarm.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> Nov 12, 2012 6:46:31 PM</td>
</tr>
<tr>
<td>Alarm Category</td>
<td>$alarm_category$</td>
<td>The alarm category that the alarm is assigned to.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> HVAC Critical</td>
</tr>
<tr>
<td>Alarm Priority</td>
<td>$alarm_priority$</td>
<td>The priority number associated with the alarm's priority (Off-Normal, Fault, or Normal) on the controller's Driver &gt; Notification Class page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm Template</td>
<td>$alarm_template$</td>
<td>The alarm template that the alarm is assigned to.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> Universal</td>
</tr>
<tr>
<td>Alarm Type</td>
<td>$alarm_type$</td>
<td>The alarm type of the alarm source.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> CHANGE OF STATE</td>
</tr>
<tr>
<td>Alert Text</td>
<td>$alerttext$</td>
<td>For a converted SuperVision® system if the option Create a single alarm template... was selected during upgrade. Retrieves alarm message text from cmnet_alert_text.properties. To use this field code: 1. Select the Alert Text field code. 2. After $alerttext, type one of the following: :normalshort :normallong :alarmsnort :alarmlong For example, $alerttext:alarmlong$</td>
</tr>
<tr>
<td>Character</td>
<td>$c$</td>
<td>A single ASCII character. Often used for form feeds and other printer escape sequences. <strong>EXAMPLE</strong> $C:65$ displays A</td>
</tr>
<tr>
<td>Command Value</td>
<td>$command_value$</td>
<td>The commanded value from the alarm source. Valid only for alarm type COMMAND FAILURE. <strong>EXAMPLE</strong> 3</td>
</tr>
<tr>
<td>Control Program</td>
<td>$equipment$</td>
<td>The display name of the equipment where the alarm came from.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> Chiller</td>
</tr>
<tr>
<td>Controller</td>
<td>$device$</td>
<td>The display name of the device where the alarm came from.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> SE6104</td>
</tr>
<tr>
<td>Dead Band</td>
<td>$deadband$</td>
<td>The deadband value from the alarm source. Valid only for alarm type OUT-OF-RANGE. <strong>EXAMPLE</strong> 5</td>
</tr>
<tr>
<td>Field Code Name</td>
<td>Field Code</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Deletion Operator       | $deletion_operator$                 | The operator who deleted the alarm.  
**EXAMPLE** John Doe |
| Deletion Time           | $deletion_time$                     | The time the alarm was deleted.  
**EXAMPLE** Nov 12, 2012 6:46:31 PM |
| Error Limit             | $error_limit$                       | The error limit, from the alarm source. Valid only for alarm type FLOATING LIMIT.  
**EXAMPLE** 90 |
| Event Values            | $event_values$                      | Returns a string of alarm values associated with the alarm.                                      |
| Exceeded Limit          | $exceeded_limit$                    | The exceeded limit value from the alarm source. Valid only for alarm type OUT-OF-RANGE.  
**EXAMPLE** 90 |
| Exceeding Value         | $exceeding_value$                   | The exceeding value from the alarm source. Valid only for alarm type OUT-OF-RANGE.  
**EXAMPLE** 91 |
| Fault                   | $fault$                             | The status of the fault condition from the alarm source.  
**EXAMPLE** True or false |
| Field Message           | $field_message$                     | Text generated in the alarm by the controller.                                                   |
| Feedback Value          | $feedback_value$                    | The feedback value from the alarm source. Valid only for alarm type COMMAND FAILURE.  
**EXAMPLE** 10 |
| From State              | $from_state$                        | The previous state of the alarm source.  
**EXAMPLES** NORMAL, FAULT, OFF NORMAL, HIGH LIMIT, LOW LIMIT |
| Generation Operator     | $generation_operator$               | The operator who forced the alarm to return to normal.  
**EXAMPLE** John Doe |
| Generation Time         | $generation_time$                   | The time in the controller when the alarm was generated.  
**EXAMPLE** Nov 12, 2012 6:35:18 PM |
| In Alarm                | $in_alarm$                          | The in alarm status from the alarm source.  
**EXAMPLE** True or false |
| Incident Closed Time    | $incident_closed_time$              | The time the alarm's entire incident group closed.  
**EXAMPLE** Nov 12, 2012 6:46:31 PM |
<p>| Latched Data Value      | $latched_data_analog:x$             | &quot;x&quot; ranges from 1 to 10. Returns a numerical value. Use for legacy systems.                      |
| Latched Data Value      | $latched_data_digital:x$            | &quot;x&quot; ranges from 1 to 10. Returns On or Off. Use for legacy systems.                              |</p>
<table>
<thead>
<tr>
<th>Field Code Name</th>
<th>Field Code</th>
<th>Description</th>
</tr>
</thead>
</table>
| Location Path   | $location_path$ | Displays the path display names from root to source. \**EXAMPLE** Building B / Basement / VAV AHU B / SSP_STOP  
The number of levels in the path is based on the System Settings field **Levels displayed in paths**. To override this setting, enter the field code as $location_path:##$, substituting # with the number of path levels you want to show. For example, $location_path:5$ will show 5 levels. |
| Long Message    | $long_message$  | The formatted alarm long text displayed by double-clicking the alarm on the Alarms page.                                                  |
| Message Details | $message_details$ | The message details displayed on the Alarms page **View** tab.                                                                                |
| Message Prefix  | $message_prefix$ | The message prefix displayed on the Alarms page **View** tab.                                                                                |
| Message Text    | $message_text$  | The message text displayed on the Alarms page **View** tab.                                                                                   |
| New State       | $new_state$     | The status of new state from the alarm source. Valid only for alarm type CHANGE OF STATE. \**EXAMPLE** Alarm, Fault |
| New Value       | $new_value$     | The new value from the alarm source. Valid only for alarm type CHANGE OF VALUE. \**EXAMPLE** 70                                               |
| Notification Class | $notification_class$ | The notification class assigned denotes how the received alarm was generated. For example, if set to 1, the alarm would typically be sent to WebCTRL by Automated Logic® controllers. |
| Object ID       | $object_ID$     | Object ID of the alarm source. \**EXAMPLE** 5:26                                                                                           |
| Out of Service  | $out_of_service$ | The status of 'out of service' from the alarm source. \**EXAMPLE** True or false                                                           |
| Overridden      | $overridden$    | The status of 'overridden' from the alarm source. \**EXAMPLE** True or false                                                              |
| Program ID      | $program_id$    | The address of the control program that generated the alarm.  
BACnet program address format: device ID, program number \**EXAMPLE** 2423101,1  
SuperVision program address format: site, gateway, controller, fb \**EXAMPLE** 1, 2, 13, 5 |
<table>
<thead>
<tr>
<th>Field Code Name</th>
<th>Field Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receive Time</td>
<td>$receive_time$</td>
<td>The time at the workstation when the alarm was received.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> Nov 12, 2012 6:46:31 PM</td>
</tr>
<tr>
<td>Recipient Device ID</td>
<td>$device_id$</td>
<td>The device ID of the device where the alarm came from.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> 8:2423101</td>
</tr>
<tr>
<td>Record Type</td>
<td>$record_type$</td>
<td>The type of alarm.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> BACnet, Supervision®, System</td>
</tr>
<tr>
<td>Reference Path</td>
<td>$reference_path$</td>
<td>Path to alarm source. Available in all alarm actions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> #e_b_vav_ahu_b/ssp_stop</td>
</tr>
<tr>
<td>Reference Value</td>
<td>$reference_value$</td>
<td>The 'reference value' from the alarm source. Valid only for alarm type FLOATING LIMIT.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> 83</td>
</tr>
<tr>
<td>Referenced Bitstring</td>
<td>$referenced_bitstring$</td>
<td>The value of the 'referenced bitstring' value from the alarm source. Valid only for alarm type CHANGE OF BITSTRING.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> 10110111011101</td>
</tr>
<tr>
<td>RTN Time</td>
<td>$RTN_time$</td>
<td>The time when the alarm returned to normal.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> Nov 12, 2012 6:46:31 PM</td>
</tr>
<tr>
<td>Setpoint Value</td>
<td>$setpoint_value$</td>
<td>The 'setpoint value' from the alarm source. Valid only for alarm type FLOATING LIMIT.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> 72</td>
</tr>
<tr>
<td>Short Message</td>
<td>$short_message$</td>
<td>The formatted alarm short text.</td>
</tr>
<tr>
<td>Site</td>
<td>$site$</td>
<td>The display name of the site the alarm came from.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> Kennesaw</td>
</tr>
<tr>
<td>Source</td>
<td>$source$</td>
<td>The display name of the alarm source microblock that generated the alarm.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> SAT_HI</td>
</tr>
<tr>
<td>Source description</td>
<td>$source:description$</td>
<td>The Description field of the alarm source microblock that generated the alarm.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>EXAMPLE</strong> High Cooling Supply Air Temp</td>
</tr>
<tr>
<td>Field Code Name</td>
<td>Field Code</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Source Path     | $source:<path>$| Substitute <path> with the path to the value you want to display. See Defining WebCTRL® paths.  
Example to add text value: $source:~equipment.display-name$  
Example to add a numeric value: $source:/trees/geographic/rd_facility/zone_1/lstat/present_value$  
NOTES  
• You can use Global Modify (page 44) to get the path.  
• For legacy systems, use the latched data field codes. |
| System Directory| $system_dir$   | The system folder name.  
EXAMPLE c:\WebCTRLx.x\webroot\world_corporation |
| To State        | $to_state$     | The current state of the alarm source.  
EXAMPLES NORMAL, FAULT, OFF NORMAL, HIGH LIMIT, LOW LIMIT |
Time-lapse

You can replay up to 24 hours of Graphics, Alarms, or Trends pages starting on a specified date and time. Time-lapse can be a helpful troubleshooting tool.

For Time-lapse to show thermographic colors, the WebCTRL® application polls each router in the system at specified intervals and collects color. Color is collected for the router and its downstream controllers only if their control program contains a Setpoint, Set Color, or Set Color If True microblock. The Server then uses the collected colors to create a trend called Color Trend.

To play Time-lapse

1. Select the location on the tree where you want to see the time-lapse.
2. Click at the top of the page.
3. In the Replay field, select the length of time that you want to replay. The replay will step through the data at the interval shown.
4. In the Start field, select the date and time that you want the replay to begin. You can click:
   - The buttons to change the day or time.
   - The to select the date.
   - A date/time field, and then type the new number.
5. Click Accept. The time-lapse immediately begins to play.
6. Use the following items to work with the time-lapse.

   - Change number of hours to replay or Start date/time
   - Start date/time
   - Date/time of current time-lapse display
   - End date/time
   - Exit Time-lapse
   - Show an earlier time period
   - Show a later time period
   - Steps through the time-lapse
   - Pause the time-lapse

NOTES

- While in time-lapse, you can navigate to other locations in the tree.
- The Graphics page can replay only trended values. Values that are not trended are grayed out. Floorplan areas without trend data are dark grey.
**TIP** You can enable historical trending for trended values to have more trend data available in Time-lapse and to have the data retrieved faster.

- You can select an alarm on the **Alarms** page and then click the **Activate Time-lapse** button. This changes the time-lapse to the 1-hour period in which the alarm occurred. You can step backward or forward through the time-lapse at 1-minute intervals to see what other alarms occurred during that hour. You can also go to **Graphics** or **Trends** to see what else happened when the alarm occurred.
- The white horizontal line on a **Trends** time-lapse indicates where the replay currently is in the time-lapse range.

**To change polling interval or duration or to turn off color collection**

1. On the **System Configuration** tree, select **System Settings**.
2. On the **General** tab under **Trends**, do one of the following:
   - In the **Poll Interval** field, change the frequency that the server collects color trend data from the routers.
     
     **NOTE** **Last Poll Duration** shows how long the last polling of the routers took.
   - If directed by Automated Logic® Technical Support, uncheck **Enable Server Trending of Color** to stop color collection.
3. Click **Accept**.
Use WebCTRL® reports to monitor and troubleshoot your system. In the WebCTRL® interface, you can:

- View preconfigured reports
- Create custom reports

See the table below for a list of all reports.

<table>
<thead>
<tr>
<th>This preconfigured report...</th>
<th>allows you to...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Schedules</strong></td>
<td></td>
</tr>
<tr>
<td>Schedule Instances</td>
<td>Find every schedule with its location that is entered at and below a selected tree item. This report can help you discover newly added and conflicting schedules.</td>
</tr>
<tr>
<td>Effective Schedules</td>
<td>View all equipment that may be scheduled and the net result of all schedules in effect for a selected date and time.</td>
</tr>
<tr>
<td><strong>Commissioning</strong></td>
<td></td>
</tr>
<tr>
<td>Test &amp; Balance</td>
<td>View the results of VAV box commissioning. Running this report automatically uploads calibration parameters to the WebCTRL® application.</td>
</tr>
<tr>
<td>Equipment Checkout</td>
<td>View the information on the Equipment Checkout tab of the equipment’s Properties page during commissioning. Also, find equipment that has not been fully commissioned.</td>
</tr>
<tr>
<td><strong>Alarms</strong></td>
<td></td>
</tr>
</tbody>
</table>

The Reports button drop-list varies depending on whether you selected the Geographic or Network tree and if you have created any custom reports at or above the selected location. A report shows data for the selected item and all of its children.

**NOTE** You can display icons and hover text on the Geographic tree that show where custom reports have been created. See Tree icons and hover text (page 27).
<table>
<thead>
<tr>
<th><strong>This preconfigured report...</strong></th>
<th>allows you to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarms</td>
<td>View, sort, and filter the information on the Alarms View (page 78) tab.</td>
</tr>
<tr>
<td>Alarm Sources</td>
<td>Create a summary of potential alarm sources as configured on the Alarms &gt; Enable/Disable (page 103) tab.</td>
</tr>
<tr>
<td>Alarm Prefixes &amp; Details</td>
<td>Create a summary of the information configured on the Alarms &gt; Messages (page 106) tab.</td>
</tr>
<tr>
<td>Alarm Actions</td>
<td>Create a summary of the information configured on the Alarms &gt; Actions (page 83) tab.</td>
</tr>
</tbody>
</table>

### Equipment

| **Point List** | View the details of all points. Verify that all points have been checked out during commissioning. Also, create custom lists for other contractors. For example, create a list of BACnet IDs or web services links. |
| **Locked Values** | Find all locked points and locked values. **NOTE** Locks in the Airflow microblock are not reported. |
| **Network IO** | Verify the programming and status of all network points—especially useful for commissioning controllers used for third-party integration. |
| **Trend Usage** | Creates a summary of the information configured on the Trends > Enable/Disable (page 71) tab. |
| **Parameter Mismatch** | Discover where your system has parameter mismatches that need to be resolved. |

### Security

| **Location Audit Log** | View chronological lists of location-based changes, the operators that made them, and the reasons for the changes. This report includes changes such as property edits, downloads, driver changes, and view changes. |
| **System Audit Log** | View chronological lists of system-wide changes, the operators that made them, and the reasons for the changes. This report includes changes such as any change made on the System Configuration tree, login/logout, and scheduled processes like deleting expired trends. |

### Network

<p>| <strong>Equipment Status</strong> | Display the thermographic color, status, and prime variable of each control program. |
| <strong>Controller Status</strong> | Discover network communication problems (shown as purple squares on the report) that need troubleshooting. The report also shows boot and driver version, download information, and if controller has 4.x or later driver, the report shows the serial number and Local Access port status. |</p>
<table>
<thead>
<tr>
<th>This custom report...</th>
<th>allows you to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equipment Summary</td>
<td>View the following information for equipment at or below the location where the report was created:</td>
</tr>
<tr>
<td></td>
<td>• Color</td>
</tr>
<tr>
<td></td>
<td>• Active alarm</td>
</tr>
<tr>
<td></td>
<td>• Locked values</td>
</tr>
<tr>
<td></td>
<td>• Current value of selected points</td>
</tr>
<tr>
<td></td>
<td>• Combined schedule</td>
</tr>
<tr>
<td></td>
<td>See To create an Equipment Summary report (page 122).</td>
</tr>
<tr>
<td>Equipment Values</td>
<td>Compare point information. See To create an Equipment Values report (page 123).</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> This report is available only if your system has the optional Advanced Reporting package.</td>
</tr>
<tr>
<td>Trend Samples</td>
<td>View trend values for a particular time frame. See To create an Trend Samples report (page 125).</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> This report is available only if your system has the optional Advanced Reporting package.</td>
</tr>
</tbody>
</table>

**NOTE** The Send E-mail alarm action (page 93) can run any WebCTRL® report and attach it to the email. The Write to File alarm action (page 102) can run any WebCTRL® report and save it as a file. For both alarm actions, the report can be a PDF, HTML, XLS, or CSV file.

**To run a report**

1. Select an item on the Geographic or Network tree.
2. Click the Reports button drop-down arrow, then select a report.
3. On the Options tab, define the layout and content of the report.
   **NOTES**
   - Changing the size and orientation of the printed page also changes the report layout on the View tab.
   - To create a CSV (Comma Separated Values) file after you run the report, select **Support CSV text format**. See To create a PDF, XLS, or CSV file (page 122).
   - The current operator's report options are saved so that when that operator logs in again, the same options are used.
4. Click **Run**.
5. Click **PDF** if you want to print the report.
To create a PDF, XLS, or CSV file

PREREQUISITE FOR CSV You must enable Support CSV text format on the Reports > Options tab before you run the report.

1 Run a report.
2 Click PDF, XLS, or CSV.

NOTE To create a CSV file when using Safari, see instructions below.
3 For XLS or CSV, click Open to view the file or Save to save it.

To create a CSV file when using Safari
1 Run a report.
2 Click CSV. A pop-up displays the results.
3 Select File > Save As.
4 In the Format field, select Page Source.
5 Add the .csv extension to the file name.
6 Select the save location in the Where field.
7 Click Save.
8 Close the popup.

NOTE If you need a digitally signed PDF to comply with 21 CFR Part 11, open the PDF in a program that supports digital signing such as the Adobe Acrobat application, then sign the PDF. The WebCTRL application does not support digital signing because 21 CFR Part 11 requires that the signature be added manually, not through an automated process.

To create an Equipment Summary report
An Equipment Summary report can provide the following information for equipment at or below the location where the report is created.

- Color
- Active alarm
- Locked values
- Current value of selected points
- Effective schedule

To create an Equipment Summary report:

1 On the Geographic or Network tree, select the location where you want to view the report.
2 Click the Reports button drop-down arrow, then select New Report.
3 Select Equipment Summary.
4 Optional: Select a Category.

NOTE The Category field is visible only if you have defined report categories. See To organize custom reports (page 128).
5 Type a name for the report.
6 Click **Create**.
7 Define the **Title**, **Page Size** and orientation, and the **Maximum number of rows**.
8 Check or uncheck the **Optional Sections** checkboxes as needed.
9 Optional: Check **Include only specific control programs at or below this location**, then type the names of the control programs.
10 Select **Available Points** that you want to include in the report. Use **Ctrl+click**, **Shift+click**, or both to select multiple items.
11 Click **Add**.
12 Click **Accept**.
13 Click **Run**.

**NOTE** To run this report later, go to the location where the report was created. Click the **Reports** button drop-down arrow, select the report, then click **Run**.

---

**To create an Equipment Values report**

**Optional WebCTRL Package**

**NOTE** To see if your system has this optional package, click , then select **About**. You have this package if **Enabled Features** shows **Adv. Reporting**.

An **Equipment Values** report allows you to compare point information. To create an Equipment Values report:

1 On the **Geographic** or **Network** tree, select the location where you want to view the report.
2 Click the **Reports** button drop-down arrow, then select **New Report**.
3 Select **Equipment Values**.
4 Optional: Select a **Category**.
   **NOTE** The **Category** drop-down list is only visible if you have defined report categories. See To **organize custom reports** (page 128).
5 Type a name for the report.
6 Click **Create**.
7 Do one of the following:
   - Select **Include only specific control programs at or below this location**, then type the control program names.
   - On the selection tree, select the pieces of equipment you want to view in the report. (Use **Ctrl+click**, **Shift+click**, or both to select multiple items.) Then click **Add**.
8 Optional: Check **Highlight alternate rows** to make the report easier to analyze.
9 Click **Next** or **Columns**.
10 Verify or change the report **Title**, **Page units** of measure for defining column widths, and **Outer border** characteristics.
11 Select a column in the report preview.
   **NOTE** The selected column is light blue.
12 Under **Column Header**, define how you want the column header to look.

13 Under **Column Data**, define the data you want in the column and how you want it to look. See table below.

**NOTE** Select **General** from the **Format** drop-down list unless you want to define the number of places to the right of the decimal point for the displayed value.

14 Optional: Use the **Add**, **Delete**, and arrow buttons below the report preview to manipulate the columns.

15 Optional: Click **next to Page** to change the page size and orientation.

**NOTE** Changing the size and orientation of the printed page also changes the report layout on the **View** tab.

16 Click **Accept**.

17 Click **Run**.

**NOTE** To run this report later, go to the location where the report was created. Click the **Reports** button drop-down arrow, select the report, then click **Run**.

<table>
<thead>
<tr>
<th><strong>Type of Column Data</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Point</strong></td>
<td>Displays point data in the column.</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>Select the property to show in this column.</td>
</tr>
<tr>
<td><strong>Data is named differently in some control programs</strong></td>
<td>Select this checkbox if similar points have different names in different control programs. Then add each of the names to the <strong>Name to use</strong> list. For example, if a point is named Zone Temp in one control program and Zone Temperature in different control program, add both names to the list.</td>
</tr>
<tr>
<td><strong>Point to use</strong></td>
<td>Select the name of the point to show in the column.</td>
</tr>
<tr>
<td><strong>Trend Sample</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>Select <strong>First</strong>, <strong>Minimum</strong>, <strong>Maximum</strong>, or <strong>Last</strong> recorded trend value.</td>
</tr>
<tr>
<td><strong>Data is named differently in some control programs</strong></td>
<td>Select this checkbox if similar points have different names in different control programs. Then add each of the names to the <strong>Name to use</strong> list. For example, if a point is named Zone Temp in one control program and Zone Temperature in different control program, add both names to the list.</td>
</tr>
<tr>
<td><strong>Trend to use</strong></td>
<td>Select the name of the point to show in the column.</td>
</tr>
<tr>
<td><strong>Set</strong></td>
<td>Click to have all columns in the report use the same time range.</td>
</tr>
<tr>
<td><strong>Time Range</strong></td>
<td>Select the time range to run the report for.</td>
</tr>
</tbody>
</table>
### Type of Column Data

<table>
<thead>
<tr>
<th>Trend Calculation</th>
<th>Display</th>
<th>Select the type of calculation to show in the column, <strong>Average</strong> or <strong>Total</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data is named differently in some control programs</td>
<td><strong>Display</strong></td>
<td>Select this checkbox if similar points have different names in different control programs. Then add each of the names to the <strong>Name to use</strong> list. For example, if a point is named Zone Temp in one control program and Zone Temperature in different control program, add both names to the list.</td>
</tr>
<tr>
<td>Trend to use</td>
<td><strong>Display</strong></td>
<td>Select the name of the point to show in the column.</td>
</tr>
<tr>
<td>Set</td>
<td><strong>Display</strong></td>
<td>Click to have all columns in the report use the same time range.</td>
</tr>
<tr>
<td>Time Range</td>
<td><strong>Display</strong></td>
<td>Select the time range to run the report for.</td>
</tr>
<tr>
<td>Control Program</td>
<td><strong>Display</strong></td>
<td>Select <strong>Color</strong>, <strong>Display Name</strong>, <strong>Display Path</strong>, <strong>Notes</strong>, <strong>Prime Variable</strong>, or <strong>Reference Name</strong> to show in the column.</td>
</tr>
<tr>
<td>Expression</td>
<td><strong>Display</strong></td>
<td>Select this checkbox if similar points have different names in different control programs. Then add each of the names to the <strong>Name to use</strong> list. For example, if a point is named Zone Temp in one control program and Zone Temperature in different control program, add both names to the list.</td>
</tr>
<tr>
<td>Expression</td>
<td><strong>Display</strong></td>
<td>Type the path relative to the current control program. The path must return a string value. See Defining WebCTRL® paths for more information on paths. To display the <strong>Notes</strong> on an equipment's <strong>Properties</strong> page, type <strong>.notations</strong> in this field.</td>
</tr>
</tbody>
</table>

### To create a Trend Samples report

**Optional WebCTRL Package**

**NOTE** To see if your system has this optional package, click , then select **About**. You have this package if **Enabled Features** shows **Adv. Reporting**.

A **Trend Samples** report provides trend values for a particular time frame. To create a Trend Samples report:

1. On the **Geographic** or **Network** tree, select the location where you want to view the report.
2. Select the **Reports** button drop-down arrow, then select **New Report**.
3. Select **Trend Samples**.
4 Optional: Select a Category.
   NOTE The Category drop-down list is only visible if you have defined report categories. See To organize custom reports (page 128).
5 Type a name for the report.
6 Click Create.
7 Select a Time Range from the drop-down list, then refine that option by selecting an option from the drop-down list(s) to the right.
8 Define the trend data.
   NOTES
   ○ Calculate values for missing samples calculates a value based on the 2 closest values to the time interval.
   ○ Find the closest sample displays the value closest to the time interval selected.
9 Optional: Check Highlight alternate rows to make the report easier to analyze.
10 Click Next or next to Columns.
11 Verify or change the report Title, Page units of measure for defining column widths, and Outer border characteristics.
12 Select a column in the report preview.
   NOTE The selected column is light purple.
13 Under Column Header, define how you want the column header to look.
14 Under Column Data, select the source of the trend data and how you want the data to look.
   NOTE Select General from the Format drop-down list unless you want to define the number of places to the right of the decimal point for the displayed value.
15 Optional: Use the Add, Delete, and arrow buttons below the report preview to manipulate the columns.
16 Optional: Click next to Page to change the page size and orientation.
   NOTE Changing the size and orientation of the printed page also changes the report layout on the View tab.
17 Click Accept.
18 Click Run.
   NOTE To run this report later, go to the location where the report was created. Click the Reports button drop-down arrow, select the report, then click Run.

To save a custom report's design for use in another location or system

You can save the design of an Equipment Values report or a Trend Samples report for reuse in another location or in another system. Or, you can create a library of different report designs to pull from as needed.

To save a report's design
1 Create the Equipment Values (page 123) or Trend Samples (page 125) report.
2 On the Reports > Design tab, click the Save Report Design button. The design is saved to WebCTRL#.#/webroot/<system>/Reports/<report name>.reportdesign.
   NOTE The .reportdesign file includes the report name. If you save multiple report designs in your system, each of those reports must have a unique name.
To use the report design at a different location in the system

1. Select the location in the Geographic tree.
3. In step 1, select Report design, then select the report name in the drop-down list.
4. In step 2, type a report Name.
5. In step 3, click Create.

To copy individual report design file(s) to another system

1. In Windows Explorer, go to the WebCTRL#{.}/webroot/<system>/Reports/ folder.
2. Copy the *.reportdesign files that you want.
3. In the new system, paste the copied files in the WebCTRL#{.}/webroot/<system>/Reports/ folder.
4. Follow the steps above in "To use the report design at a different location in the system".

To create a .zip file to import into another system

NOTE The import process will not import a file if it has the same name as a file in the other system. Make sure your file names are unique.

1. Do one of the following:
   - Create a .zip file that contains the *.reportdesign files that you want. These files may be in the WebCTRL#{.}/webroot/<system>/Reports/ folder, or in a library that you created.
   - On the System Settings > General tab, under Source Files, click Export.
     NOTE Export creates a .zip file that contains all of the system's source files (control programs, drivers, view files, touchscreen or BACview files, report design files).
2. In the new system, go to the System Settings > General tab.
3. Under Source Files, click Import.
5. Click Continue.
6. Click Close. WebCTRL® will put the imported files in the correct folder.

To edit or delete a custom report

1. Select the item on the Geographic or Network tree where the report was created.
2. Click the Reports button drop-down arrow, then select the report you want to edit or delete.
3. Do one of the following:
   - Edit the report, then click Accept.
   - Click the Delete Report button, then click OK.
To organize custom reports

You can organize your custom reports by creating report categories that appear in the Reports button drop-down list.

![Diagram of custom report category and report]

To add a report category

1. On the System Configuration tree, click to the left of the Categories folder, then click Report.
2. Click Add.
3. Type the Category Name and Reference Name.
4. Select a privilege so that only operators with that privilege can access reports in the category.
5. Click Accept.

NOTES
- To edit a category, select the category, make your changes, then click Accept.
- To delete a category, select the category, click Delete, then click Accept.
Privileges control which parts of a WebCTRL® system an operator can access. Privileges also control what an operator can do and what he can change.

To set up operator access to your system:

1. Log in to the WebCTRL® application as the Administrator. See Operators and operator groups (page 133).
2. Define privilege sets by job function. See Privilege sets (page 129).
3. Enter each operator in the system by assigning him privilege sets and entering settings that apply only to him. If you need to assign the same privilege set to multiple operators, you can create an operator group and assign the privilege set to the group. See Operators and operator groups (page 133).

An operator can change many of his operator settings on the My Settings page (page 136).

To access the WebCTRL® interface, an operator must enter his user name and password. This password requirement can be enhanced by using the advanced password policy (page 142) (available with the optional Advanced Security package).

Restricting operator access

To restrict access to your system, you can:

- Restrict an operator's privileges
- Use location-dependent operator access (page 138) (available with the optional Advanced Security package)
- Change a microblock's Editing Privilege from Preset to a specific privilege. The microblock's properties will be editable only by an operator that has that privilege.

⚠️ CAUTION Each microblock property has a default Editing Privilege (represented by the Preset option) that is appropriate for that property. Changing Preset to a specific privilege changes every property in the microblock to the same privilege which may produce undesirable results.

Privilege sets

A privilege set is a group of one or more privileges (page 130). The Administrator creates privilege sets and assigns them to operators and operator groups.
### Privileges

<table>
<thead>
<tr>
<th>This privilege...</th>
<th>allows an operator to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Administration Privilege</td>
<td>- Add, edit, and delete operators, operator groups, and privilege sets.&lt;br&gt;- Update the WebCTRL® system with service packs and patches.&lt;br&gt;- Register the WebCTRL® software. See To register your WebCTRL® software (page 179).&lt;br&gt;- Enable and set up advanced security features such as location-dependent operator access (page 138) and the advanced password policy (page 142).&lt;br&gt;- Add and remove WebCTRL® add-ons such as EnergyReports.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>This Access privilege...</th>
<th>allows an operator to access (but not edit)...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Geographic Locations</td>
<td>pages from the <strong>Geographic</strong> tree.</td>
</tr>
<tr>
<td>Access Network Items</td>
<td>pages from the <strong>Network</strong> tree.</td>
</tr>
<tr>
<td>Access Groups</td>
<td>pages from the <strong>Schedule Groups</strong> tree.</td>
</tr>
<tr>
<td>Access Config Items</td>
<td>pages from the <strong>System Configuration</strong> tree.</td>
</tr>
<tr>
<td>Access Alarms</td>
<td>alarms.</td>
</tr>
<tr>
<td>Access Logic Pages</td>
<td><strong>Logic</strong> pages.</td>
</tr>
<tr>
<td>Access User Category 1-5</td>
<td>anything in a category that has the same privilege assigned to it. See &quot;To create a custom privilege&quot; below.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>This Parameter privilege...</th>
<th>allows an operator to edit properties such as...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Setpoint Parameters</td>
<td>occupied and unoccupied heating and cooling setpoints.</td>
</tr>
<tr>
<td>Edit Setpoint Tuning Parameters</td>
<td>demand level setpoint offsets, thermographic color band offsets, heating and cooling capacities and design temperatures, color hysteresis, and learning adaptive optimal start capacity adjustment values.</td>
</tr>
<tr>
<td>Edit Tuning and Logic Parameters</td>
<td>gains, limits, trip points, hysteresis, color bandwidths, design temperatures, and optimal start/stop.</td>
</tr>
<tr>
<td>Edit Manual Override Parameters</td>
<td>locks on input, output, and network points.</td>
</tr>
<tr>
<td>Edit Point Setup Parameters</td>
<td>point number, type, range, and network source and destination.</td>
</tr>
<tr>
<td>Edit Restricted Parameters</td>
<td>properties the installer restricted with this privilege.</td>
</tr>
<tr>
<td>Edit Category Assignments</td>
<td>Alarm, Graphic, Trend, and Report category assignments.</td>
</tr>
<tr>
<td>This Parameter privilege...</td>
<td>allows an operator to edit properties such as...</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Edit History Value Reset</td>
<td>elapsed active time and history resets, and runtime hours.</td>
</tr>
<tr>
<td>Edit Trend Parameters</td>
<td>enable trend logging, log intervals, and log start/stop times.</td>
</tr>
<tr>
<td>Edit Calibration Parameters</td>
<td>point calibration offsets.</td>
</tr>
<tr>
<td>Edit Hardware Controller Parameters</td>
<td>driver properties.</td>
</tr>
<tr>
<td>Edit Critical Configuration</td>
<td>critical properties the installer protected with this privilege.</td>
</tr>
<tr>
<td>Edit Area Name</td>
<td>area display names.</td>
</tr>
<tr>
<td>Edit Control Program Name</td>
<td>control program display names.</td>
</tr>
<tr>
<td>Edit Alarm Configuration</td>
<td>enabling/disabling alarms and editing alarm messages, actions, categories, and templates.</td>
</tr>
<tr>
<td>InterOp Privilege 1 - 10</td>
<td>those protected by password levels 1-10 in SuperVision.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>This Functional privilege...</th>
<th>allows an operator to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Alarm Messages and Actions</td>
<td>add, edit, and delete alarm messages and actions.</td>
</tr>
<tr>
<td>Maintain System Parameters</td>
<td>edit all properties on the System Settings page.</td>
</tr>
<tr>
<td>Maintain Schedules</td>
<td>add, edit, delete, and download schedules.</td>
</tr>
<tr>
<td>Maintain Schedule Group Members</td>
<td>add, edit, and delete schedule groups.</td>
</tr>
<tr>
<td>Maintain Categories</td>
<td>add, edit, and delete categories.</td>
</tr>
<tr>
<td>Maintain Alarm Templates</td>
<td>edit Alarm Template and Reporting Action Templates.</td>
</tr>
<tr>
<td>Acknowledge Non-Critical Alarms</td>
<td>acknowledge all non-critical alarms.</td>
</tr>
<tr>
<td>Acknowledge Critical Alarms</td>
<td>acknowledge all critical alarms.</td>
</tr>
<tr>
<td>Force Normal Non-Critical Alarms</td>
<td>force non-critical alarms to return to normal.</td>
</tr>
<tr>
<td>Force Normal Critical Alarms</td>
<td>force critical alarms to return to normal.</td>
</tr>
<tr>
<td>Delete Non-Critical Alarms</td>
<td>delete non-critical alarms.</td>
</tr>
<tr>
<td>Delete Critical Alarms</td>
<td>delete critical alarms.</td>
</tr>
<tr>
<td>Execute Audit Log Report</td>
<td>run the Location Audit Log and System Audit Log reports.</td>
</tr>
<tr>
<td>Download Controllers</td>
<td>mark equipment for download and initiate a download.</td>
</tr>
<tr>
<td>System Shutdown</td>
<td>issue the Shutdown manual command that shuts down the WebCTRL® Server application.</td>
</tr>
<tr>
<td>Engineer System</td>
<td>• log in and make database changes in SiteBuilder.</td>
</tr>
<tr>
<td></td>
<td>• use the copy, notify, reload, and revert manual commands.</td>
</tr>
<tr>
<td></td>
<td>• access the Configure and Set up Tree right-click menus in the WebCTRL® interface.</td>
</tr>
<tr>
<td></td>
<td>• Add text in the Notes field on an equipment's Properties page.</td>
</tr>
<tr>
<td>This Functional privilege...</td>
<td>allows an operator to...</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------</td>
</tr>
</tbody>
</table>
| Access Commissioning Tools  | access:  
• Equipment Checkout  
• Airflow Configuration  
• Trend, Report, and Graphic categories that require this privilege  
• Discovery tool |
| Maintain Graphs and Reports | add, edit, and delete trend graphs and reports. Also required for Time-lapse. |
| Maintain Connections        | edit **Connections** page properties. |
| Remote File Management      | access files using a WebDAV utility. |
| Remote Data Access-SOAP     | retrieve WebCTRL® data through an Enterprise Data Exchange (SOAP) application. |
| Do not audit changes made   | not have his SOAP (web services) changes recorded in the Audit Log. |
| using SOAP (Web services)   | |
| Manual Commands/Console     | access the manual command dialog box and issue basic manual commands. |
| Operations                  | |
| Manual Commands/File IO     | execute manual commands that access the server's file system. |
| Manual Commands/Adv Network | execute manual commands that directly access network communications. |
| Manual Commands/Unrestricted| execute manual commands that bypass all safeguards and may cause unpredictable results if used incorrectly. |
| Change My Settings          | edit his preferences on the **My Settings** page. |

**To create a custom privilege**

You can assign a privilege to a Graphic, Property, Trend, or Report category so that only operators with that privilege can access the category. You assign a category privilege on the page where you create or edit categories.

If all the other privileges are too widely used to accomplish the results you want, you can assign one of the five Access User Category privileges to the operator(s) and category.

For example, your system has 2 graphics categories, HVAC and Lighting/Security. You want HVAC technicians to see only the HVAC graphics and security personnel to see only the Lighting/Security graphics. To do this:

<table>
<thead>
<tr>
<th>Assign...</th>
<th>To...</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access User</td>
<td>HVAC graphics category and HVAC technicians only</td>
<td>The security personnel cannot see the HVAC graphics because they do not have Access User Category 1.</td>
</tr>
<tr>
<td>Category 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access User</td>
<td>Lighting/Security Graphics category and Security personnel only</td>
<td>The HVAC technicians cannot see the Lighting/Security graphics because they do not have Access User Category 2.</td>
</tr>
<tr>
<td>Category 2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
To add or edit a privilege set

1. On the System Configuration tree, select Privilege Sets.
2. Click Add to create a new privilege set, or select a privilege set to edit.
3. Type the Name and Reference Name for the privilege set.
4. Check each privilege (page 130) that you want to include in the privilege set.
5. Click Accept.

⚠️ **CAUTION** Include all required access privileges in a privilege set. For example, if you add Acknowledge Non-Critical Alarms to a privilege set, also add Access Alarms to that privilege set.

💡 **TIP** (Location-independent security only) To create a privilege set that is similar to an existing set, select the existing set, then click Add. The privileges that are initially selected are identical to those of the existing set.

To delete a privilege set

1. On the System Configuration tree, select Privilege Sets.
2. Select the privilege set to be deleted.
3. Click Delete.
4. Click OK.
5. Click Accept.

Operators and operator groups

The Administrator (see "Default operators" below) sets up each operator in the WebCTRL® interface by entering the necessary settings and assigning one or more privilege sets (page 129) to the operator. Operator groups give you the ability to assign privilege sets to a group of operators instead of the individual operators. Operator groups are useful if you have multiple operators who need the same privilege set or you have positions with high turnover rates. You can assign an operator to a group when you enter the operator or when you create the operator group.

**NOTE** When using hierarchical servers, you must create identical operators on each server in order to navigate across servers.

Default operators

A WebCTRL® system has the following default operators:

<table>
<thead>
<tr>
<th>Operator...</th>
<th>Has ...</th>
<th>To log in...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Almost all privileges</td>
<td>Type Administrator in the Name field, then click Log in.</td>
</tr>
<tr>
<td>Anonymous</td>
<td>The Standard privilege set that contains only viewing privileges</td>
<td>Click Log in.</td>
</tr>
</tbody>
</table>
To ensure system security, log in as the Administrator, then do one of the following:

- Assign the Admin privilege set to another operator, then delete the Administrator operator
- Assign a password to the Administrator operator.

⚠️ CAUTION ⚠️ Passwords can be forgotten. To ensure access to the WebCTRL® administrative functions, assign the Admin privilege set to at least 2 operators.

If you want to prevent Anonymous access to your system, delete the Anonymous operator.

To add or edit an operator

1. On the System Configuration tree, select Operators.
2. Click Add to enter a new operator, or select an operator to edit his settings.
3. Enter information on this page as needed. See table below.
4. Click Accept.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Name</td>
<td>The name the operator must type to log in to the system. This name must be unique within the system.</td>
</tr>
<tr>
<td>Change password</td>
<td>Enable this field, then type the current and new passwords.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> An operator can change his password on the My Settings page (page 136).</td>
</tr>
<tr>
<td>Force User to Change Password at login?</td>
<td>Forces the operator to change his password immediately after his next login.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> Use this field with the Change Password field to create a temporary password that the operator must change after his next login.</td>
</tr>
<tr>
<td>Exempt From Password Policy</td>
<td>If Use advanced password policy is enabled on the System Settings &gt; Security tab (page 173), select this option if you do not want the policy to apply to this operator.</td>
</tr>
<tr>
<td>Logoff options</td>
<td>If Log off operators after ___ of inactivity is enabled on the System Settings &gt; Security tab (page 173), select one of the 3 logoff options.</td>
</tr>
<tr>
<td>Personal Information</td>
<td>You can enter contact information for this operator.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> An operator can enter contact information on the My Settings page (page 136).</td>
</tr>
<tr>
<td>Starting Location and Starting Page</td>
<td>The WebCTRL® location and page that will be displayed after the operator logs in.</td>
</tr>
</tbody>
</table>
### Field Notes

**System-wide Privilege Sets**
Select the privilege set(s) that you want to assign to the operator. The **Effective System-wide Privileges** list show which privileges the operator will have.

**NOTES**
- Click **Show current privileges only** to see only the selected privilege sets and privileges.
- A grayed out privilege set with a group name beside it indicates the operator is inheriting that privilege set from the group.

**Tip** To test the settings and privileges that you gave to an operator, you can open a second browser session on your computer and log in as the operator. For instructions on opening a second session in the browser you are using, see *Setting up and using a web browser to view the WebCTRL® interface* (page 165).

---

To delete an operator

1. On the **System Configuration** tree, select **Operators**.
2. Select the operator.
3. Click **Delete**.
4. Click **Accept**.

To add or edit an operator group

1. On the **System Configuration** tree, select **Operator Groups**.
2. Click **Add** to create a new operator group, or select an operator group to edit it.
3. Type the **Display Name** and **Reference Name** for the operator group.
4. Under **Members**, select the operators and/or groups that you want to add to the new group.
5. Under **Privilege Sets**, select the **privilege sets** (page 129) that you want to assign to the new group.
   
   **NOTE** To see what privileges are included in a privilege set, go to the **Privilege Sets** page and then select the privilege set in the table.

6. Click **Accept**.

**Tip** Every operator is automatically a member of a permanent default group called **Everybody**. You can assign privilege sets to this group.

To delete an operator group

1. On the **System Configuration** tree, select **Operator Groups**.
2. Select the operator group.
3 Click **Delete**.
4 Click **Accept**.

⚠️ **CAUTION** When you delete an operator group, its individual members lose the privilege sets that were assigned to the group.

---

**To change My Settings**

On the **My Settings** page, you can change settings, such as your:

- Password
- Viewing preferences
- Contact information

**NOTE** The System Administrator can also change these settings on the **Operators** page.

To change your settings:

1. On the **System Configuration** tree, select **My Settings**.
2. Make changes on the **Settings** or **Contact Info** tab. See table below.
3. Click **Accept**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Change password</strong></td>
<td>Enable this field, then type your current and new passwords.</td>
</tr>
<tr>
<td><strong>Starting Location</strong> and <strong>Starting Page</strong></td>
<td>The WebCTRL® location and page that will be displayed after you log in.</td>
</tr>
</tbody>
</table>
| **Language**                   | The language and formatting conventions you want to see in the WebCTRL® interface.

**NOTES**

- If you will be using a language other than English, see *Setting up your system for non-English languages* (page 197) for additional requirements.
- If support for your selected language is removed in SiteBuilder, the WebCTRL® application will automatically assign the System language to you.

| **Automatically collapse trees** | Expands only one tree branch at a time. |
| **Automatically download schedules on each change** | Select to automatically download all new schedules that you create and schedules that you change. |
Play sound at browser when server receives Check **Non-critical alarms** or **Critical alarms** if you want the system to audibly notify you when that type of alarm is received.

You can specify a different sound file.

- Internet Explorer®, Firefox®, and Safari® support .wav, .mp3, or .au files.
- Google™ Chrome™ supports .wav or .mp3 files.

1. Put your file in the `webroot\_common\lvl5\sounds` folder.
2. In the **Sound File** field, replace `normal_alarm.wav` or `critical_alarm.wav` with the name of your sound file.

**NOTE** You can put your sound file anywhere under the `WebCTRL\ldots` folder, but you must change the path in the **Sound File** field.
Advanced security

Optional WebCTRL Package

NOTE To see if your system has this optional package, click , then select About. You have this package if Enabled Features shows Adv. Security.

Location-dependent operator access

Optional WebCTRL Package

NOTE To see if your system has this optional package, click , then select About. You have this package if Enabled Features shows Adv. Security.

With the Advanced Security package, you can set up operator access to your system to be location-dependent. This type of operator access lets you assign privileges to an operator only at locations in the system where he needs them. For example, you could assign an operator mechanic privileges in one building in a system, view-only privileges in another building, and no privileges in a third building.

New and converted WebCTRL® systems default to location-independent operator access in which an operator’s privileges apply throughout the system. You should understand this type of operator access before switching to location-dependent. See Operator access (page 129) for more information on location-independent operator access.

NOTE When using hierarchical servers, the security policy and privilege sets are local to each server, so you can have location independent security on one server but not on another.

To switch to location-dependent access

CAUTIONS

• Create a backup of your system before you begin. Switching to location-dependent operator access changes the configuration of operators and privilege sets. If you need to revert to location-independent operator access, your previous configuration cannot be automatically restored.

• If you change the policy after you create and assign privilege sets to operators, you may need to reconfigure your operators’ privileges.

To switch to location-dependent operator access:

1 On the System Configuration tree, select System Settings.
2 On the Security tab under Security Policy, click Change Policy.
3 Follow the on-screen instructions.

Privileges and privilege sets

When using location-dependent operator access, privileges are either system-wide or local.

System-wide privileges allow an operator to perform functions throughout the entire system, such as accessing the Configuration tree or performing a system shutdown.

Local privileges allow an operator to perform functions in a specific area of the system, such as editing...
setpoints or viewing alarms. Assigning any local privilege to an operator also allows him to change his password and set preferences on his *My Settings* (page 136) page.

You assign system-wide privileges to system-wide privilege sets and local privileges to local privilege sets. Use the following table in planning which privileges to assign to a privilege set. For a description of each privilege, see *Privileges* (page 130).

<table>
<thead>
<tr>
<th>System-wide privileges</th>
<th>Local privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Groups</td>
<td>Access Geographic Locations</td>
</tr>
<tr>
<td>Access Config Items</td>
<td>Access Network Items</td>
</tr>
<tr>
<td>Maintain System Parameters</td>
<td>Access Alarms</td>
</tr>
<tr>
<td>Maintain Schedule Group Members</td>
<td>Access Logic Pages</td>
</tr>
<tr>
<td>Maintain Categories</td>
<td>Access User Category 1 - 5</td>
</tr>
<tr>
<td>Maintain Trends Display and Print Setup</td>
<td>Edit Setpoint Parameters</td>
</tr>
<tr>
<td>Maintain Alarm Templates</td>
<td>Edit Setpoint Tuning Parameters</td>
</tr>
<tr>
<td>Acknowledge Non-Critical Alarms</td>
<td>Edit Tuning and Logic Parameters</td>
</tr>
<tr>
<td>Acknowledge Critical Alarms</td>
<td>Edit Manual Override Parameters</td>
</tr>
<tr>
<td>Force Normal Non-Critical Alarms</td>
<td>Edit Point Setup Parameters</td>
</tr>
<tr>
<td>Force Normal Critical Alarms</td>
<td>Edit Restricted Parameters</td>
</tr>
<tr>
<td>Delete Non-Critical Alarms</td>
<td>Edit Category Assignments</td>
</tr>
<tr>
<td>Delete Critical Alarms</td>
<td>Edit History Value Reset</td>
</tr>
<tr>
<td>Execute Audit Log Report</td>
<td>Edit Trend Parameters</td>
</tr>
<tr>
<td>Download Controllers</td>
<td>Edit Calibration Parameters</td>
</tr>
<tr>
<td>System Shutdown</td>
<td>Edit Hardware Controller Parameters</td>
</tr>
<tr>
<td>Engineer System</td>
<td>Edit Critical Configuration</td>
</tr>
<tr>
<td>Access Commissioning Tools</td>
<td>Edit Area Name</td>
</tr>
<tr>
<td>Maintain Graphs and Reports</td>
<td>Edit Control Program Name</td>
</tr>
<tr>
<td>Maintain Connections</td>
<td>Edit Alarm Configuration</td>
</tr>
<tr>
<td>Remote File Management</td>
<td>InterOp Privilege 1 - 10</td>
</tr>
<tr>
<td>Remote Data Access-SOAP</td>
<td>Manage Alarm Messages and Actions</td>
</tr>
<tr>
<td>Do not audit changes made using SOAP (Web services)</td>
<td>Maintain Schedules</td>
</tr>
<tr>
<td>Manual Commands/Console Operations</td>
<td></td>
</tr>
<tr>
<td>Manual Commands/File IO</td>
<td></td>
</tr>
<tr>
<td>Manual Commands/Adv Network</td>
<td></td>
</tr>
<tr>
<td>Manual Commands/Unrestricted</td>
<td></td>
</tr>
<tr>
<td>Change My Settings</td>
<td></td>
</tr>
</tbody>
</table>

**NOTES**

- For an operator to add, edit, or delete schedule groups, he must have the system-wide privilege Maintain Schedule Group Members. He must also have the local privileges Access Geographic Locations and Maintain Schedules at each location that is a member of the schedule group.

- If you switch to location-dependent operator access in a system that has operators and privileges set up, the WebCTRL® application splits any existing privilege set containing local and system-wide privileges into 2 separate privilege sets - one local and one system-wide. Operators’ system-wide privilege sets still apply throughout the system. The operators’ local privilege sets are automatically assigned at the system level. You can then reassign the local privilege sets to the operators at the locations where they need them.
To add a privilege set
Adding a privilege set using location-dependent operator access is the same as using location-independent operator access except that you must select whether you are adding a system-wide or local privilege set. See Privilege sets (page 129).

To assign privilege sets to an operator
Assign a system-wide privilege set to an operator on the Operators page in the same way you would assign privilege sets in a system using location-independent operator access. See Operators and Operator Groups (page 133).

Assign a local privilege set to an operator at locations on the Geographic or Network tree where he needs the privileges.

1. Select a location on the Geographic or Network tree.
2. Click Privileges.
3. On the Configure tab, click Add.
4. Select the operator or operator group.
5. Click OK.
6. Select the privilege set(s) that you want the operator to have.
7. Click Accept.

NOTE You can display icons and hover text on the Geographic tree that show where privileges have been assigned. See Tree icons and hover text (page 27).

To delete a local privilege set assignment
1. On the Geographic or Network tree, select the location where the assignment was made.
2. Click Privileges.
3. Select the assignment under Privilege Set Assignments at this Level.
4. Click Delete.
5. Click Accept.

Restricting access in the system

Restricting an operator’s access to areas of the system
You can give an operator access to only a specific area of the system. All other areas will be either grayed out or not visible when the operator logs in to the WebCTRL® interface.

EXAMPLE If you give an operator the Access Geographic Locations privilege only at the first floor of the system shown below, he will see a navigation tree like the one on the left. The areas above the first
floor are visible because he needs them to navigate to the first floor, but grayed out because he cannot access them. The operator does not see Dallas, New York, or San Francisco because he can’t access them and does not need them to navigate.

### Restricted access

<table>
<thead>
<tr>
<th>World Corporation</th>
<th>First Floor</th>
</tr>
</thead>
<tbody>
<tr>
<td>▶️ Atlanta - R&amp;D Facility</td>
<td>▶️ Administration</td>
</tr>
<tr>
<td>▶️</td>
<td>▶️ Main Conference Room</td>
</tr>
<tr>
<td>▶️</td>
<td>▶️ AHU-1</td>
</tr>
<tr>
<td>▶️</td>
<td>▶️ Accounting</td>
</tr>
<tr>
<td>▶️</td>
<td>▶️ Cafeteria</td>
</tr>
</tbody>
</table>

### Full system access

<table>
<thead>
<tr>
<th>World Corporation</th>
<th>Dallas - Training Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>▶️ Atlanta - R&amp;D Facility</td>
<td>▶️ New York - Headquarters</td>
</tr>
<tr>
<td>▶️</td>
<td>▶️ San Francisco - Medical</td>
</tr>
<tr>
<td>▶️ Basement</td>
<td>▶️ Electric Meter</td>
</tr>
<tr>
<td>▶️ First Floor</td>
<td>▶️ OA Conditions</td>
</tr>
<tr>
<td>▶️ Second Floor</td>
<td>▶️ Third Floor</td>
</tr>
</tbody>
</table>

### Security Assignments Report

A Security Assignments Report shows an operator’s local and system-wide privileges and privilege sets at a specific location.

1. Select the location on the Geographic or Network tree.
2. Click the Reports button drop-down arrow, then select Security > Security Assignments.
3. On the Options tab, select an operator.
4. Click Run.

Restricting all operator access to a location

To remove all operators’ local privileges from a location so that you can assign access only to a specific operator(s), navigate to the location, select Privileges, then uncheck Inherit security privileges from above this level.
Recording reasons for edits (21 CFR Part 11)

Optional WebCTRL Package

NOTE To see if your system has this optional package, click , then select About. You have this package if Enabled Features shows Adv. Security.

The Advanced Security package provides support for 21 CFR Part 11. With this feature enabled, the WebCTRL® application can require an operator to record a reason for changing an equipment property before it accepts the change. The WebCTRL® Audit Log report then displays the operator's name and the recorded reason for making the change.

NOTE You cannot use WAP-enabled devices to change equipment that requires operators to log changes.

To set up equipment to require reasons for changes

1. On the WebCTRL® Geographic or Network tree, right-click the equipment, then select Configure.
2. Check Require operator to record any changes to control program.
3. Click Accept.

NOTE You can also turn this setting on in SiteBuilder in the equipment's properties dialog box.

To view reasons for changing equipment properties

1. On the WebCTRL® tree, select a piece of equipment that requires reasons for change.
2. Click the Reports button drop-down arrow, select Security > Location Audit Log or System Audit Log.
3. On the Options tab under Display the following columns, check Reason.
4. Click Run.

Advanced password policy

Optional WebCTRL Package

NOTE To see if your system has this optional package, click , then select About. You have this package if Enabled Features shows Adv. Security.

With the Advanced Security package, you can set up a WebCTRL® password policy to meet your security needs.

1. On the System Configuration tree, select System Settings.
2. On the Security tab under Operators, enter information in the fields described below.

NOTE See System Settings (page 171) for information on all the other fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use advanced password policy</strong></td>
<td>Enable this field to put restrictions on passwords. An operator’s login name and password must be different when this policy is enabled. After you change the password policy, any operator whose password doesn't meet the new requirements will not be locked out of the system, but will be prompted to create a new password.</td>
</tr>
<tr>
<td><strong>Passwords must contain</strong></td>
<td>You can specify how many characters and which of the following types of characters a password must contain:</td>
</tr>
<tr>
<td></td>
<td>• Numbers</td>
</tr>
<tr>
<td></td>
<td>• Special characters—any keyboard character that is not a number or letter.</td>
</tr>
<tr>
<td></td>
<td>• Letters—uppercase, lowercase, or both.</td>
</tr>
<tr>
<td><strong>Cannot be changed more than once every __ days.</strong></td>
<td>Enter a number to limit how often users can change their passwords. When set to 0, users can change them as often as they want.</td>
</tr>
<tr>
<td><strong>May not be reused until ___ different passwords are used.</strong></td>
<td>Enter a number between 1 and 20. Enter 0 to reuse passwords without a delay.</td>
</tr>
<tr>
<td><strong>Expire after ___ days</strong></td>
<td>Enable to set the number of days an operator can use his password before the system requires him to change it. Enter a number between 1 and 999.</td>
</tr>
<tr>
<td><strong>Force expiration</strong></td>
<td>Click this button to force every user's password to expire. Each user will be prompted to change their password when they next attempt to log in to the WebCTRL® interface.</td>
</tr>
</tbody>
</table>

**NOTE** The Advanced password policy settings do not synchronize across hierarchical servers. You should set up each system with the same advanced password settings to avoid problems when navigating between the systems.
Cost-saving strategies

HVAC equipment runs to maintain adequate zone temperatures. Some zones, like classrooms, must maintain a comfortable temperature only while people occupy them. When a zone is no longer occupied, you can define different setpoints that require less energy to maintain. Use WebCTRL® Schedules for these occupied/unoccupied zones so that equipment runs only as needed to reduce energy consumption, but not comfort.

Other zones, like computer server rooms and production floors, must maintain particular cooling and heating setpoints 24 hours a day, 7 days a week. Schedules would have no cost-saving effect on them. Use one of the other cost-saving strategies to reduce energy consumption and equipment repairs for these kinds of zones.

You can realize the greatest savings by using Schedules. Then fine tune Optimal Start, Demand Control, and Setpoint Optimization. Each strategy depends on a particular microblock.

<table>
<thead>
<tr>
<th>Microblock</th>
<th>Strategy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Schedules" /></td>
<td>Schedules (page 60)</td>
<td>Define when a building or zone is occupied and whether or not equipment should run, depending on the occupied setpoints.</td>
</tr>
<tr>
<td><img src="image" alt="Optimal Start" /></td>
<td>Optimal Start (page 56)</td>
<td>Ensures that a zone’s ideal comfort range is reached just as the zone becomes occupied.</td>
</tr>
<tr>
<td><img src="image" alt="Demand Control" /></td>
<td>Demand Control (page 58)</td>
<td>Relaxes heating or cooling setpoints when a certain level of energy use is reached in order to avoid peak demand, ratchet, or time of use electric charges.</td>
</tr>
<tr>
<td><img src="image" alt="Setpoint Optimization" /></td>
<td>Setpoint Optimization (Trim and Respond)</td>
<td>Calculates a piece of equipment’s setpoint based on the number of heating or cooling requests it receives from other equipment.</td>
</tr>
</tbody>
</table>
Advanced topics
To run a manual command:

1. Click , then select **Manual Command**.
2. Type the manual command in the dialog box, then click **OK**.

**TIP** Ctrl+Shift+M also opens the dialog box.

You must have the Manual Commands/Console Operations privilege to access the manual commands dialog box. The descriptions below tell you if you need an additional privilege to run the corresponding command.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>addon</td>
<td>Opens a dialog box where you can upload, start, stop, or remove an add-on program such as Tenant Override Billing.</td>
</tr>
<tr>
<td>arcnet</td>
<td>Run this command each time you plug a device, such as a laptop, into a controller using an ARCNET card. The arcnet command configures the WebCTRL® application to recognize your device as the WebCTRL® server. Run this command from the equipment, controller, or network level on the <strong>Network</strong> tree.</td>
</tr>
<tr>
<td>autopilot location</td>
<td>Displays the full path for the current location and copies the path to the Windows® clipboard. You can then paste the path into the autopilot.xml file that runs the WebCTRL® autopilot. See <em>Running the WebCTRL® autopilot</em> (page 154).</td>
</tr>
<tr>
<td>bacnet showindex</td>
<td>Displays all files (file name, size, date) downloaded to the selected controller.</td>
</tr>
</tbody>
</table>

**bbmd commands:**

You must have the Manual Commands/Adv Network privilege to run bbmd commands.

- **bbmd read <IP address>**
  - Reads the BBMD table of the controller at the given IP address. For example, to display the BBMD table in the BACnet device router at IP address 154.16.12.101, type:

    `bbmd read 154.16.12.101`

- **bbmd update <network number>**
  - Selects BBMDs on the specified network and marks them for download. If no network is entered at the end of the command, all networks in the system are scanned. For example, if the network number is 888, type:

    `bbmd update 888`
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| bbmd view <network number> | Views the list of BBMDs that have been selected for the network number at the end of the command. Assumes the update has been run.  
  For example:  
  `bbmd view 888` |
| bbmd write <table file> <IP address> | Writes the BBMD table into the controller at the given IP address.  
  See To set up BBMD's through the WebCTRL® interface.  
  For example, to write the BBMD table in dallasbbmd.bdt into the BACnet device router at IP address 154.16.12.101, type:  
  `bbmd write dallasbbmd.bdt 154.16.12.101` |
| bbmd clear <IP address> | Clears the BBMD for the specified controller.  
  For example:  
  `bbmd clear 154.16.12.101` |
| bbmd dump <network> <file> | Writes to a file the BBMD from the specified controller.  
  For example:  
  `bbmd dump 888 dallasbbmd.bdt` |
| checkurls | 1 Finds all network point exp: expressions for the selected item on the Geographic or Network tree.  
  2 Converts the exp: expressions to bacnet:// equivalent expressions that the controllers use.  
  3 Compares the equivalent bacnet:// expressions to the bacnet:// expressions currently downloaded in the controllers.  
  4 Displays any mismatches. |
<p>| checkurls -p | Does the same as checkurls, then adds any mismatches to the download queue as parameter downloads. |
| checkurls -v | Does the same as checkurls, but displays the exp: and bacnet:// expressions for all network points that were checked. |
| commstat | Gives a complete set of diagnostic information for all defined connections as well as information regarding all modems in the system. |
| copy | Displays a global copy utility that allows you to selectively copy trend graphs, custom reports and all editable properties from the selected equipment to other equipment in the system with the same control program. See To use Global Copy (page 46). |
| disconnect | Disconnects you from a BACnet dial-up session if you are the last active operator. |
| <strong>download commands:</strong> | Each of these commands performs an immediate download to a controller for the selected control program, device, or driver. |
| download m | Downloads all content, including parameters, schedules, and BBMDs (if applicable). |
| download p | Downloads parameters only. |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>download s</td>
<td>Downloads schedules only.</td>
</tr>
<tr>
<td>go commands:</td>
<td></td>
</tr>
</tbody>
</table>
| go <refname or path> | Goes to the point in the system that is referenced. For example:  
|                  | go #oa_conditions or go vav_1/m28                             |
|                  | See Defining WebCTRL paths.                                  |
| go ~net          | Takes you from a piece of equipment on the Geographic tree to the same equipment on the Network tree. |
| go ~geo          | Takes you from a piece of equipment on the Network tree to the same equipment on the Geographic tree. |
| go ~device       | Takes you to the controller for a point or piece of equipment on the Network tree. |
| go ~network      | Takes you to the network the selected object’s controller is associated to. |
| go -logicpopup <refname> | Goes to the microblock pop-up for the microblock that is referenced. You must run this command from the microblock’s equipment in the navigation tree. For example:  
|                  | go -logicpopup lstat                                         |
| go <device ID>   | Goes to a device on the Network tree. For example, to go to device 301205 referenced in a dead module alarm, type:  
|                  | go 301205                                                    |
| go <device ID>/<object ID> | Goes to a device and object on the Geographic or Network tree. For example:  
|                  | go 300550/AI:3                                               |
| go <object ID>   | Goes to an object for the current device on the Geographic or Network tree. For example, if a module alarm reports a control program Locked I/O Alarm and references an error in program 11, click the link to go to the device, then go to the object by typing:  
<p>|                  | go PRG:11                                                    |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>go &lt;s,g,m,p&gt;</td>
<td>(site, gateway, controller, program) Goes to the item that the s,g,m,p address references. Use this command for legacy equipment only. For example: go 2,1,4,1</td>
</tr>
<tr>
<td>localhost</td>
<td>Shows the IP address of the WebCTRL® server</td>
</tr>
<tr>
<td>logoffuser</td>
<td>Logs off a user (without warning the user). Type a <code>whoson</code> manual command to view the IDs of logged in operators, then type <code>logoffuser x</code>, where x is a the user's ID.</td>
</tr>
<tr>
<td><strong>markdowndownload commands:</strong></td>
<td>These commands place the controller for the selected tree item on the list to download at a later time. The download list can be viewed at <strong>Network tree &gt; Downloads</strong>.</td>
</tr>
<tr>
<td>markdownload</td>
<td>Marks for an All Content download, that includes parameters, schedules, and BBMDs (if applicable).</td>
</tr>
<tr>
<td>markdownload p</td>
<td>Marks for a Parameters download.</td>
</tr>
<tr>
<td>markdownload s</td>
<td>Marks for a Schedules download.</td>
</tr>
<tr>
<td>memory</td>
<td>Shows the amount of server memory allocated for the WebCTRL® application and the amount being used.</td>
</tr>
<tr>
<td>memory -free</td>
<td>Releases unused server memory, then shows the WebCTRL® memory usage before and after the release.</td>
</tr>
<tr>
<td><strong>modstat commands:</strong></td>
<td>These commands display a Modstat report. <strong>NOTE</strong> It is not necessary to download a controller before running a Modstat on it. Binding takes place when you run the modstat.</td>
</tr>
<tr>
<td>modstat</td>
<td>Displays status of the controller at the current location, including: • Hardware components of the device • Software components of the device • Error conditions that may exist in the device • Date and time the device is using</td>
</tr>
<tr>
<td>modstat 8:&lt;device instance number&gt;</td>
<td>Displays status for a specific controller in the IP network using the controller’s ID. Your location in the system does not have to be the controller you are querying. For example: modstat 8:489202</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| modstat mac:<network number>,<media type>:<mac address> | Displays a Modstat for a specific controller in the system using the controller’s MAC address. Network number is the number of the network this controller is on as specified in SiteBuilder; media type is the type of network the controller is on; MAC address can be either the controller address or the IP address and depends on the controller’s media type.  
  For example:  
  modstat mac:48161,arcnet:2  
  or  
  modstat mac:888,bacnet/ip:172.16.101.119 |
| notify               | Sends a message to all operators currently logged in to the system. For example, "The server is going to shut down in 5 minutes. Please log off." To run this command, type: notify <your message>. The message must use only alphanumeric characters. You must have the Admin privilege set or the Engineer System privilege to run this command. |
| paramupload          | Uploads parameters (editable properties) to the WebCTRL® application from the equipment or driver at the current location and below. If you want to upload editable properties for all equipment on a floor, navigate to the floor level on the Geographic tree. If you want to do this for everything under a particular router, navigate to the router or the network on the Network tree. You must have the Manual Commands/Adv Network privilege to run this command. |
| ping                 | Ping to verify communication between to IP devices. You cannot ping devices on non-IP networks. To run this command type: ping <hostname> where <hostname> is the IP address or device name.  
  For example:  
  ping 192.168.168.1  
  (will ping the IP address 4 times)  
  or  
  ping 192.168.168.1 -t  
  (will ping the IP address constantly) |
<p>| rebootserver         | Restarts the WebCTRL® Server application. You must log back in to the WebCTRL® interface if you want to continue. You must have the System Shutdown privilege to run this command. |
| rebuild              | Rebuilds a Properties page. Use if you make changes to control program property text in the EIKON® application.                                                                                                                                                        |
| reload               | Reloads a control program. Use if you make changes to control program logic in the EIKON® application. Reloading updates all instances of the control program throughout the system and marks the controller(s) for an All Content download. You must have the Engineer System privilege to run this command. |
| restartmodule       | Restarts the current controller. You must have the Manual Commands/Adv Network privilege to run this command.                                                                                                                                                      |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rnet here</td>
<td>Overrides the address configuration of the Rnet host controller to allow a subsequent All Content or Parameters download. Run this command if you experience communication problems with the controller because the controller’s network number does not agree with SiteBuilder’s network number. Run this command from a control program, device or driver.</td>
</tr>
<tr>
<td>revert</td>
<td>Resets the selected driver or control program to its default values.</td>
</tr>
<tr>
<td>setdefault</td>
<td>Sets the current page as the default view for the selected action button and the selected tree location. You must have the Engineer System privilege to run this command.</td>
</tr>
<tr>
<td>setgcm</td>
<td>Initializes any LANgate (gateway) from a converted SuperVision® system.</td>
</tr>
<tr>
<td></td>
<td>After downloading to the LANgate, run setgcm if you:</td>
</tr>
<tr>
<td></td>
<td>• Added a controller to a CMnet where the address is set higher than any other address on the CMnet</td>
</tr>
<tr>
<td></td>
<td>• Changed the 3-letter system name</td>
</tr>
<tr>
<td></td>
<td>• Changed the <strong>Generate controller alarm after no communication for ___ minutes</strong> (dead module timeout value) on the <strong>System Settings</strong> page</td>
</tr>
<tr>
<td></td>
<td>• Changed the site number in SiteBuilder (previously referred to as the line number)</td>
</tr>
<tr>
<td></td>
<td>setgcm sends the following information from the WebCTRL® database to the LANgate:</td>
</tr>
<tr>
<td></td>
<td>• Maxnet (the highest addressed controller plus one)</td>
</tr>
<tr>
<td></td>
<td>• 3-letter system name</td>
</tr>
<tr>
<td></td>
<td>• Site number</td>
</tr>
<tr>
<td></td>
<td>• Dead module timeout value</td>
</tr>
<tr>
<td>NOTES</td>
<td>• You can send this command over network, direct or modem connections, but not over a direct network (access port).</td>
</tr>
<tr>
<td></td>
<td>• In Supervision®, the command set the workstation phone number in the LANgate. You must now type the LANgate’s phone numbers on the LANgate’s parameter pages.</td>
</tr>
<tr>
<td></td>
<td>• You must have the Manual Commands/Adv Network privilege to run this command.</td>
</tr>
<tr>
<td>showhistory</td>
<td>Gives historical information on the system, such as when it was created and updated. You must have the Manual Commands/Unrestricted privilege to run this command.</td>
</tr>
<tr>
<td>shutdown</td>
<td>Shuts down the WebCTRL Server application. This stops communication between the server and the client, but does not close any open WebCTRL® pages. You must have the System Shutdown privilege to run this command.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>storetrends</td>
<td>Uploads trend data from the controller(s) to the database for all equipment at and below the selected item on the Geographic tree. This command stores trend data for points that have Trend Historian enabled.</td>
</tr>
</tbody>
</table>
| timesync      | Synchronizes the time on all controllers at the current location and below to the time on the server. Run this command only from a location on the Network tree.  
**NOTE** For CMnet networks, executing a timesync on a controller sends the timesync to its gateway, and all the controllers under that gateway.  
You must have the Manual Commands/Adv Network privilege to run this command. |
<p>| updatedriver commands: | You must have the Engineer System privilege to run updatedriver commands.                                                                 |
| updatedriver  | Updates the selected controller to the latest version of its driver.                                                                             |
| updatedriver net | Updates the selected controller to the latest version of its driver and any other controllers on the same network that use that driver.          |
| updatedriver all | Updates the selected controller to the latest version of its driver and all other controllers in the system that use that driver.               |
| upgradejsp commands: | Upgrading to a v6.0 or later system automatically upgrades any .jsp graphics created in WebCTRL® Extensions for FrontPage. If you edit one of the .jsp files after upgrade, you must run one of the following commands. These commands could take several minutes to complete. A message is displayed when finished. |
| upgradejsp &lt;absolute path&gt; | Use to update a single graphic. For example: c:\webctrl#.#\webroot&lt;system&gt;\graphics\vl5\sitea\building1.jsp |
| upgradejsp &lt;folder path&gt; | Use to update all graphics in a folder. For example: c:\webctrl#.#\webroot&lt;system&gt;\graphics\vl5\sitea |
| upgradejsp all | Use to update all graphics in c:\webctrl#.#\webroot&lt;system&gt;\graphics\vl5 |
| whereami      | Displays the full path for the current location and gives the display and reference names of the action button, category, instance and tab. If the selected tree location differs from the location shown in the action pane (for example, a point trend page), whereami returns information on both locations. Use this command when you create links in ViewBuilder. |
| whoson        | Shows the list of users currently logged in to the WebCTRL® system, the IP addresses from where they are logged on, what kind of interface they are using (for example, lvl5 for a web browser on a computer), and how long it has been since they have actively interfaced with the WebCTRL® system. |</p>
<table>
<thead>
<tr>
<th><strong>Command</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>zap</td>
<td>Restarts the current controller. You must have the Manual Commands/Adv Network privilege to run this command.</td>
</tr>
</tbody>
</table>
Running the WebCTRL® autopilot

To monitor your WebCTRL® system, you can run the autopilot to display specified WebCTRL® pages at regular intervals. You can run the autopilot on the WebCTRL® server or on one or more client computers. Each computer can display a different set of pages.

To set up the WebCTRL® autopilot

1. Copy the WebCTRLx.autoplay folder from the WebCTRL® system to any location on the computer where you will be running the autopilot.
2. In a text editor such as Windows® Notepad, open the autopilot.xml file in the new folder you created in step 1.

   CAUTION  Do not open or edit the original autopilot.xml file in the WebCTRL® system. Keep this file to set up the autopilot on other computers.
3. In the row that begins with <script, replace the highlighted text shown below with the information needed to start your system.

   <script url="http://someurl" user="admin" password="pwd123" fullscreen="true" loop="true">

   NOTES
   ○ The Attribute list near the top of the file describes each field.
   ○ To prevent exposing someone's password in this file, create a generic user and password in the WebCTRL® interface.
4. Each pair of rows beginning with <navigate and <delay define a WebCTRL® page and how many seconds the page should display. Follow the steps below to replace each <navigate line with information specific to your system. Add or delete rows as needed.
   a) In the WebCTRL® interface, go to the page you want to display.
   b) Press Ctrl+M.
   c) Type autopilot location.
   d) Click OK. The path to the WebCTRL® page is displayed and is copied to the Windows clipboard.
   e) In the autopilot.xml file, highlight a <navigate row, then press Ctrl+V to replace the highlighted text with the copied WebCTRL® path.

   NOTE  To have the autopilot run a report, define the path to the report's View tab.
5. In the <delay row below each path, change 20 to the number of seconds you want to display the WebCTRL® page.
6. Save the file.
To run the WebCTRL® autopilot

**NOTE** If your computer is running Windows Vista®, see *To run autopilot with Windows Vista* (page 155) before starting the autopilot.

1. Start the WebCTRL Server application.
2. Run the `autopilot.bat` file that you created in step 1 of *To set up the WebCTRL® autopilot* (page 154).

**NOTES**
- To stop the autopilot, do one of the following:
  - Close the web browser.
  - Close the Command Prompt window that is running the `autopilot.bat` file to stop the autopilot but leave the WebCTRL® interface running in the web browser.
- If the autopilot does not start, open `autopilot.log` to see the error.

To run autopilot with Windows Vista

To run the autopilot with the Windows Vista® operating system, you must add the WebCTRL® URL to your web browser’s trusted sites.

1. In Internet Explorer®, select **Tools** or 🌐 > **Internet Options**.
2. On the **Security** tab, select the **Trusted Sites** icon, then click the **Sites** button.
3. Under **Add this Web site to the zone**, type the url that autopilot uses to start your system. See step 3 in *To set up the WebCTRL® autopilot* (page 154).
4. Uncheck **Require server verification (https:) for all sites in this zone**.
5. Click **Add**.
6. Click **OK** to close both windows.
7. Close Internet Explorer to have the changes take effect.
Using WAP devices with the WebCTRL® system

The WebCTRL® system supports Wireless Application Protocol (WAP), a communications protocol that allows you to access your system through a WAP-enabled phone. The WebCTRL® application supports WAP-enabled browsers on 2G and 3G devices on the Sprint PCS network and Pocket Internet Explorer on devices running Windows Mobile for Pocket PC 2003 or later.

Using a WAP device, you can access the Internet and remotely manage certain aspects of your system. Only English alphanumeric characters are supported.

NOTES

• Navigation buttons and how the information is presented varies among WAP devices.
• To use WAP through a secure port, you must use a certificate from a trusted Certificate Authority (CA). Ask your phone company which Certificate Authorities they support. See "To set up TLS using a self-signed certificate" in WebCTRL® Help.

Supported WebCTRL® features

The WAP interface supports the following WebCTRL® features. You can:

• Navigate through the Geographic tree.
• View and manage Alarms for the current location.
• Receive an e-mail alarm message.
• View and edit abbreviated Properties pages for areas and equipment.
• View and edit abbreviated Properties pages for microblocks.

You cannot:

• View and edit items under the System Configuration tree.
• View and manage Schedules.
• Configure and view Reports.
• View Graphics pages.
• Send manual commands.

To dial up a WebCTRL® system using WAP

Dialing up a WebCTRL® system using a WAP device differs from dialing a telephone number. Each service has a slightly different method. The following method for connecting to WebCTRL Server using WAP is similar to the Sprint PCS Wireless mobile phone process.

1  Turn on the WAP device.
2  Select Wireless Web.
3 Select **Launch Browser**.
4 Select **Menu**.
   You can also select **WebCTRL bookmark** if one has been saved.
5 Select **Goto**.
6 Tap in the **WebCTRL® IP address**; for example, **192.168.168.1**.
   **NOTE** If you do not see the **WebCTRL® login**, tap in the IP address again and do the following:

<table>
<thead>
<tr>
<th>If your WAP device supports...</th>
<th>...append these characters to the end of the address.</th>
</tr>
</thead>
<tbody>
<tr>
<td>WML browsers.</td>
<td>?t=w</td>
</tr>
<tr>
<td>Applies to most older (pre 3G) WAP devices.</td>
<td></td>
</tr>
<tr>
<td>XHTMLMP browsers.</td>
<td>?t=xmp</td>
</tr>
<tr>
<td>Applies to most newer (3G) WAP devices.</td>
<td></td>
</tr>
<tr>
<td>XHTML browsers.</td>
<td>?t=X</td>
</tr>
<tr>
<td>A text only interface for PC's or PDA's.</td>
<td></td>
</tr>
</tbody>
</table>

**EXAMPLE** 192.168.168.1?t=xmp
7 Log in to your **WebCTRL® system**:
   ○ Tap in your **WebCTRL® username**, then select **OK**
   ○ Tap in your **WebCTRL® password**, then select **Login**.
To navigate the system

Navigating through the WAP interface is the same as navigating through the WebCTRL® GEO tree—the WAP screen is similar to the WebCTRL® navigation pane.

The WebCTRL® application automatically generates default WAP interface pages. However, you can create custom pages using ViewBuilder for WAP.

After you log in, the first screen shows the system level. The name at the top of the screen is the name of the current level. To navigate deeper into the system, select an item by either pressing its number on the keypad or by scrolling through the list and then selecting OK. To navigate to other areas of the system, see below.

<table>
<thead>
<tr>
<th>Select</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1...</td>
<td>Navigate up one level.</td>
</tr>
<tr>
<td>Menu</td>
<td>Navigation Return to the navigation tree (area and equipment level only).</td>
</tr>
<tr>
<td>Alarms</td>
<td>List the alarms at the current level (area and equipment level only).</td>
</tr>
<tr>
<td>Properties</td>
<td>Show properties at the point level and show properties at the area and equipment levels if custom pages have been attached.</td>
</tr>
<tr>
<td>Back</td>
<td>Return to the previous page.</td>
</tr>
<tr>
<td>Go to Root</td>
<td>Return to the top of the GEO tree.</td>
</tr>
<tr>
<td>Logout</td>
<td>Log out of the WebCTRL® application.</td>
</tr>
</tbody>
</table>
To view and edit Alarms

1. Navigate to the area you want to view alarms for.
2. Select Menu.
3. Select Alarms to view all alarms at this area.
4. Select an alarm, then click OK to view or edit its details.
5. Select Actions to view a list of actions for the alarm.
6. Select the action to be done, then select OK.

<table>
<thead>
<tr>
<th>Select</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 List</td>
<td>List all alarms at the current area or equipment level.</td>
</tr>
<tr>
<td>2 Navigation</td>
<td>Return to the navigation tree.</td>
</tr>
<tr>
<td>3 Ack All</td>
<td>Acknowledge all alarms at the current level.</td>
</tr>
<tr>
<td>4 Del All Closed</td>
<td>Delete all closed alarms at the current level.</td>
</tr>
<tr>
<td>5 Del All</td>
<td>Delete all alarms at the current level.</td>
</tr>
</tbody>
</table>

To view and edit equipment properties

**NOTE** If your WebCTRL® system requires reasons for changes to equipment (page 142), you cannot edit equipment properties using WAP.

1. Navigate to a point or BACnet object to view.
2. Edit any properties in brackets.
   **NOTE** You may need to scroll down the screen to view them all.

For example, from the BACnet analog input point level, you can view the following:

<table>
<thead>
<tr>
<th>Select</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Present value for that point.</td>
</tr>
<tr>
<td>Lock</td>
<td>Locked override status for that point; True locks the present value to the At value.</td>
</tr>
<tr>
<td>At</td>
<td>Locked override value.</td>
</tr>
<tr>
<td>Alarm</td>
<td>Alarm state for that point.</td>
</tr>
</tbody>
</table>
System database maintenance

You should perform the following system maintenance on a regular basis.

To back up a system

The type of database your system uses determines the method you use to back up the system. In WebCTRL®, you can find the database type on the System Settings (page 171) > General tab.

For Apache Derby, MS Access, MSDE, or SQLServer Express

1. Shut down the SiteBuilder and WebCTRL Server applications.
2. In the WebCTRL\x.webroot folder, copy your system folder.
3. Paste the copy to a new location.
   
   **TIP** Zip the copy before transporting it over a network or to a CD.

For MySQL, MS SQL Server, Oracle, or PostGreSQL

Use the database management system's backup method.

To compact and defragment

In a new WebCTRL® system, the records in a database are contiguous. As records are added, deleted, and modified, the records become scattered in the database. This condition, called fragmentation, can slow down system performance and increase the database size. Compact the database to correct this situation.

The files on the server's hard drive can also become fragmented. Defragment the hard drive to correct this situation.

You should compact and defragment on a regular schedule such as once a month. But, you may need to do these more often, depending on how often the data or files change.

**NOTE** Compacting a database may take several minutes to several hours, depending on its size.

**TIP** To minimize the effects of fragmentation, you should maintain at least 20% free disk space on the server.

Compacting the database

MSDE, MySQL, MS SQL Server, Oracle, and PostGreSQL databases are compacted dynamically—compacting occurs in the background when a database is open.
To compact an MS Access database:
1. Shut down the SiteBuilder and WebCTRL® Server applications.
2. Click Start > Control Panel.
3. Double click Administrative Tools.
4. Double click Data Sources (ODBC).
5. On the User DSN tab, click MS Access Database, then click Configure.
6. Click Compact.
7. Under Directories, select your system’s folder under \webroot.
8. Under Database Name, select core.mdb, then click OK.
9. Under Format, select Version 4.x, then click OK.
10. When asked if you want to replace the database, click Yes.
11. When compacting finishes, click OK.
12. Repeat steps 5 - 10 to compact audit.mdb, events.mdb, and trends.mdb.

To compact a Derby database:
1. Shut down the SiteBuilder and WebCTRL® Server applications.
2. Open the computer’s Command Prompt application and type cd c:\WebCTRL#.#; replacing #.# with your system version number.
3. Click Enter.
4. Type "Derby Compression Tool.exe" <system name>.
5. Click Enter.
6. When compacting finishes, close the command window.

Defragmenting the server’s hard drive
For all database types, use a defragmentation utility such as Windows® Disk Defragmenter.

NOTE If you are using a single computer as both the WebCTRL® server and the client, you must defragment the disk more often than the disk of a dedicated server—especially if people access the Internet from this computer.

To minimize the database size
The larger a database is, the less responsive it may become. Deleting closed alarm incident groups, expired schedules, and expired historical trends on a regular basis will reduce the database size. You can set up your WebCTRL® application to automatically delete these. See "System Settings > Scheduled Tasks tab (page 176)" in WebCTRL® Help.
The WebCTRL® system can be viewed on the following client devices and web browsers.

<table>
<thead>
<tr>
<th>A computer 1 with this operating system...</th>
<th>Supports these web browsers...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows®</td>
<td>Google™ Chrome™ v23.0 or later 2</td>
</tr>
<tr>
<td></td>
<td>Internet Explorer® v8, v9, v10, or v11 Desktop</td>
</tr>
<tr>
<td></td>
<td>Mozilla® Firefox® v21.0 or later</td>
</tr>
<tr>
<td>Linux®</td>
<td>Google Chrome v23.0 or later</td>
</tr>
<tr>
<td></td>
<td>Mozilla Firefox v21.0 or later</td>
</tr>
<tr>
<td>Mac® OS X® (Apple® Mac only)</td>
<td>Safari® v6 or later 3</td>
</tr>
<tr>
<td></td>
<td>Google Chrome v23.0 or later</td>
</tr>
<tr>
<td></td>
<td>Mozilla Firefox v21.0 or later</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>A tablet with this operating system</th>
<th>Web browser</th>
<th>Tested tablets</th>
</tr>
</thead>
<tbody>
<tr>
<td>iOS</td>
<td>Safari v6 or later</td>
<td>Apple® iPad® 4, 5</td>
</tr>
<tr>
<td>Windows® RT</td>
<td>Internet Explorer® 10/11 or Metro-style Internet Explorer® 10/11</td>
<td>Microsoft® Surface 4, 5</td>
</tr>
<tr>
<td>Windows® 8 or 8.1 Pro</td>
<td>Internet Explorer® 10/11 or Metro-style Internet Explorer® 10/11</td>
<td>Microsoft® Surface™ Pro 4, 5</td>
</tr>
<tr>
<td>Android™</td>
<td>Google™ Chrome™ v23.0 or later</td>
<td>Google™ Nexus™ 7 and 10 4, 5</td>
</tr>
</tbody>
</table>

1 The client computer should have at least:
   • Dual core processor
   • 1.5 GB RAM
   • Communications link of 10 Mbps or higher

   The WebCTRL® application will work with slower computers and slower links, but the results may not be satisfactory.

2 Best performance

3 Best performance unless browser is running on a Mac® Mini or a MacBook:

   **WARNING** If machine is running Mountain Lion 10.8x with an integrated Intel HD 400 graphics card, it will experience display issues. Use one of these workarounds for better performance:
   • If an additional NVIDIA graphics card is available, manually switch the graphic card setting in MAC® OS X® to use that card.
   • If not, use Google™ Chrome™ v23.0 or later.
4 Most of the tablets listed do not support plug-ins (Java Runtime Environment, Flash, PDF reader, etc.) so some WebCTRL® add-on applications and other features may not work. The Surface Pro with IE 10 Desktop does support plug-ins.

5 Touch functionality on tablets not tested by Automated Logic® may or may not work with the WebCTRL® application. Use at your own risk.

Setting up and using a computer with the WebCTRL® system

- Set the monitor's screen resolution to a minimum of 1024 x 768 with 24- or 32-bit color quality
- You may want to disable the computer's navigation sounds.

Mac only

**NOTE** The instructions below are for a Mac OS X 10.8. Other versions may vary slightly. See your computer's Help if necessary.

<table>
<thead>
<tr>
<th>Computer settings</th>
<th>To change setting…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable right-clicking to see right-click menus:</td>
<td></td>
</tr>
<tr>
<td>On a Mac</td>
<td>1 Select <strong>System Preferences &gt; Mouse.</strong></td>
</tr>
<tr>
<td></td>
<td>2 Click the drop-down list that points to the mouse's right-click button, then select <strong>Secondary Button.</strong></td>
</tr>
<tr>
<td>On a MacBook</td>
<td>1 Select <strong>System Preferences &gt; Trackpad.</strong></td>
</tr>
<tr>
<td></td>
<td>2 Enable <strong>Secondary click.</strong></td>
</tr>
</tbody>
</table>

The instructions in Help are for a Windows computer. For instructions that include the **Ctrl** key, replace **Ctrl** with **Command**. For example, replace **Ctrl+click** with **Command+click.**

Linux only

The instructions in Help are for a Windows computer. **Alt+click** on a Windows computer is accomplished by **Ctrl+Alt+click** on a Linux computer.
Using a tablet with a WebCTRL® system

You can view your WebCTRL® system on tablets that have the following operating systems and web browsers, but some functionality may be changed or limited. Issues with each tablet are discussed below.

<table>
<thead>
<tr>
<th>Tablet operating system</th>
<th>Web browser</th>
<th>Tested tablet*</th>
</tr>
</thead>
<tbody>
<tr>
<td>iOS</td>
<td>Safari® v6 or later</td>
<td>Apple® iPad®</td>
</tr>
<tr>
<td>Windows® RT</td>
<td>Internet Explorer® 10/11 or Metro-style Internet Explorer® 10/11</td>
<td>Microsoft® Surface</td>
</tr>
<tr>
<td>Windows® 8 or 8.1 Pro</td>
<td>Internet Explorer® 10/11 or Metro-style Internet Explorer® 10/11</td>
<td>Microsoft® Surface™ Pro</td>
</tr>
<tr>
<td>Android™</td>
<td>Google™ Chrome™ v23.0 or later</td>
<td>Google™ Nexus™ 7 and 10</td>
</tr>
</tbody>
</table>

* Touch functionality of tablets not tested by Automated Logic® may or may not work with WebCTRL®. Use at your own risk.

All tablets

- To access the right-click menu for:
  - The action pane–Touch and hold the item for several seconds.
  - A tree item–Select the item first, then touch and hold the item for several seconds.

- Audible alarms do not generate a sound.

- Firefox currently has many problems supporting touch gestures on tablets.

- To clear the browser’s cache, see Setting up and using a web browser to view the WebCTRL® interface (page 165).

iPad

- Double-tap to zoom in/out.

- The Jump To feature does not work in Safari® on an iPad® due to way Safari handles JavaScript on secondary tabs.

- A WebCTRL® feature that opens a pop-up window on a computer (for example, Global Modify) will open in a new tab in Safari.

  NOTE Some of these features will present the message This site is attempting to open a pop-up window. Select Allow to continue.

- iOS restricts access to a file system so WebCTRL® features that upload or download files on a computer client are disabled on an iPad. This applies to the following configuration features:
  - Configure > Edit Existing or Add New (views, control programs, screen files, drivers)
  - Import clipping
  - System Settings > General > Source Files > Export or Import
  - System Settings > General > Logs > Download
  - System Settings > Security > Permissions > Add
  - System Settings > Daylight Saving > Import
- System Settings > Add-ons > Install Add-on
- License Administration > Browse
- Update (patches, service packs, drivers, language packs, graphics libraries, help)
- Reports saved as XLS

- iOS does not support plug-ins (Java Runtime Environment, Flash, etc.) so some WebCTRL® add-on applications will not work on an iPad.

**Microsoft Surface and Surface Pro**
- Pinch-zoom works on individual frames, instead of the whole screen. This means you can zoom and scroll the navigation pane and action pane separately.

- The Surface RT and IE 10 or 11 Metro do not support plug-ins (Java Runtime Environment, Flash, PDF reader, etc.) so the following features will not work.
  - Some WebCTRL® add-on applications
  - The Reports page PDF button
You can use the Surface Pro with IE 10 or 11 Desktop if you need these features.

- If browser text is too small, use Ctrl + to increase Internet Explorer's zoom level, then reload the page.

**Google Nexus**
- The Nexus does not support plug-ins (Java Runtime Environment, Flash, PDF reader, etc.) so the following features will not work.
  - Some WebCTRL® add-on applications
  - The Reports page PDF button

**Setting up and using a web browser to view the WebCTRL® interface**

*To set up and use Internet Explorer*

**NOTES**
- The instructions below are for Internet Explorer 9. Other versions may vary slightly. See your web browser's Help if necessary.
- If the menu bar is not visible, right-click on the window's header, and then select **Menu bar**.
<table>
<thead>
<tr>
<th>Web browser settings</th>
<th>To set in Internet Explorer...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept First-party and Third-party cookies</td>
<td>Tools &gt; Internet Options &gt; Privacy &gt; Advanced button</td>
</tr>
<tr>
<td>Automatically check for newer versions of stored pages</td>
<td>Tools &gt; Internet Options &gt; General &gt; Browsing history &gt; Settings button</td>
</tr>
</tbody>
</table>
| Load ActiveX Control | Tools > Internet Options > Security > Custom Level button. Under ActiveX controls and plug-ins, set the following:  
• Download signed ActiveX controls > Prompt  
• Download unsigned ActiveX controls > Disable  
• Run ActiveX controls and plug-ins > Enable  
• Script ActiveX controls marked safe for scripting > Enable |
| Select Play animations in web pages | Tools > Internet Options > Advanced > under Multimedia |
| Do not save passwords if the computer is used by multiple operators | Tools > Internet Options > Content > AutoComplete > Settings button |
| Disable all the options on the Explorer Bar | View > Explorer Bars |
| Disable web browser's pop-up blockers | Tools > Pop-up Blocker > Turn Off Pop-Up Blocker |
| Disable external toolbar pop-up blockers | Varies |
| Hide the web browser's toolbars | View > Toolbars |

<table>
<thead>
<tr>
<th>To...</th>
<th>Do the following...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize the web browser window</td>
<td>Press F11 on your keyboard to turn full-screen mode on\off, or use the minimize/maximize button in the top right corner of the browser window.</td>
</tr>
<tr>
<td>Have 2 different users logged in to the WebCTRL® system on the same computer</td>
<td>Start a new web browser session. Select File &gt; New Session.</td>
</tr>
</tbody>
</table>
| Clear browser cache | 1 Select Tools > Internet Options.  
2 Click Delete.  
3 If you had the WebCTRL® system saved as a Favorite, uncheck Preserve Favorites website data.  
4 Click Delete again. |
To set up and use Mozilla Firefox

**NOTES**
- The instructions below are for Mozilla® Firefox® v21.0 on a Windows operating system. Other versions may vary slightly. See your web browser's Help if necessary.
- For the first two items in the table below, Linux instructions are in parentheses. All other instructions are the same for Windows and Linux.
- If the menu bar is not visible, click in the top left corner, and then select **Options > Menu bar**.
- If a message appears in the WebCTRL® interface that includes the checkbox **Prevent this page from creating additional dialogs**, DO NOT check this box.

### Web browser settings

<table>
<thead>
<tr>
<th>Disable Pop-up blocker</th>
<th>To set in Firefox...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools &gt; Options &gt; Content &gt; uncheck Block pop-up windows</td>
<td>(In Linux: Edit &gt; Preferences &gt; Content)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enable JavaScript</th>
<th>1</th>
<th>Select Tools &gt; Options &gt; Content &gt; Enable JavaScript.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(In Linux: Select Edit &gt; Preferences &gt; Content)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Click the <strong>Advanced</strong> button to the right of Enable JavaScript, then verify the following options are checked:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Move or resize popup windows</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Raise or lower windows</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Disable or replace context menus</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Add-ons Manager</th>
<th>Select Tools &gt; Add-ons. On this page, you can enable/disable installed add-ons such as:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Adobe® Acrobat® Reader (to view PDF's)</td>
</tr>
<tr>
<td></td>
<td>• QuickTime Plug-in (to play audible alarms)</td>
</tr>
<tr>
<td></td>
<td>Only installed Firefox add-ons will show up in the list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To...</th>
<th>Do the following...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize the web browser window</td>
<td>Press F11 on your keyboard to turn full-screen mode on/off.</td>
</tr>
<tr>
<td>Clear browser cache</td>
<td>Select Tools &gt; Options &gt; Advanced &gt; Network &gt; Cached Web Content &gt; Clear Now.</td>
</tr>
<tr>
<td>Have 2 different users logged in to the WebCTRL® system on the same computer</td>
<td>Start a new web browser session. Select File &gt; New Private Window.</td>
</tr>
</tbody>
</table>
To set up and use Google Chrome

NOTES

• The instructions below are for Google™ Chrome™ v23.0. Other versions may vary slightly. See your
  web browser's Help if necessary.
• If a message appears in the WebCTRL® interface that includes the checkbox Prevent this page
  from creating additional dialogs, DO NOT check this box.

On a computer

<table>
<thead>
<tr>
<th>Web browser settings</th>
<th>To set in Chrome...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable pop-ups</td>
<td>1 Click on the browser toolbar.</td>
</tr>
<tr>
<td></td>
<td>2 Select Settings.</td>
</tr>
<tr>
<td></td>
<td>3 Click Show advanced settings.</td>
</tr>
<tr>
<td></td>
<td>4 Under Privacy, click Content settings.</td>
</tr>
<tr>
<td></td>
<td>5 Under Pop-ups, do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Select Allow all sites to show pop-ups.</td>
</tr>
<tr>
<td></td>
<td>• Click Manage exceptions. Type your system's IP address or server name in the</td>
</tr>
<tr>
<td></td>
<td>Hostname pattern field, then set Behavior to Allow.</td>
</tr>
</tbody>
</table>

To...

Do the following...

Clear browser cache

1 Click on the browser toolbar.
2 Select Tools > Clear browsing data.
3 Check the types of information that you want to remove.
4 Select a time range in the drop-down list.
5 Click Clear browsing data.

Maximize the web browser window

Press F11 on your keyboard to turn full-screen mode on/off.

Have 2 different users logged in to the WebCTRL® system on the same computer

Start a new web browser session. Click , then select New incognito window.

On a Google Nexus

<table>
<thead>
<tr>
<th>Web browser settings</th>
<th>In the Chrome menu...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn off desktop mode</td>
<td>Uncheck Request desktop site.</td>
</tr>
<tr>
<td>Disable pop-up blocker</td>
<td>Settings &gt; Advanced &gt; Content Settings &gt; uncheck Block pop-ups</td>
</tr>
<tr>
<td>Enable JavaScript</td>
<td>Settings &gt; Advanced &gt; Content Settings &gt; check Enable JavaScript</td>
</tr>
</tbody>
</table>
To set up and use Safari

**NOTES**
- The instructions below are for Safari® v6. Other versions may vary slightly. See your web browser's Help if necessary.
- We recommend that you do not run Safari in full-screen mode. If you do, WebCTRL® pop-ups will open full-screen, covering the main application window.

### On an Apple® computer (Mac®)

<table>
<thead>
<tr>
<th>Web browser settings</th>
<th>To set in Safari...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable pop-up blocker</td>
<td>Preferences &gt; Security &gt; uncheck Block pop-up windows.</td>
</tr>
<tr>
<td>Enable JavaScript</td>
<td>Preferences &gt; Security &gt; check Enable JavaScript.</td>
</tr>
<tr>
<td>Enable Plug-ins</td>
<td>Preferences &gt; Security &gt; check Enable plug-ins.</td>
</tr>
<tr>
<td>Prevent pop-ups from opening in a new browser tab</td>
<td>Preferences &gt; Tabs &gt; uncheck Command-click opens a link in a new tab.</td>
</tr>
<tr>
<td>Prevent Safari from automatically opening zip files exported from the WebCTRL® application</td>
<td>Preferences &gt; General &gt; uncheck Open &quot;safe&quot; files after downloading.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To...</th>
<th>Do the following...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear browser cache</td>
<td>History &gt; Clear History.</td>
</tr>
<tr>
<td>Have 2 different users logged in to the WebCTRL® system on the same computer</td>
<td>Start a new web browser session. Select Safari &gt; Private Browsing. Then select File &gt; New window.</td>
</tr>
</tbody>
</table>

### On an Apple® iPad

<table>
<thead>
<tr>
<th>Web browser settings</th>
<th>To set on the iPad...</th>
</tr>
</thead>
</table>
| Disable pop-up blocker | 1 In the Settings app, select Safari.  
2 Set Block pop-ups to Off. |
<table>
<thead>
<tr>
<th>Web browser settings</th>
<th>To set on the iPad...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable JavaScript</td>
<td>1 In the <strong>Settings</strong> app, select <strong>Safari</strong>.</td>
</tr>
<tr>
<td></td>
<td>2 Set <strong>JavaScript</strong> to <strong>On</strong>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To...</th>
<th>Do the following...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear browser cache</td>
<td>In the <strong>Settings</strong> app, select <strong>Safari &gt; Clear History</strong>.</td>
</tr>
</tbody>
</table>
Setting up a system in the WebCTRL® interface

System Settings

The System Settings page contains information that you must enter before the WebCTRL® application can run properly.

1. On the System Configuration tree, select System Settings.
2. Click each tab, then enter the necessary information. Tab details are described below.

General tab

The General tab presents the following system information:

- **System Directory Name**
- **Path to the Webroot Directory**
- **Database Type**
- **System Language** - The language to be used for:
  - The default language for new operators
  - Alarms logged to the database
  - State text and object names downloaded to the field
  - The login page

**NOTE** Language also refers to formatting conventions. For example, English uses the date format mm/dd/yy, but English (International) uses the date format (dd/mm/yy).

You can edit or use the following fields and buttons.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System Information</strong></td>
<td></td>
</tr>
<tr>
<td>Levels displayed in paths</td>
<td>The number of levels displayed in WebCTRL® paths. For example, if Node Name Display Depth is set at: 2, a typical path might be ..\AHU-1\RA Temp 3, a typical path might be ..\Atlanta R&amp;D\First Floor\AHU-1</td>
</tr>
<tr>
<td><strong>System Statistics</strong> button</td>
<td>Click to see the number of controllers and trends in the system.</td>
</tr>
<tr>
<td><strong>Logs</strong></td>
<td>For troubleshooting, you can download a zip file that contains logs of system activity.</td>
</tr>
<tr>
<td>Select a week of logs to review</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** Changing this field does not take effect until you restart the WebCTRL Server application.
<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Time Sync</strong></td>
<td>Click to immediately synchronize the time on all IP network controllers in the system database to the WebCTRL® server's time. Time synchronization occurs daily if the Enable time synchronization of controllers daily at field on the Scheduled Tasks tab (page 176) is enabled. (Click this link for more information on time synchronization.)</td>
</tr>
<tr>
<td><strong>Time Format</strong></td>
<td>Select one of the following for the system's time:</td>
</tr>
<tr>
<td></td>
<td>• <strong>12-hour clock</strong> (Example: 4:34 pm)</td>
</tr>
<tr>
<td></td>
<td>• <strong>24-hour clock</strong> (Example: 16:34)</td>
</tr>
<tr>
<td><strong>Date Format</strong></td>
<td>Select the format you want the system to use.</td>
</tr>
<tr>
<td><strong>Alarms</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Use a single alarm template for CMnet alarms</strong></td>
<td>If your system is an upgraded legacy system:</td>
</tr>
<tr>
<td></td>
<td>• Check to have alarms for CMnet equipment use only the alert_auto alarm template.</td>
</tr>
<tr>
<td></td>
<td>• Uncheck to allow multiple alarm templates.</td>
</tr>
<tr>
<td><strong>Enable support for Alarm Notification Clients to connect to this server</strong></td>
<td>Check to use the Alarm Notification Client application. See Alarm Popup (page 84) alarm action.</td>
</tr>
<tr>
<td><strong>Restrict to IP Address</strong></td>
<td>If the server has more than one network interface adapter, type the IP address of the server's network connection that the Alarm Notification Client application will connect to.</td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>Change this field if the Alarm Notification Client application will use a port other than 47806 on the server.</td>
</tr>
<tr>
<td><strong>Current client connections</strong></td>
<td>Shows any workstation whose Alarm Notification Client is actively connected to this server.</td>
</tr>
<tr>
<td><strong>Trends</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Keep historical trends for ___ days</strong></td>
<td>Stores trend data in the WebCTRL® database for the time you specify. This is a default setting that you can change when you set up trends for an individual point.</td>
</tr>
<tr>
<td><strong>Enable Server Trending of Color</strong></td>
<td>Leave this checked unless directed otherwise by Technical Support.</td>
</tr>
<tr>
<td><strong>Poll Interval</strong></td>
<td>The frequency that the server polls routers for color trend data. Increase this field only if Last Poll Duration exceeds the Poll Interval.</td>
</tr>
</tbody>
</table>
**Source Files**

**All Source Files**

Use to export source files to a .zip file that can be imported into another WebCTRL® or Field Assistant system. Source files include:

- Control programs (.equipment files only)
- Drivers
- Graphics (.view files only)
- Touchscreen files
- BACview® files
- Report design files for Equipment Values or Trend Sample reports

**NOTE** If import detects a difference between a database file and an import file with the same name, import does not overwrite the database file. A message lists any file differences so that you can resolve them.

See Commissioning equipment using Field Assistant.

---

**Security tab**

**Field**

**Log audit data to file**

Records operator activities and some system activities (such as opening and closing the database or automatic deletions) in a text file.

The default file is `auditlog.txt` stored in `WebCTRL\webroot\<system_name>`. You can change the file name and include a different path.

To prevent the file from growing too large as new data is appended, you can archive the data to another text file by selecting an archive frequency in the **Archive log file contents** field. The archive file is `auditlog_yyyymmdd.txt`, where `yyyymmdd` is the creation date of the archive file. This file is created in the same location as `auditlog.txt`.

**NOTE** If you do not archive the log file contents, you should manually delete the oldest entries.

**Log audit data to database**

Records audit data in a database named `audit.mdb` that can be accessed by third-party software.

**NOTE** For Access, MSDE, and Derby, the database is automatically created. An Access database is named `audit.mdb`; a MSDE database is named `audit.mdf`. The Derby database consists of multiple files in a folder called `audit`. For MySQL, SQL Server, PostgreSQL, or Oracle, you must create the database manually.
<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete database entries older than ____ days</td>
<td>Automatically deletes entries in the database that are older than the number of days you specify.</td>
</tr>
<tr>
<td>Log errors for invalid URLs</td>
<td>Check this field to write to the core.txt log any time an external source sends a request to the WebCTRL Server application.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong>  Regular maintenance scans by external software can cause the log files to grow large.</td>
</tr>
<tr>
<td>Security Policy</td>
<td></td>
</tr>
<tr>
<td>Change Policy</td>
<td>See <em>Location-dependent operator access</em> (page 138) for information on <em>Change Policy</em>.</td>
</tr>
<tr>
<td>Remote Access</td>
<td></td>
</tr>
<tr>
<td>Allow remote file management</td>
<td>Lets you access the system using WebDAV.</td>
</tr>
<tr>
<td>Operators</td>
<td></td>
</tr>
<tr>
<td>Return operators to previous locations when server reconnects</td>
<td>Returns operators to current tree locations when the server reconnects.</td>
</tr>
<tr>
<td>Log off operators after __ (HH:MM) of inactivity</td>
<td>The system automatically logs off an operator who has had no activity in the system for the time period specified.</td>
</tr>
<tr>
<td></td>
<td>This is a default setting for the system. The System Administrator can change this setting for an individual operator on the Operators page.</td>
</tr>
<tr>
<td>Lock out operators for ___ minutes after ___ failed login attempts</td>
<td>Clear Lockouts removes lockouts for all users.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong>  Restarting the WebCTRL Server application will remove lockouts.</td>
</tr>
<tr>
<td>Use advanced password policy</td>
<td>You can place specific requirements on passwords to increase security. See <em>Advanced password policy</em> (page 142).</td>
</tr>
<tr>
<td>Do not synchronize operator and privileges</td>
<td>If using hierarchical servers, the WebCTRL® application automatically synchronizes the operator/privilege settings on the child servers with those on the parent server. You have the following options:</td>
</tr>
<tr>
<td></td>
<td>• Check this field on all servers to stop the synchronization process.</td>
</tr>
<tr>
<td></td>
<td>• Check this field on a child server to remove it from the synchronization process so that you can manage that server’s settings locally.</td>
</tr>
<tr>
<td>Synchronize Now</td>
<td>Click this button on the parent server for immediate synchronization of operator/privilege settings.</td>
</tr>
</tbody>
</table>
### Permissions

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permissions</td>
<td>When control programs, views, and touchscreen and BACview® files are created by an original equipment manufacturer (OEM), they cannot be used in a WebCTRL® system without the creator's permission. However, the creator can produce a key for a system with a different license that will grant permission to the key's recipient. If you receive a key, put it in the <strong>WebCTRL X.X\resources\keys</strong> folder. The table in the Permissions section of the Security page shows all keys in the that folder. To activate a key, click <strong>Add</strong>, then browse to the key. To delete a key from your system, select the key in the table, then click <strong>Delete</strong>. Red text in the table indicates the key has a problem such as it does not apply or has expired. See the <strong>Notes</strong> column for an explanation.</td>
</tr>
</tbody>
</table>

### Communications tab

The fields on this tab let you define controller communication with the WebCTRL Server application and BACnet network communication.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebCTRL Server BACnet Controller Instance and BACnet Alarm Recipient Instance</td>
<td>The BACnet identifier for the system's server and the alarm recipient. You enter these system properties in SiteBuilder.</td>
</tr>
<tr>
<td>Always upload properties from controllers to WebCTRL database on mismatch</td>
<td>Automatic uploads are listed in the Audit Log. If you do not check this field, properties must be manually uploaded or downloaded by the operator when a mismatch occurs. <strong>NOTE</strong> If an automatic upload fails and the operator chooses to do nothing at that time, the upload will be attempted again when he returns to the page where he encountered the mismatch.</td>
</tr>
<tr>
<td>Ignore incoming alarms from sources not in this database</td>
<td>The WebCTRL® application will ignore alarms from third-party devices not in the database or devices from other WebCTRL® systems on the same network.</td>
</tr>
<tr>
<td>BACnet Settings</td>
<td>Native WebCTRL® system only</td>
</tr>
<tr>
<td>Log BACnet Binding Conflicts</td>
<td>The WebCTRL® application uses BACnet (dynamic) binding for communication between devices unless your system uses NAT routing. If using NAT, the WebCTRL® application uses information in its database to bind to BACnet devices. When checked, the WebCTRL® application logs binding conflicts that result from duplicate network numbers or device IDs.</td>
</tr>
</tbody>
</table>
Scheduled Tasks tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatically delete alarm incident groups which have been closed for more than ___ days</strong></td>
<td>An incident group is all alarms related to a particular incident, such as Off Normal, Fault, and Return to Normal. <strong>NOTE</strong> Alarms in an incident group are not deleted until all alarms in the group have been closed.</td>
</tr>
<tr>
<td><strong>Archive alarm information upon alarm deletion</strong></td>
<td>Writes alarm information to a text file.</td>
</tr>
<tr>
<td><strong>Archive file</strong></td>
<td>The default file is <code>eventdel.txt</code> stored in <code>WebCTRL\webroot\&lt;system_name&gt;</code>. You can change the file name and include a different path.</td>
</tr>
<tr>
<td><strong>Archive file format</strong></td>
<td>The alarm information to be written to the archive file. To add information, select field codes in Append Field Code. To delete field codes, highlight them in the Archive file format box and press Delete.</td>
</tr>
<tr>
<td><strong>Automatically delete expired schedules daily at ___</strong></td>
<td>To ensure there are no time zone conflicts, the WebCTRL® application waits 2 days after a schedule expires to delete it.</td>
</tr>
<tr>
<td><strong>Remove expired historical trends daily at ___</strong></td>
<td>Deletes trend data that has been in the database longer than then time you specified in the previous field.</td>
</tr>
<tr>
<td><strong>Enable time synchronization of controllers daily at ___</strong></td>
<td>Automatically synchronizes the time on all equipment to the time on the server, adjusting for different time zones and Daylight Saving Time. We recommend that you check this field. The WebCTRL® application will send a daily time sync message to each IP network device that is in the system database. IP devices not in the database will not be synchronized. For all ARC156 or MS/TP networks in the database, the WebCTRL® application will send a broadcast time sync message. All devices on these networks will be synchronized, regardless of whether or not the devices are in the database.</td>
</tr>
</tbody>
</table>

**CAUTIONS**

- Make sure that your server’s time and time zone setting are correct.
- Make sure that each site’s time zone setting in SiteBuilder is correct.
- To prevent time sync problems when the transition to and from Daylight Saving Time occurs, set the time sync to occur at least 1 hour after the last controller in the system is adjusted for DST. For example, your server and part of your system is in the Eastern Standard Time zone, but you also have controllers in the Pacific Time zone. Your server is adjusted for DST at 2:00 a.m. Eastern Standard Time, but the controllers in the Pacific Time zone are not adjusted until 3 hours later. So you would set the time sync to occur daily at 6:00 a.m. or later.
<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTES</strong></td>
<td>You can disable this function for an individual site on the site’s Properties page. See <em>To set up site properties</em> (page 179).</td>
</tr>
<tr>
<td></td>
<td>You can perform system-wide time synchronizations using the <strong>Time Sync</strong> button on the <strong>General tab</strong> (page 171). Or, you can synchronize individual devices using the <strong>Time Sync</strong> button on the devices Properties page.</td>
</tr>
<tr>
<td></td>
<td>Between time sync broadcasts, Automated Logic® routers include time sync information in each color request to the devices below the router. This ensures devices without a battery-backed clock will get the time shortly after powering up.</td>
</tr>
</tbody>
</table>

**Daylight Saving tab**

On this tab, you can adjust the Daylight Saving Time settings for WebCTRL Server.

Click **Update** to automatically set the table's **Begin** and **End** dates for the next 10 years based on the system’s timezone. This marks all controllers with ExecB drivers for a Parameters download.

**If the updated dates are incorrect**

If you clicked **Update** but the dates are incorrect, your system's Java timezone data may be out-of-date. Do the following:

1. Go to the *Oracle Java SE Download site* ([http://java.sun.com/javase/downloads](http://java.sun.com/javase/downloads)).
2. Download the **JDK DST Timezone Update Tool** (*tzupdater.zip*).
3. In the WebCTRL® interface, go to **System Settings > Daylight Saving**, then click **Import**.
4. Browse to the *tzupdater.zip* file, select it, then click **Open**.
5. Click **Continue**.
6. Restart the WebCTRL Server application.
7. On the **System Settings > Daylight Saving** tab, click **Update**.

**NOTE** If you have sites in different time zones that use Daylight Saving Time, you can click **View DST Dates** on the site's **Properties** page to see DST information and time change dates.

**Add-ons tab**

A WebCTRL® system supports add-ons, such as EnergyReports, that retrieve and use the WebCTRL® data.

**To install an add-on**

1. Save the add-on's file (.addon or .war) to your computer.
2. On the **System Settings > Add-ons** tab, click **Browse**, and then open the file.
3. Click **Install**. After a few seconds, the add-on will appear in the **Installed** table, and will be enabled. The table below gives a description of each column.

<table>
<thead>
<tr>
<th>Column</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The add-on's name.</td>
</tr>
<tr>
<td>Path</td>
<td>To open the add-on in a web browser, append this path to your</td>
</tr>
<tr>
<td></td>
<td>WebCTRL® system's address.</td>
</tr>
<tr>
<td></td>
<td>For example, to open EnergyReports, type:</td>
</tr>
<tr>
<td></td>
<td>http://&lt;system_name&gt;/EnergyReports, or</td>
</tr>
<tr>
<td></td>
<td>http://&lt;system_IP_address&gt;/EnergyReports</td>
</tr>
<tr>
<td>Version</td>
<td>The version is shown if the author provided the information in the</td>
</tr>
<tr>
<td></td>
<td>add-on.</td>
</tr>
<tr>
<td>Status</td>
<td>If this column shows:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Running</strong>, you can open the add-on in a web browser.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Disabled</strong>, click <strong>Enable</strong> to run the add-on.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Startup error</strong>, select the table row to see an</td>
</tr>
<tr>
<td></td>
<td>explanation of the error under <strong>Details</strong>.</td>
</tr>
</tbody>
</table>

4. Select an add-on in the **Installed** table to disable or enable it, or to see the following **Details**.

<table>
<thead>
<tr>
<th>Add-on main page</th>
<th>Click the main page link to open the add-on, if the author provided a main page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>A description of the add-on, if the author provided one</td>
</tr>
<tr>
<td>Vendor Name</td>
<td>The add-on's author</td>
</tr>
<tr>
<td>Public Data Directory</td>
<td>This public directory contains data generated by the add-on. This data is visible in a web browser.</td>
</tr>
<tr>
<td>Private Data Directory</td>
<td>This private directory contains information such as configuration data.</td>
</tr>
</tbody>
</table>

**To back up the add-on’s private and public data directories**

**NOTE** This procedure will not back up data stored in an external database. For example, EnergyReports uses an external database.

1. Select the add-on in the table.
2. Click **Save Data**.
3. Click **OK**.
4. Click **Save**.
5. Select the location where you want to save the data, then click **Save**.
To update an add-on

NOTE Add-ons for WebCTRL® v6.0 or later systems have a different folder structure than previous versions.

1. Select the add-on in the table.
2. Click Remove Add-on and Keep Data
3. Follow the procedure above to install the new version of the add-on.

To uninstall an add-on
1. Select the add-on in the table.
2. Click Remove Add-on and Data.

To set up site properties

1. On the Network tree, select the site.
2. Click Properties.
3. Configure site properties.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Timesync</td>
<td>Daily synchronizes the time in the site's controllers with the server's time, adjusting for different time zones and Daylight Saving Time. Synchronization occurs each day at the time specified in the field Enable time synchronization of controllers daily at on the System Settings &gt; Scheduled Tasks (page 176) tab.</td>
</tr>
<tr>
<td>View DST Dates</td>
<td>If the site's time zone (set in SiteBuilder) uses Daylight Saving Time, you can click View DST Dates to see DST information and time change dates.</td>
</tr>
<tr>
<td>Group Cache Controller</td>
<td>The designated router where colors are cached when peer caching is enabled in SiteBuilder.</td>
</tr>
</tbody>
</table>

To register your WebCTRL® software

To register your software, you must obtain a registered license from Automated Logic® and then apply it in the WebCTRL® interface. You can apply it when you install the software or at a later time.

2. Select Support > Software Licenses > WebCTRL 2.5 and later (BAS License Manager).
3. Select filter criteria to narrow the list of licenses, then click Filter in the upper right-hand corner.
4. Select the appropriate row.
5. Fill in the blank fields in the License Registration Area.
6 Click **Register License**.
7 Check **I agree to the terms of use**.
8 Click **Download License**, then save the license file to a disk or to your hard drive.
9 Apply your license:
   ○ During the WebCTRL® installation—The installation requests the location of your license file. Browse to location where you saved it in step 4 above.
   ○ After the installation—
     a. On the WebCTRL® **System Configuration** tree, select **License Administration**.
     b. Browse to the license file.
     c. Click **Apply**.
     d. Restart the WebCTRL Server application.

**NOTES**
- Do not edit any part of this registered license file. Editing a license file invalidates the license.
- Store the license in a safe location.

To replace the license when adding features
You can add any of the following optional WebCTRL® packages to your system:
- Advanced security: Location-dependent operator access, configurable password policies, and required operator comments/verification for system changes
- Advanced reporting: Custom reports
- Advanced Alarming: Additional alarm actions

You can purchase an optional package at http://orders.automatedlogic.com. Select **Options** under **Software Products**.

To obtain an updated license and then apply it in the WebCTRL® interface:
2 Select **Support > Software Licenses > WebCTRL 2.5 and later (BAS License Manager)**.
3 Select filter criteria to narrow the list of licenses, then click **Filter** in the upper right-hand corner.
4 Select the appropriate row.
5 Check **I agree to the terms of use**.
6 Click **Download License**, then save the license file to a disk or to your hard drive.
7 To replace your license, on the WebCTRL® **System Configuration** tree, select **License Administration**.
8 Browse to the license file.
9 Click **Apply**.
10 Restart the WebCTRL Server application.

💡 **TIP**  Back up your system (page 160) before replacing your license.
Adding links or text to the WebCTRL® login page

You can add links or text, such as a disclaimer, to the login page.

To add links to the login page

1. In a text editor such as Notepad, type 2 lines for each link that you want on the login page.
   Line 1: link#.text=<the link text that is to appear on the login page>
   Line 2: link#.url=<the link's address>

   **NOTE** link#.text and link#.url must be lowercase.

Example to add links shown above:
2  Save the file with the following name and location.
   File name: extra_login_links.properties
   Location:  WebCTRLx.x\webroot\<system_name>

To add text to the login page

1  In a text editor such as Notepad, type the text that you want on the login page.

Example to add text shown above:

2  Save the file with the following name and location.
   File name:  legal_disclaimer.txt
   Location:  WebCTRLx.x\webroot\<system_name>
Editing a system remotely

Editing the Geographic or Network tree

In the WebCTRL® interface, you can edit the Geographic or Network tree that was originally set up in SiteBuilder. The system database is updated immediately.

Right-click an item on the Geographic tree, then select Set up Tree. Click Geographic or Network to display the tree you want to edit.

<table>
<thead>
<tr>
<th>Click this button...</th>
<th>Or use this shortcut...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="add.png" alt="Add Area" /></td>
<td></td>
<td>Add an area as a child of the selected area. (Geographic tree only)</td>
</tr>
<tr>
<td><img src="import.png" alt="Import" /></td>
<td></td>
<td>Import a clipping that was saved in SiteBuilder. See To import a clipping (page 184) below.</td>
</tr>
<tr>
<td><img src="cut.png" alt="Cut" /></td>
<td>Ctrl+X</td>
<td>Cut a selected item so it can be pasted in another location in the tree. (Geographic tree only)</td>
</tr>
<tr>
<td><img src="paste.png" alt="Paste" /></td>
<td>Ctrl+V</td>
<td>Paste an item that was previously cut from another location in the tree. The item will be pasted as a child to the selected item. (Geographic tree only)</td>
</tr>
<tr>
<td><img src="move-up.png" alt="Move Up" /></td>
<td>Up arrow, or Drag and drop in new location</td>
<td>Move the selected item up the tree to a new location. (Geographic tree only)</td>
</tr>
<tr>
<td><img src="move-down.png" alt="Move Down" /></td>
<td>Down arrow, or Drag and drop in new location</td>
<td>Move the selected item down the tree to a new location. (Geographic tree only)</td>
</tr>
<tr>
<td><img src="rename.png" alt="Rename" /></td>
<td></td>
<td>Rename the selected item.</td>
</tr>
<tr>
<td><img src="delete.png" alt="Delete" /></td>
<td></td>
<td>Delete the selected item. The item and all of its children will be deleted.</td>
</tr>
<tr>
<td><img src="edit.png" alt="Edit" /></td>
<td>Double-click the tree item</td>
<td>Edit the item's features such as:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• names</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• view—See To attach a graphic in the WebCTRL® interface (page 35)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• control program—See Working with control programs in the WebCTRL® interface (page 190)</td>
</tr>
</tbody>
</table>
CAUTIONS

• Make a backup of your system before making changes.
• Make changes carefully as they cannot be undone.

NOTES

• You can also right-click items in the Set up Tree dialog box to perform the above tasks.
• You can perform some of the above actions on multiple tree items simultaneously. Use Ctrl+click, Shift+click, or both to select multiple items.

To import a clipping

You can export a clipping (a portion of a system) in SiteBuilder and then import it in the WebCTRL® interface. The following items are imported:

• One or more selected Geographic and Network tree items including attached control programs, graphics, and drivers
• Reports
• Trend data (if included in the clipping)
• Alarm templates and categories
• Location-dependent security information
• Schedules and schedule group membership (including the entire schedule group and schedules, if it does not exist in the target system)
• Alarm actions
• Alarm message prefixes and suffixes
• Source tree relationships (including source tree rules if the source tree does not exist in the target system)

To import a clipping:

1 Right-click an item on the Geographic tree, then select Set up Tree.
2 Click the Import clipping button .
3 Browse to and select the clipping you want to import, then click Next.
4 Optional: If necessary, you can change the location path where the clipping will be imported. Select the system fragment, then select the import location in the tree below.
5 Click Next.
6 If asked if you want to replace event templates, follow the on-screen instructions.
7 If asked if you want to overwrite components, follow the on-screen instructions.
8 The interface shows any conflicts and problems that were found during the import. Make any needed corrections in SiteBuilder.
   NOTE Click Copy to Clipboard and then paste the list into another program such as Notepad for viewing or printing.
9 Click Next.
10 Click Finish.
Do any of the following that apply.

<table>
<thead>
<tr>
<th>If you Imported...</th>
<th>Do the following in the SiteBuilder application...</th>
<th>Do the following in the WebCTRL® application...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Another site into the system</td>
<td>Change the new site's BACnet/IP network number to be the same as the other BACnet/IP network(s).</td>
<td>Download All Content to all Automated Logic® IP routers in the system.</td>
</tr>
</tbody>
</table>

XYZ system
- Site #1
  - BACnet/IP (A=2400)
- Site #2
  - BACnet/IP (A=2406)

Change this address to 2400

A second BACnet/IP network into a site
Move the items under the new network to the original BACnet/IP network, then delete the new network.

XYZ System
- Site
  - BACnet/IP #1
    - LGR1000
      - Driver
    - ARC156
  - BACnet/IP #2
    - LGR250
      - Driver
    - ARC156

Any controllers that use the SiteBuilder option

Automatically Configure My BBMDs
N/A
Download BBMDs to the routers.

Any controllers that use manually configured BBMD tables
N/A
Update the routers' BBMD tables. See "To set up BBMD's through the WebCTRL® interface" or "To set up BBMD's using the BBMD Configuration Tool" in WebCTRL® Help.

A clipping without trends into a system using NAT
N/A
Restart IP connection(s) to new devices.
Managing files on a remote WebCTRL® server

A WebCTRL® system supports WebDAV, a network protocol designed for managing remote server files through an Internet connection. Use a third-party WebDAV client application, such as WebDrive, to access the Internet from anywhere in the world and manage your system files residing on a distant WebCTRL® server.
Running WebCTRL Server as a Windows® service

Run WebCTRL Server as a Windows service if you want WebCTRL Server to automatically start up when the server computer is restarted.

**NOTE** If your WebCTRL® system uses a non-MS Access database located on the same computer as WebCTRL Server, you must set up Windows to delay starting WebCTRL Server until the database service has started. See "How to delay loading of specific services" (http://support.microsoft.com/kb/193888) on the Microsoft® website.

To install WebCTRL® Server service

**NOTE** If you think the service was previously installed, see To determine if WebCTRL Server service is installed (page 189).

On Windows 2003 and XP

1. In the WebCTRL® server's Start menu, select Run (or the Search programs and files box in Windows 7).
2. Browse to the WebCTRLx.x folder, select WebCTRL Service.exe (the service install file), then click Open.
3. Click OK.

On Windows 7, Vista, 2008, and 2008 R2

1. In the Windows Start menu, right-click Command Prompt, then select Run as administrator.
2. Select Yes in the User Account Control message.
3. In the Command Prompt window, type: cd <path to the WebCTRL install directory>
   For example, type: cd c:\WebCTRL#.#, replace #.# with your current version number.
4. Press Enter.
5. Type: "WebCTRL Service.exe" -install
6. Press Enter.
To start WebCTRL® Server as a Windows service

1. Click the Windows Start button, then select Control Panel.
2. Double-click Administrative Tools, then Services.
3. In the Services (Local) list, double-click WebCTRL.
4. In the WebCTRL Properties dialog box, select Automatic in the Startup type drop-down list.
5. Optional: If you want to be able to access WebCTRL Server on the server computer's desktop, check Allow service to interact with desktop on the Log On tab.

**NOTES**
- If you do not check this field, the computer screen will give no indication that WebCTRL Server is running; you must view the computer's Services page to see if it is running.
- This checkbox applies only to a user logged in on the server. A Windows Remote Desktop user cannot access WebCTRL Server running as a service.
- If you check this field, you cannot use the instructions below to set up printing to a network printer. Ask your Network Administrator to set up Local System account to use a network printer.
- If you check this field and the WebCTRL® application is to run email alarm actions, ask your Network Administrator to set up Local System account to send emails.

6. Click Start.
7. Click OK.

**NOTES**
- To shut down the WebCTRL service, return to the WebCTRL Properties dialog box and click Stop.
- If WebCTRL Server does not start after you click Start, you may have a Windows permissions problem. Follow the procedure below in To set up the WebCTRL service for network printing (page 188) to set up the Windows user name and password.

To set up the service for network printing

If WebCTRL Server runs as a service on a computer that is using a network printer, you must set up the Windows user name and password for the service. The Print alarm action requires this setup to be able to print.

1. Open the Windows Control Panel.
2. Select Administrative Tools > Services.
3. Double-click WebCTRL Service x.x.
4. On the Log On tab, select This account.
5. Browse to the computer's domain, then select the user that the service will log in as.
   **NOTE** Contact your network administrator if you need help determining the domain.
6. Type the user's password in the Password and Confirm password fields.
To remove WebCTRL® Server service

On Windows 2003 and XP
1. In the WebCTRL® server’s Start menu, select Run (or the Search programs and files box in Windows 7).
2. Browse to the WebCTRLx.x folder, select WebCTRL Service.exe (the service install file), then click Open.
3. At the end of the path, type: <space>-remove
   EXAMPLE "c:\WebCTRLx.x\WebCTRL Service.exe" -remove
4. Click OK.

On Windows 7, Vista, 2008, and 2008 R2
1. In the Windows Start menu, right-click Command Prompt, then select Run as administrator.
2. Select Yes in the User Account Control message.
3. In the Command Prompt window, type: cd <path to the WebCTRL install directory>
   For example, type: cd c:\WebCTRLx.x
4. Press Enter.
5. Type: "WebCTRL Service.exe" -remove
6. Press Enter.

To determine if WebCTRL® Server service is installed
If you do not know if the service was previously installed, follow the appropriate steps below.

On Windows 2003 and XP
1. From the Windows Start menu, open Command Prompt.
2. In the Command Prompt window, type: cd <path to the WebCTRL install directory>
   For example, type: cd c:\WebCTRLx.x
3. Press Enter.
4. Type: "WebCTRL Service.exe" -check
5. Press Enter.

On Windows 7, Vista, 2008, and 2008 R2
1. In the Windows Start menu, right-click Command Prompt, then select Run as administrator.
2. Select Yes in the User Account Control message.
3. In the Command Prompt window, type: cd <path to the WebCTRL install directory>
   For example, type: cd c:\WebCTRLx.x
4. Press Enter.
5. Type: "WebCTRL Service.exe" -check
6. Press Enter.
A control program is typically defined in SiteBuilder when the system is engineered, but you can do the following in the WebCTRL® interface. These changes require you to download All Content (page 47) to the controller.

- Add a control program to a controller (page 190)
- Replace an existing control program (page 191)
- Reload a revised control program located in `webroot\<system>\programs`.

On the WebCTRL® Geographic tree, right-click the equipment, then select Reload Control Program. Reloading updates all instances of a control program throughout the system and marks the controller(s) for an All Content download.

**NOTE** If you change a control program in the EIKON® application and it does not display correctly in the WebCTRL® interface, Ctrl+right-click the WebCTRL® action pane, and then select Refresh.

### To add a control program to a controller

1. Select the controller on the WebCTRL® Network tree.
2. On the Devices page > Manage tab, click the Add Control Program button.
3. Type a Display Name for the control program.
4. Select the Controller that you are adding the program to.
5. Optional: You can change the control program’s Reference Name if needed.
6. Optional: You can select a different Icon.
7. Do one of the following:

<table>
<thead>
<tr>
<th>If the control program is...</th>
<th>In the Control Program drop-down list</th>
<th>Select the control program.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not in the Control Program drop-down list</td>
<td>a. Click Add New.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. Browse to select the control program.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. Click Open.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>d. Click Continue.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>e. Click Close.</td>
<td></td>
</tr>
</tbody>
</table>

8. Optional: Check Require operator to record any changes to control program. See Recording reasons for edits (21 CFR Part 11) (page 142).
9. Click **Accept**.

10. **Download All Content (page 47)** to the controller.

**NOTES**

- You can click **Delete Unused** in the **Control Programs** section to delete all unattached control programs and any supporting files with the same name from the **programs** folder.
- In the **Add Control Program** dialog box, you can also attach or remove a .view file that will be displayed in the WebCTRL® interface for the control program.

**To replace an existing control program**

1. Right-click the control program on the WebCTRL® navigation tree, then select **Configure**.

2. The following steps are optional:
   a) Change the **Display Name** for the control program.
   b) Change the control program’s **Reference Name** if needed.
   c) Select a different **Icon**.

3. If the system has other control programs of this type, select which control programs you want to change.

   - **Change this control program only.**
   - **Change for all control programs of this type on this network only.**
   - **Change for all control programs of this type.**

**NOTES**

- If you are changing an IP router’s control program, the second option will change all control programs of this type only on the IP network.
- If you are changing a control program on the network below an IP router, the second option will not change control programs of this type in the router.

4. Do one of the following:

   **If the control program is...**

<table>
<thead>
<tr>
<th>In the <strong>Control Program</strong> drop-down list</th>
<th>Select the control program.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not in the <strong>Control Program</strong> drop-down list</td>
<td>a. Click <strong>Add New</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Browse to select the control program.</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Open</strong>.</td>
</tr>
<tr>
<td></td>
<td>d. Click <strong>Continue</strong>.</td>
</tr>
<tr>
<td></td>
<td>e. Click <strong>Close</strong>.</td>
</tr>
</tbody>
</table>

5. Optional: Check **Require operator to record any changes to control program**. See **Recording reasons for edits (21 CFR Part 11)** (page 142).

6. Click **Accept**.

7. **Download All Content (page 47)** to the controller.
NOTES

- You can click **Delete Unused** in the **Control Programs** section to delete all unattached control programs and any supporting files with the same name from the **programs** folder.
- In the **Add Control Program** dialog box, you can also attach or remove a .view file that will be displayed in the WebCTRL® interface for the control program.

To edit a control program

On a WebCTRL® client, you can get a copy of a control program from the server, edit it, then put it back on the server.

**To get the control program**

1. Right-click the equipment on the WebCTRL® **Geographic** or **Network** tree, then select **Configure**.
2. In the **Control Programs** section, click **Edit Existing**.
3. Click **Save as**.
4. Browse to the folder you want to put the file in.
5. Click **Save**.
6. Click **Close**.

**To put the edited control program back on the server**

1. Right-click the equipment on the WebCTRL® **Geographic** or **Network** tree, then select **Configure**.
2. In the **Control Programs** section, click **Add New**.
3. Browse to select the control program.
4. Click **Open**.
5. Click **Continue**.
6. Click **Close**.
7. Click **Close** again.
Working with drivers in the WebCTRL® Interface

A controller's driver is defined in SiteBuilder when the system is engineered, but you can make the following changes in the WebCTRL® interface.

- Change the driver settings. See "Setting up the driver" in the controller's Technical Instructions.
- Change or upgrade a driver. See topic below.
- Reload a driver if it becomes corrupt (for example, a driver page is missing in the WebCTRL® interface). On the WebCTRL® Network tree, right-click the controller or driver, then select Reload Driver. Reloading updates all instances of the driver throughout the system and marks the controller(s) for an All Content download. Changes you made on the driver pages in the WebCTRL® interface remain in effect.

After you make these changes, you must download All Content (page 47) to the affected controller(s).

NOTE You can also make these changes in SiteBuilder. See "To change or upgrade a driver" in SiteBuilder Help.

To change or upgrade a driver

1. On the WebCTRL® Network tree, right-click the controller, then select Configure.
2. If other controllers in the system use this driver, select which controllers you want to change.
   - This controller only
   - All controllers on this network that use same driver version
   - All controllers in the system that use same driver version
3. Do one of the following:
   
   **If the driver is...**

   | In the Driver Version drop-down list | a. Select the driver.  
   | b. Click Accept. |  
   | Not in the Driver Version drop-down list | a. Click Add.  
   | b. Browse to select the driver.  
   | c. Click Open.  
   | d. Click Continue.  
   | e. Click Close.  
   | f. Click Close again. |
4  Download All Content (page 47) to the controller.

**NOTE** You can click Delete Unused in the Controller section to delete all unused drivers in WebCTRLx.webroot\<system_name>\drivers.
To use a touchscreen device or BACview® device to view or edit a controller's property values, you must download a screen file (.touch, .bacview, .S37, or .kpd) to the controller. The screen file is typically defined in SiteBuilder and downloaded with the initial download to the controller, but you can select a different file in the WebCTRL® interface.

To select a different screen file

1. On the WebCTRL® Network tree, right-click the controller, then select Configure.
2. If other controllers in the system use the current screen file, select which controllers you want to change.
   - This controller only
   - All controllers on this network that use the same screen file
   - All controllers in the system that use the same screen file
3. Do one of the following:

<table>
<thead>
<tr>
<th>If the screen file is...</th>
<th>a. Select the file.</th>
<th>b. Click Accept.</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the Screen file drop-down list</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Not in the Screen file drop-down list</td>
<td>a. Click Add.</td>
<td>b. Browse to select the screen file.</td>
</tr>
</tbody>
</table>
4. Download All Content (page 47) to the controller.

**NOTE** You can click Delete Unused in the Screen File section to delete all unused screen files in:

- WebCTRLx\webroot\<system_name>\views
- WebCTRLx\webroot\<system_name>\programs
To edit a screen file on a WebCTRL® client
On a WebCTRL® client, you can get a copy of a screen file from the server, edit it, then put it back on the server.

To get the screen file

1. On the WebCTRL® Network tree, right-click the controller that uses the screen file, then select Configure.
2. Under Screen File, click Edit.
3. Click Save as.
4. Browse to the folder you want to put the file in.
5. Click Save.
6. Click Close.

To put the edited file back on the server

1. On the WebCTRL® Network tree, right-click the controller that uses the screen file, then select Configure.
2. Under Screen File, click Add.
3. Browse to select the file.
4. Click Open.
5. Click Continue.
6. Click Close.
7. Click Close again.
Setting up a system for non-English languages

English is the WebCTRL® default language, but you can set up your system to display a different language. You can also set up multiple languages so different operators can view the system in different languages.

Follow the procedures below to display the WebCTRL® interface in non-English languages.

1. Install a language pack (page 197).
2. Prepare your workstation for non-English text (page 197).
3. Create control programs and translation files (page 199).
4. Create graphics (page 201).
5. Create your system in SiteBuilder (page 203).
6. Set an operator's language in the WebCTRL® interface (page 204).

Installing a language pack

A language pack translates the text in the WebCTRL® interface. A WebCTRL® system is installed with an English language pack. To download other language packs:

2. Under Software Updates, select v# Language Packs, where # is your WebCTRL version.
3. Select the language you want.
4. Follow the instructions under To install this language pack.

NOTE If you create a system by copying an existing system that uses language packs, install the same language packs on the new system.

Preparing your workstation for non-English text

NOTE The instructions below are for a Windows XP operating system. If you have a different operating system, see your system's Help for instructions.

Set up your workstation so you can type international characters in control programs, graphics, or SiteBuilder.

1. Install the appropriate fonts for the languages you will be using. In the Windows Control Panel, open Fonts, select File > Install new fonts.
2. In the Control Panel, open Regional and Language Options, then select the Input language.
3 Install an Input Method Editor (IME) for non-alphanumeric characters.

See your operating system's Help for more information.
Creating control programs and translation files for a non-English system

To have the WebCTRL® interface display a control program’s user-defined text (such as microblock names and property text) in a non-English language, you must:

1. Create the control program using key terms instead of the text.
2. Create translation files of key terms and their language-specific equivalents.

In the WebCTRL® interface, the key term is replaced with its equivalent in the translation file for the current operator language. If a WebCTRL® Properties page, Logic page, or graphic shows ??key term??, the key term is missing from the translation file.

NOTES
- You also use key terms and translation files with graphics that you created with WebCTRL® extensions for FrontPage (page 201).
- To edit existing control programs or translation files, see Editing translation files, control programs, or graphics (page 204).

To enter a key term in the EIKON® application

In the EIKON® Property Editor, type @ before each key term.

Property Page Text

Show Property Page Text

@This_value

NOTES
- Type only the key term in the EIKON® application. Expressions such as $present_value$ are put in the translation file as part of the translated text. See EXAMPLES in "Translation files" below.
- Key terms can contain only alphanumeric characters and underscores (no spaces) and cannot start with a number.

Translation files

Translation files are used to translate key terms in control programs and graphics created with WebCTRL® extensions for FrontPage (page 202). A translation file contains key terms and their language-specific equivalents.

For a non-English system, you must create an English translation file and a non-English translation file* for each of the following:

- Each control program
- Key terms used in multiple control programs
- Each graphic created with WebCTRL® Extensions for FrontPage
- Key terms used in multiple graphics
EXAMPLES

<table>
<thead>
<tr>
<th>Translation files</th>
<th>Key term=Language-specific equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>This_value=This value is $present_value$ Zone_temp=Zone temperature</td>
</tr>
<tr>
<td>Spanish</td>
<td>This_value=Este valor es $present_value$ Zone_temp=Temperatura de zona</td>
</tr>
</tbody>
</table>

*If the WebCTRL® interface will display multiple non-English languages, create a translation file for each language.*

To create and implement a translation file

Create your translation file in a text editor, such as Microsoft® Word, that supports the character encoding you need.

1. Type one key term and language equivalent per line, left justified, starting in column 1. Do not put spaces on either side of the equal sign.

2. Save the file using the appropriate file name and location in the table below.

<table>
<thead>
<tr>
<th>If key terms are used in...</th>
<th>the file name is...</th>
<th>File location</th>
</tr>
</thead>
<tbody>
<tr>
<td>A single control program</td>
<td>&lt;any_name&gt;._xx.native*</td>
<td>Any location</td>
</tr>
<tr>
<td>Multiple control programs</td>
<td>equipment_xx.native*</td>
<td>WebCTRL\webroot\&lt;system_name&gt;\resources</td>
</tr>
<tr>
<td>A single graphic</td>
<td>&lt;graphic_name&gt;._xx.native*</td>
<td>WebCTRL\webroot\&lt;system_name&gt;\graphics\vl5</td>
</tr>
<tr>
<td>Multiple graphics</td>
<td>translations_xx.native*</td>
<td>WebCTRL\webroot\&lt;system_name&gt;\resources</td>
</tr>
</tbody>
</table>

* xx = the language extension code. See "Extension codes and encoding" below.

If you are using:
○ the English character set, save the file as Text only.
○ a non-English character set, save the file as Encoded text. (See your application’s help for information on saving files as encoded text.) When prompted for the language and encoding, see “Extension codes and encoding” below.

3. Open the control program in the EIKON® application, then select **Control Program > Bundled Resources**.

4. Click , locate and select the translation file(s) for this control program, then click **Open**.

**NOTES**
○ Do not add equipment_xx.native files that you created for multiple control programs.
○ You can use **Ctrl+click** or **Shift+click** to select multiple files.

5. Save the control program. The translation files are embedded in the control program; the original files are no longer necessary.
### Extension codes and encoding

<table>
<thead>
<tr>
<th>Language</th>
<th>Extension codes</th>
<th>Encoding*</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>_en</td>
<td>ISO-8859-1</td>
</tr>
<tr>
<td>French</td>
<td>_fr_FR</td>
<td>ISO-8859-1</td>
</tr>
<tr>
<td>German</td>
<td>_de</td>
<td>ISO-8859-1</td>
</tr>
<tr>
<td>Japanese</td>
<td>_ja</td>
<td>EUC-JP</td>
</tr>
<tr>
<td>Korean</td>
<td>_ko</td>
<td>EUC-KR</td>
</tr>
<tr>
<td>Russian</td>
<td>_ru</td>
<td>KOI8_R</td>
</tr>
<tr>
<td>Spanish</td>
<td>_es</td>
<td>ISO-8859-1</td>
</tr>
<tr>
<td>Swedish</td>
<td>_sv</td>
<td>ISO-8859-1</td>
</tr>
<tr>
<td>Simplified Chinese</td>
<td>_zh</td>
<td>GB2312</td>
</tr>
<tr>
<td>Traditional Chinese</td>
<td>_zh_TW</td>
<td>Big5</td>
</tr>
<tr>
<td>Thai</td>
<td>_th</td>
<td>TIS620</td>
</tr>
<tr>
<td>Vietnamese</td>
<td>_vi</td>
<td>Cp1258</td>
</tr>
</tbody>
</table>

* Encoding is used when you create the translation file.

### Creating graphics for a non-English system

Use ViewBuilder to create graphics for a single language system.
Use WebCTRL® extensions for FrontPage to create graphics for a multi-language system.

### Creating a non-English graphic in ViewBuilder

**NOTES**
- The names of your .view file and any inserted image files must contain only ASCII characters.
- Graphics created in ViewBuilder do not use translation files. Type non-English terms directly into the graphic in ViewBuilder.

Before you begin adding objects to a graphic:
1. Select **Configure > View Properties**.
2. In the **Language** field, select the language you want to use.
3. Click **OK**.
To set the default language and font

If your system has language packs installed, you can select a language to be the default language for all new graphics that you create in ViewBuilder. You can then change the language selection for an individual graphic in its View Properties.

To set the default language:

1. Select `Configure > Preferences > Graphic (.view)`.
2. On the Languages tab, check the language that you want to be the default.
3. Optional: Click on the name in the Font column to select a different font. Your selection affects only how text in your graphic appears in ViewBuilder.

Creating a graphic for a multi-language system using WebCTRL® extensions for FrontPage

When you create a graphic using WebCTRL® extensions for FrontPage, you enter a key term instead of text in the graphic. When the graphic is displayed in the WebCTRL® interface, the key term is replaced with its equivalent in the translation file for the current operator language. See Creating control programs and translation files (page 199).

To enter a key term for an image area label:

1. Double-click the image area label.
2. Enter a key term in the Label Text field.
   
   **NOTE** Use only alphanumeric characters and underscores (no spaces). Do not start a key term with a number.
3. Select Label Text is resource key.
4. Do one of the following:
   
   - If the translation file for the graphic is in `WebCTRL\webroot\<system_name>\graphics\lvl5`), leave the Resource field blank.
   - If the translation file is in `WebCTRL\webroot\<system_name>\resources`, enter the following in the Resource field: `resources<translation file prefix>`

   **EXAMPLE** `resources\translation`
5. Click OK.

To enter a key term for other text:

1. Click the International Text button .
3. Type the key term in the Key field.
4. Enter the location of the translation file in the Resource field. See step 4 above.
5. Click OK.
Creating a non-English system in SiteBuilder

To choose the language(s) for your system

1. In SiteBuilder, select Configure > Preferences.
2. Select the Language tab.
3. Under Supported Languages, select each language that you want to be available in your system.
   
   NOTE: This list shows all installed language packs. To install additional languages, see Installing a language pack (page 197).
4. In the System field, select the system Language (page 203).
5. Click OK.
6. Save your database.

To create your system

To create your system in each language that the system will display:

1. In SiteBuilder, select Configure > Preferences.
2. Optional: The Font tab shows the font that will be displayed in SiteBuilder for each language that you selected on the Language tab. To change a font, click on the name in the Preview Font column, then make a new selection.
3. On the Language tab, select a language in the Current Session field.
4. Click OK.
5. Create your system.
6. Save your database.
7. If your system will display multiple languages:
   
   a) Select Configure > Preferences, select the Language tab, and select another language in the Current Session field.
   
   b) Re-enter all node names and display names in the current language.
   
   c) Save your database.
   
   d) Repeat steps a. through c. for each additional language the system will display.

System language

The system language is used for:

- The default language for new operators
- Alarms sent to the database
- State text and object names downloaded to the field
- The default login page *

All other information is displayed in the operator’s language, which may be different than the system language. See To set an operator’s language in the WebCTRL® interface (page 204).

* You can change the language shown on the WebCTRL® login page by selecting a different language from the list below the Password field.
To set an operator's language in the WebCTRL® interface

An operator can change their language preference in the WebCTRL® interface.

1. On the **System Configuration** tree, select **My Settings**.
2. Under **Preferences**, select the **Language** in the drop-down list.
3. Click **Accept**.

Editing translation files, control programs, or graphics for a non-English system

If you add or edit a key term in a control program or graphic, be sure to make the same change in the translation file. See *Creating control programs and translation files* (page 199).

If you make changes after attaching a control program or graphic in SiteBuilder, do one of the following:

- If you changed text only in a control program or its translation file, right-click the control program on the **Geographic** tree, then select **Rebuild Equipment Pages**.
- If you changed logic in the control program, right-click the control program on the **Geographic** tree, then select **Reload Control Program**.
- If you changed a translation file located in WebCTRL\webroot\<system_name>\resources, right-click each applicable graphic on the **Geographic** tree, then select **Rebuild Graphic Resources**.

To edit a bundled resource

The EIKON® application bundles (embeds) the translation file(s) for a control program into the .equipment file. See steps 3 through 5 in *To create and implement a translation file* (page 200). To edit a bundled translation file:

1. Open the control program in the EIKON® application.
2. Select **Control Program > Bundled Resources**.
3. Select the file, then click to save it to your hard drive.
4. Edit the translation file.
5. In the **Bundled Resources** dialog box in the EIKON® application, click and select the edited file.
6. Click **OK** to overwrite the existing file.

Editing an EIKON® for WebCTRL control program in the EIKON® application

To edit a non-English control program that you created in the EIKON® for WebCTRL application:

1. Open the .eiw or .equipment file in the EIKON® application, then make your edits.
2. Select **Control Program > Bundled Resources**.
3. Verify that the list shows all translation files specifically for the control program. Use the plus or minus button to add or delete translation files.

**NOTE** This list shows the translation files in the WebCTRL\webroot\<system_name>\programs folder. This list should not include translation files for multiple control programs or graphics.
4 Click **OK**.

5 Save the control program. The translation files are bundled with the control program; the original files are no longer necessary.

**NOTE** If you need to change a translation file after you save the control program, see *To edit a bundled resource* (page 204).

---

**Copying translation files to another system**

To copy most translation files from one system to another, you copy the files in the source system and paste them into the same folders in the destination system.

However, if your source system and destination system have translation files with the same name, copying and pasting would overwrite the file(s) in the destination system. In this case:

1 Open the source system’s translation file in a text editor, then copy the key terms and translations.

2 Open the destination system’s translation file in a text editor, then paste into it the key terms that you copied. Remove any duplicate key terms.
Web services

Using web services to retrieve or change data

Web services are:

- A class of data exchange using XML (extensible markup language) and SOAP (simple object access protocol)
- Self-contained, modular applications that can be run over the Internet and can be integrated into other applications
- A standardized method for combining remote applications distributed over the Internet so that they may work together for a common purpose
- Application-to-application interfaces

Using web services, you can retrieve information or set values for items accessible through the WebCTRL® Geographic or Network tree. You can retrieve trend data, reports, present values, setpoints, and any other BACnet object property information from a remote WebCTRL® server and import the information into a SOAP client such as Microsoft® Excel®. You can also set present values, setpoints, and any other object property information on a remote WebCTRL® server. The web services examples we provide use Microsoft Excel as the SOAP client, but you can use other software packages.

**NOTE** To use web services with Microsoft Excel or Microsoft Word:

- You should be comfortable writing Visual Basic scripts and setting up macros.
- You must install the Soap Toolkit found at http://download.microsoft.com/download/xml/Install/3.0/W982KMeXP/EN-US/SoapToolkit30.EXE.

WebCTRL® privilege requirements

You should create a WebCTRL® operator and a privilege set whose specific purpose is web services. The privilege set must have the following privileges:

- Remote Data Access
- Access Geographic Locations or Network Locations, as needed
- Access Network items, as needed
- Any privileges needed for the specific task

Every change made through web services is recorded in the Audit Log. If you do not want these changes recorded in the Audit Log, add the following privilege to the privilege set:

- Do not audit changes made using SOAP (Web Services)
WebCTRL® data access using SOAP

NOTE The operator attempting to use SOAP must have the Remote Data Access privilege.

You can use the following services with WebCTRL® data:

- **Eval** - Returns the value for the given path.
- **Trend** - Returns trend data for a specified point
- **Report** - Returns the WebCTRL® report in CSV or HTML format
- **System** - Returns a path to a folder in the system folder where an add-on application can store data so that it is backed up with other system files.

The information below gives the WSDL, methods, and parameters for each service.

NOTE You may discover other methods in our web services that are not listed below, but these are for internal use only and not intended for use by our customers.
1. Eval

See:
Example using web services to set a value (page 212)
Example using web services to retrieve values (page 214)

WSDL:
http://<WebCTRL_server>/_common/webservices/Eval?wsdl

Methods:

a. String getValue(String expression)
   Returns the raw value for the given expression.

b. String [] getValues(String [] expressions)
   Returns an array of the raw values for the given expressions.

c. String getDisplayValue(String expression)
   Returns the display value for the given expression.

d. String [] getDisplayValues(String [] expressions)
   Returns an array of the display values for the given expressions.

e. setValue(String expression, String rawVal, String reason)
   Sets the given raw value for the expression.

f. setValues(String [] expressions, String [] rawVals, String reason)
   Sets an array of the given raw values for the expressions.

g. setDisplayValue(String expression, String displayVal, String reason)
   Sets the given display value for the expression.

h. setDisplayValues(String [] expressions, String [] displayVals, String reason)
   Sets an array of the given display values for the expressions.

Parameters:

- expression:
  For Methods a. through d., it is the path to the value to be evaluated. For points, expression
  only needs to refer to the microblock; present_value is assumed.
  For Methods e. through h., it is the path to the value to be set

- rawVal: The raw value (for instance, 1, indicating a On status)

- displayVal: The display value (for instance, “On”, indicating On status)

- reason: Reason for the change.

* raw value versus display value: For a binary input that is on, the raw value would be "1".
  For an operator whose default language is English, the display value would be "On". The
  display value is in the operator’s default language.

** reason can be used if you need to comply with 21 CFR Part 11 (page 142).
NOTE Methods b, d, f, and h above process multiple expressions. If an expression causes an error, only that expression returns an error. The remaining expressions are processed as intended.

- For an expression that gets a value, an error is indicated by [ERROR]: error message. Correctly processed expressions return a value.
- For an expression that sets a value, an error is indicated by [ERROR]. Correctly processed expression return [OK].

2. Trend
See Example using web services to retrieve trend data (page 217).

**WSDL:**
http://<WebCTRL_server>/_common/webservices/Trend?wsdl

**Method:**
getTrendData(String trendLogPath, String sTime, String eTime, boolean limitFromStart, int maxRecords)

Retrieves trend records for a given point or a trend log. A series of (time, value) pairs representing trend samples is returned.

The first element of the array is the time for the first sample, second element of the array is the trend data value for the first sample. The third element is time for second sample fourth element is trend data value for second sample etc. The returned array is in the following format:

<table>
<thead>
<tr>
<th>Time</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/02/2002 10:22:00 AM</td>
<td>Time for first sample</td>
</tr>
<tr>
<td>76.1</td>
<td>Trend data value for first sample</td>
</tr>
<tr>
<td>10/02/2002 10:22:30 AM</td>
<td>Time for second sample</td>
</tr>
<tr>
<td>76.1</td>
<td>Trend data value for second sample</td>
</tr>
<tr>
<td>10/02/2002 10:23:00 AM</td>
<td>Time for third sample</td>
</tr>
<tr>
<td>76.2</td>
<td>Trend data value for third sample</td>
</tr>
</tbody>
</table>
Parameters:

- **user**: WebCTRL® operator login Id. This user should have the Remote Data Access privilege.
- **password**: Password for the above WebCTRL® user.
- **trendLogPath**: The full path to the point, or trend log node whose trend data is desired. For example, #mxm/ai_interval, or #mxm/ai_interval/trend_log
- **sTime**: Start Time. Returns trend data values starting with this time.
- **eTime**: End Time. Returns trend data values until this time.
- **limitFromStart**: If maxRecords is >0, use True to retrieve maxRecords from the start (sTime if specified or the first record in the database); use False to retrieve maxRecords from the end (eTime if specified or the last record in the database)
- **maxRecords**: Maximum number of records desired. Use a number >0 to limit records; use 0 to retrieve unlimited records. If using 0, you must specify sTime and eTime; limitFromStart will be ignored.

NOTES

- **sTime and eTime format**: MM/dd/yyyy hh:mm:ss aa. Example: 10/02/2002 10:22:00 AM
- If you do not want to specify a start time or end time, use NULL or an empty string for the sTime or eTime. In this case, maxRecords must be >0.

EXAMPLES

- **sTime=04/07/2007 12:00:00 AM**
  - **eTime=NULL**
  - **limitFromStart=True**
  - **maxRecords=10**
  - The first 10 records starting on 4/7/2007 at 12:00:00 AM will be returned.

- **sTime=NULL**
  - **eTime=NULL**
  - **limitFromStart=False**
  - **maxRecords=10**
  - The most recent 10 records in the database will be returned.

- **sTime=04/07/2007 12:00:00 AM**
  - **eTime=04/10/2007 11:59:00 PM**
  - **limitFromStart=False**
  - **maxRecords=0**
  - All records in the database between 04/07/2007 12:00:00 AM and 04/10/2007 11:59:00 PM will be returned.
3. Report

See Example using web services to retrieve a report (page 220).

WSDL:

Methods:

a. String runReport(String location, String reportName, String extension)
   Runs the named report at the given location and returns the result as a large
   string with embedded carriage returns.

b. String [] runReportCsvLines(String location, String reportName)
   Runs the named report at the given location and returns an array of individual CSV
   lines. The caller must still parse each line.

Parameters:

- location: The location to run the report at in the database
- reportName: The name of a built-in report or the reference name of a custom report

Built-in report names:
- ~schedule-instance
- ~effective-schedule
- ~point-list-report
- ~locked-value
- ~network-io
- ~test-and-balance
- ~equipment-checkout
- ~audit-log
- ~alarms
- ~alarm-source
- ~network-status
- ~module-version
- ~security-assignment
- ~alarm-messages
- ~alarm-actions
- ~trend-usage
- ~parameter-mismatch

- extension: Type of report to run, CSV or html
4. System

**WSDL:**
http://<WebCTRL_server>/_common/webservices/System?wsdl

**Method:**
String getWebAppStorageDirectory(String webAppName)
Returns a path to a folder in the system folder where a web application can store data. The web application is responsible for creating the folder.

**Parameter:**
webAppName: A name unique to the web application.

---

**Example using web services to set a value**

Follow the process below to change a BACnet Binary Point's:

- Raw value in the WebCTRL® database and controller
- Display value shown in the WebCTRL® interface

**Step 1: Create a spreadsheet**

1. Enter the following information the spreadsheet uses to log in to the WebCTRL® system.
   - WebCTRL® server IP address or the server network name (Cell A1 in this example)
   - Operator name for logging in to the WebCTRL® application (Cell A2 in this example)
   - Operator’s WebCTRL® password (Cell A3 in this example)

2. Enter the path to the property whose raw value you want to set (Cell A5), then enter the raw value (Cell B5).
   
   **NOTE** You can use an absolute path, such as /trees/geographic/points/io_points/m001, or a global reference name.

3. Enter the path to the property whose display value you want to set (Cell A6), then enter the display value (B6).

4. If you need to comply with 21 CFR Part 11 (page 142), enter the reason the values are being changed (Cell C5 and C6).

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>192.168.162.170</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>administrator</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>abc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>#o_points/m02'/locked</td>
<td>TRUE</td>
<td>Fan needs maintenance</td>
</tr>
<tr>
<td>6</td>
<td>#o_points/m02'/locked_value</td>
<td>On</td>
<td>Fan needs maintenance</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Step 2: Create a macro**

The macro will write the values from the spreadsheet to the WebCTRL® system.

The following steps correspond to the numbered parts of the code shown below.

1. Name the subroutine (testSoapWrite) that will set the value in the WebCTRL® application.
2. Define which spreadsheet cells contain the:
   - host (WebCTRL server)
   - user (WebCTRL operator)
   - password (WebCTRL operator's password)
3. Identify the web services program that allows the spreadsheet to access the WebCTRL server over the network or Internet.
4. Enter the code to authenticate the user.
5. Enter the error handling code.
6. Enter the code that uses the setValue method to set the raw value.
7. Enter the code that uses the setDisplayValue method to set the display value.
8. This displays an error checking statement if an error is found in the data.

```vba
Sub testSoapWrite()
    host = Range("A1").Value
    user = Range("A2").Value
    passwd = Range("A3").Value
    Dim changeReason As String
    Dim client As MSSOAPLib30.SoapClient30
    Set client = CreateObject("MSSOAP.SOAPClient30")
    URL = "http://" & host & "/_common/webservices/Eval?wsdl"
    client.mssoapinit (URL)
    client.ConnectorProperty("WinHTTPAuthScheme") = 1
    client.ConnectorProperty("AuthUser") = user
    client.ConnectorProperty("AuthPassword") = passwd
    On Error GoTo err
    i = 5
    expression = Range("A" & i).Value
    newValue = Range("B" & i).Value
    changeReason = Range("C" & i).Value
    client.setValue expression, newValue, changeReason
    i = 6
    expression = Range("A" & i).Value
    newValue = Range("B" & i).Value
    changeReason = Range("C" & i).Value
    client.setDisplayValue expression, newValue, changeReason
```

GoTo done
     err:
     Range("D" & i).Value = err.Description

done:

End Sub

NOTE If you have problems connecting to the WebCTRL® application using Visual Basic, add the following line:
client.ClientProperty("ServerHTTPRequest") = TRUE
above the line:
client.mssoapinit (URL)

Step 3: Run the macro

NOTE The WebCTRL Server application must be running.
1 In Microsoft® Excel®, click Tools > Macro > Macros.
2 Select the TestSoapWrite sub-routine.
3 Click Run. The macro will write the values into the WebCTRL® database and field controllers.
   NOTE Follow the steps below if you get an error message when you run the macro.
   a) In Excel, select Tools > Macro > Visual Basic Editor.
   b) In the Visual Basic editor, select Tools > References.
   c) Select the Microsoft Soap Type Library v3.0 and click OK.

Example using web services to retrieve values

Follow the process below to read the value of BACnet Binary Inputs.

Step 1: Create a spreadsheet

1 Enter the following information the spreadsheet uses to log in to the WebCTRL® system.
   o WebCTRL® server IP address or the server network name (Cell A1 in this example)
   o Operator name for logging in to the WebCTRL® application (Cell A2 in this example)
   o Operator's WebCTRL® password (Cell A3 in this example)
2 Enter the paths to the properties whose values you want to get (Cells A5, A6, and A7).
   NOTE You can use an absolute path, such as /trees/geographic/points/io_points/m001, or a global reference name.
The macro that will retrieve the values will write them to cells B5, B6, and B7.

Step 2: Create a macro

The macro will read the values from the WebCTRL® system and write them to the spreadsheet. The following steps correspond to the numbered parts of the code shown below.

1. Name the subroutine (testSoapRead) that will retrieve the values from the WebCTRL® application.
2. Define which spreadsheet cells contain the:
   - host (WebCTRL server)
   - user (WebCTRL operator)
   - password (WebCTRL operator's password)
3. Identify the web services program that allows the spreadsheet to access the WebCTRL server over the network or Internet.
4. Enter the code to authenticate the user.
5. Enter the error handling code.
6. Enter the code to allocate and specify the expressions to get.
7. Enter the code to get the values and insert them into the spreadsheet.
8. This displays an error checking statement if an error is found in the data.

```
Sub testSoapRead()
    host = Range("A1").Value
    user = Range("A2").Value
    passwd = Range("A3").Value
    Dim changeReason As String

    Dim client As MSSOAPLib30.SoapClient30
    Set client = CreateObject("MSSOAP.SOAPClient30")
    URL = "http://" & host & "/_common/webservices/Eval?wsdl"
    client.mssoapinit (URL)

    client.ConnectorProperty("WinHTTPAuthScheme") = 1
    client.ConnectorProperty("AuthUser") = user
    client.ConnectorProperty("AuthPassword") = passwd

    On Error GoTo err
```

The macro that will retrieve the values will write them to cells B5, B6, and B7.
REM VB arrays start at index 0 and are declared by the maximum index
REM some the next line declares an array of two strings at indices 0 and 1
Dim expressions (2) As String
Dim values (2) As String
Dim result() As String
expressions(0) = Range("A5").Value
expressions(1) = Range("A6").Value
expressions(2) = Range("A7").Value
result = client.getValues(expressions)
Range("B5") = result(0)
Range("B6") = result(1)
Range("B7") = result(2)
GoTo done
err:
Range("D" & i).Value = err.Description

done:

End Sub

NOTE If you have problems connecting to the WebCTRL® application using Visual Basic, add the following line:
client.ClientProperty("ServerHTTPRequest") = TRUE
above the line:
client.mssoapinit (URL)

Step 3: Run the macro

NOTE The WebCTRL Server application must be running.
1 In Microsoft® Excel®, click Tools > Macro > Macros.
2 Select the TestSoapRead sub-routine.
3 Click Run. The macro will write the values into the WebCTRL® database and field controllers.

NOTE Follow the steps below if you get an error message when you run the macro.
a) In Excel, select Tools > Macro > Visual Basic Editor.
b) In the Visual Basic editor, select Tools > References.
c) Select the Microsoft Soap Type Library v3.0 and click OK.
Example using web services to retrieve trend data

Follow the process below to retrieve a collection of zone temperature samples and put it in an Excel spreadsheet.

Step 1: Create a spreadsheet
1. Enter the following information the spreadsheet uses to log in to the WebCTRL® system.
   - WebCTRL® server IP address or the server network name (Cell A1 in this example)
   - Operator name for logging in to the WebCTRL® application (Cell A2 in this example)
   - Operator's WebCTRL® password (Cell A3 in this example)
2. Enter the path to the trend object you want to retrieve (Cell A5 in this example).
   **NOTE** You can also use an absolute path or a global reference name such as #zone_1.
3. Define the sample's start time (Cell A6) and end time (Cell A7), and the maximum number of samples to take (Cell A9).
4. The text in Cell A11 indicates where the results will be listed after the macro is run.

```
<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>132.168.162.170</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>administrator</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>abc</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>#av7/zone TEMP/TREND_LOG</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>1/13/07 8:00 AM</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>1/13/07 5:00 PM</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Results:</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

The macro will retrieve the trend data and write the time of each sample in column A and the corresponding zone temperature in column B.

Step 2: Create a macro
The macro will retrieve the values from your system's trend log and put them in the spreadsheet.
The following steps correspond to the numbered parts of the code shown below.

1. Name the subroutine (evalTrends) that will retrieve the trend data from the WebCTRL® application.
2. Define which spreadsheet cells contain the:
   - host (WebCTRL server)
   - user (WebCTRL operator)
   - password (WebCTRL operator's password)
Add this section to define the trend data you want to retrieve from the path in cell A5. This retrieves trends from startDate to endDate:
LimitFromStart - to retrieve maxRecords from beginning if true; from end if false
MaxRecords - the maximum numbers of records to retrieve
expression - the expression to evaluate

Identify the web services program that allows the Excel spreadsheet to retrieve the data from the WebCTRL server over the network or Internet.

Enter the code to authenticate the user.

Enter the error handling code.

Add this code to retrieve the trend data and displayed it.

This displays an error checking statement if an error is found in the data.

```
Sub evalTrends()
    host = Range("A1").Value
    user = Range("A2").Value
    passwd = Range("A3").Value
    startDate = Format(Range("A6").Value, "mm/dd/yyyy hh:mm:ss AM/PM")
    endDate = Format(Range("A7").Value, "mm/dd/yyyy hh:mm:ss AM/PM")
    limitFromStart = Range("A8").Value
    MaxRecords = Range("A9").Value
    expression = Range("A5").Value
    Dim client As MSSOAPLib30.SoapClient30
    Set client = CreateObject("MSSOAP.SOAPClient30")
    URL = "http://" & host & "/_common/webservices/Trend?wsdl"
    client.mssoapinit (URL)
    client.ConnectorProperty("WinHTTPAuthScheme") = 1
    client.ConnectorProperty("AuthUser") = user
    client.ConnectorProperty("AuthPassword") = passwd
    On Error GoTo err
    Dim result1() As String
```
result1 = client.getTrendData(expression, startDate, endDate, limitFromStart, maxRecords)

Dim i, row, index, size As Integer
index = 0

Rem results is time/value string pairs
Rem compute size: result is 0 based, so add one to UBound to get size
size = (UBound(result1) + 1) / 2

For i = 1 To size
    row = i + 11
    Range("a" & row) = result1(index)
    Range("b" & row) = result1(index + 1)
    index = index + 2
Next

GoTo done

err: Range("a10") = err.Description

done:

End Sub

NOTE If you have problems connecting to the WebCTRL® application using Visual Basic, add the following line:
client.ClientProperty("ServerHTTPRequest") = TRUE
above the line:
client.mssoapinit (URL)

Step 3: Run the macro

NOTE The WebCTRL Server application must be running.
1 To launch and run the macro, click Tools.
2 Click Macro > Macros.
3 Select the evalTrends sub-routine.
4 Click Run. The macro will retrieve the data and place it in the spreadsheet.

NOTE Follow the steps below if you get an error message when you run the macro.
a) In Microsoft® Excel®, select Tools > Macro > Visual Basic Editor.
b) In the Visual Basic editor, select Tools > References.
c) Select the Microsoft Soap Type Library v3.0 and click OK.
Example using web services to retrieve a WebCTRL® report

Follow the procedure below to retrieve a WebCTRL® Point List report and put it in an Excel spreadsheet.

**Step 1: Create a spreadsheet**

1. Enter the following information the spreadsheet uses to log in to the WebCTRL® system.
   - WebCTRL® server IP address or the server network name (Cell A1 in this example)
   - Operator name for logging in to the WebCTRL® application (Cell A2 in this example)
   - Operator's WebCTRL® password (Cell A3 in this example)
2. Enter the path to the WebCTRL® report (Cell A5 in this example).
   **NOTE** You can also use an absolute path or a global reference name such as #zone_1.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>1</td>
<td>192.168.162.170</td>
</tr>
<tr>
<td>2</td>
<td>administrator</td>
</tr>
<tr>
<td>3</td>
<td>abc</td>
</tr>
<tr>
<td>4</td>
<td>/trees/geographic/chiller</td>
</tr>
<tr>
<td>5</td>
<td>~point-list-report</td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
</tbody>
</table>

The macro will write the report data to Cell B1.

**Step 2: Create a macro**

The macro will retrieve the report data and add it to the spreadsheet.

The following steps correspond to the numbered parts of the code shown below.

1. Name the sub-routine (TestReport) that will retrieve the report.
2. Define which spreadsheet cells contain the:
   - host (WebCTRL server)
   - user (WebCTRL operator)
   - password (WebCTRL operator's password)
3. Identify the web services program that allows the Excel spreadsheet to retrieve the report from the WebCTRL server over the network or Internet.
4. Enter the code to authenticate the user.
5. Enter the error handling code.
6. Enter the code to run the report.
7. This displays an error checking statement if an error is found in the data.
Sub TestReport()

host = Range("A1").Value
user = Range("A2").Value
passwd = Range("A3").Value

Dim client As MSSOAPLib30.SoapClient30
Set client = CreateObject("MSSOAP.SOAPClient30")
URL = "http://" & host & 
"/_common/webservices/Report?wsdl"

client.mssoapinit (URL)

client.ConnectorProperty("WinHTTPAuthScheme") = 1
client.ConnectorProperty("AuthUser") = user
client.ConnectorProperty("AuthPassword") = passwd

On Error GoTo err

location = Range("A4").Value
report = Range("A5").Value

result = client.runReport(location, report, "csv")
Range ("B1").Value = result
GoTo done
err:
    Range("B1").Value = err.Description

done:
End Sub

NOTE If you have problems connecting to the WebCTRL® application using Visual Basic, add the following line:
client.ClientProperty("ServerHTTPRequest") = TRUE
above the line:
client.mssoapinit (URL)

Step 3: Run the macro

NOTE The WebCTRL Server application must be running.
1. To launch and run the macro, click Tools.
2. Click Macro > Macros.
4. Click Run. The macro will retrieve the data and place it in the spreadsheet.

NOTE Follow the steps below if you get an error message when you run the macro.
   a) In Microsoft® Excel®, select Tools > Macro > Visual Basic Editor.
   b) In the Visual Basic editor, select Tools > References.
   c) Select the Microsoft Soap Type Library v3.0 and click OK.
Important changes to this document are listed below. Minor changes such as typographical or formatting errors are not listed.

<table>
<thead>
<tr>
<th>Date</th>
<th>Topic</th>
<th>Change description</th>
<th>Code*</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/20/15</td>
<td>Working with control programs in the WebCTRL interface</td>
<td>Added bullet “Add a control program to a controller”</td>
<td>A-D-TI</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To add a control program to a controller</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>New topic</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>To replace an existing control program</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Changed instructions in step 4.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added optional step 5.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added note “In the Add Control Program dialog box...”</td>
<td></td>
</tr>
<tr>
<td>1/7/15</td>
<td>Cover page</td>
<td>Added export control statement at bottom, “This document does not contain technical data controlled by the EAR or ITAR.”</td>
<td>X-O-CY-E-CY</td>
</tr>
<tr>
<td>6/11/14</td>
<td>Send Alphanumeric page and Send E-mail</td>
<td>In section “To secure mailserver communication using Secure Sockets Layer (SSL)”, path in step 4 changed from:</td>
<td>X-TS-DB-F</td>
</tr>
<tr>
<td></td>
<td></td>
<td>C:\WebCTRL&lt;x.x&gt;\java&lt;operating_system&gt;\jre\bin\keytool.exe... to:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>C:\WebCTRL&lt;x.x&gt;\bin\java\jre\bin\keytool.exe...</td>
<td></td>
</tr>
</tbody>
</table>

* For internal use only
Index

A
Access database • 160, 173
Access User Category privilege • 130
action button • 25
action pane • 25
add-ons • 14, 177
Admin privilege set • 129, 133
advanced password policy • 142, 173
Advanced reporting actions • 83
advanced security • 138, 142
alarm actions • 77, 83, 103, 119, 183
alarm categories • 77, 106, 107, 112, 183
alarm messages • 83, 106, 112, 130, 138, 183
Alarm Notification Client • 14, 84, 171
Alarm Pop up action • 83, 84, 171
alarm source • 77, 83, 103
alarm templates • 26, 106, 109, 112, 130, 138, 171, 183
alarms • 14, 77
acknowledging • 78
alarm actions • 14, 77, 83, 103, 119
archiving deleted alarms • 176
changing settings • 77
deleting • 78, 82, 176
incident groups • 80, 176
simulating • 83, 106
sounds for alarms • 83, 136
viewing • 14, 78
All Content download • 48
apply update • 14, 26
arccnet manual command • 146
audible sounds for alarms • 78, 136
audit log • 14, 130, 138, 142, 173, 175
automatic logoff • 24, 133, 173
automatically collapse trees • 136
autopilot • 154
B
Back button • 25
backing up database • 160
BACnet alarm recipient instance • 175
BACnet binding conflicts • 14, 175
BACnet devices • 9
BACnet Discovery • 14
BACnet routers • 9
BACnet/IP • 183
BACview • 9
BACview files • 47, 195
BBMD • 48, 146
bbmd manual commands • 146
binary schedule category • 67
browser • 9, 23, 162, 165
C
category • 25, 26, 130
alarm • 77, 78, 83, 106, 112
graphic • 34
schedule • 67
category privilege • 129
checkurls manual command • 146
Chrome • 14, 21, 162, 165
client installs • 26
clipping • 183
colors • 30, 31
colors in WebCTRL® • 25, 31
compact the database • 160
comstat • 146
doctor programs • 39, 42, 44, 47, 183, 190
controllers • 23
copy manual command • 146
copying a path • 44
cost-saving strategies • 144
CSV (Comma Separated Values) • 121, 122
custom reports • 44, 119, 122, 123, 125, 127, 128
database, system • 23
back up • 160
database type • 160, 171
defragment • 160
maintenance • 160
minimize size • 161
date format • 171
Daylight Saving Time • 14, 177, 179
defragmenting the database • 160
demand control • 55, 144
Devices page • 51
disconnect manual command • 146
download • 14, 30, 47, 51, 54, 61, 130, 138, 146, 175, 177, 183, 190, 193, 195
download manual commands • 146
download options • 48
Downloads page • 47, 48
driver • 47, 130, 146, 183, 193
ingo manual commands • 146
Help button • 25
hierarchical servers • 14, 26, 60, 133, 138, 173, 175
historical trends • 70, 71, 161, 171, 176
hover text • 27
index • 67
interactive thermostat control • 37
Internet browser • 9, 14, 21, 23, 162, 165
Internet Explorer • 14, 21, 162, 165
IP address • 146
iPad • 14, 21, 162, 165
keyboard shortcuts • 183
labels • 42
language pack • 197
languages • 136, 197
license • 26, 179
links • 27, 181
local privileges • 138, 140
location-dependent operator access • 129, 138, 173, 183
location-independent operator access • 129, 138
logging in • 23, 129, 133, 136
logging out • 24, 133, 146, 173
Logic pages • 32, 42, 55, 130
login • 23, 133, 173, 181
login name • 133, 134
login, failed • 173
logoff • 134
Mac • 14, 162, 165
maintenance • 160
manual commands • 14, 146
Manual Commands/Console Operations privilege • 130, 146
markdownload manual commands • 146
memory • 70, 71
menu button • 25
menu commands • 25
microblock paths • 44
microblock pop-up • 32, 39, 42, 146
microblock properties • 32, 39, 42, 44
microblocks • 39, 42
Microsoft Surface • 14, 21, 162
minimize database size • 161

Geographic tree • 25, 26
global copy • 44, 46, 71, 146
global modify • 34, 39, 42, 44, 112
go manual commands • 146
Google Chrome • 14, 21, 162, 165
graphics • 14, 27, 34, 183, 197
attaching graphic files • 35
category • 36, 130
editing • 36
Graphics button • 36
Graphics pages • 32, 34, 55
group cache controllers • 179

Firefox • 14, 21, 162, 165
floorplans • 30
font • 197, 203
system database • 23
  back up • 160
database type • 160, 171
defragment • 160
maintenance • 160
minimize size • 161
system language • 171
system maintenance • 160
system name • 171
System Settings • 14, 26, 171
System-wide alarms button • 25
system-wide privileges • 134, 138

T
  tab • 25
tablet • 14, 21, 162, 165
TCP ports • 84
TCP/IP • 9
thermographic colors • 31
time format (12-hour or 24-hour) • 171
time synchronization • 171, 176, 179
time zone • 176, 177, 179
Time-lapse • 14, 25, 117
timesync manual command • 146
TLS/SSL • 156
touchscreens • 47, 195
translation file • 199, 204
tree icons • 27
trend data • 43, 70, 71, 76, 176
Trend Samples report • 119, 125
trends • 14, 44, 70
categories • 75
collecting data • 71
creating • 73
enabling historian • 71
historical • 70, 71, 76, 161, 176
trend graph • 73, 76
viewing • 72, 76
troubleshooting • 32, 42, 43

U
  upload • 51, 54, 175

W
  WAP • 156
  WAP devices • 156
  Web services • 206, 212, 214, 217, 220
  WebCTRL Server • 9, 23
    shutting down • 23
    starting • 23
  WebCTRL Server BACnet device instance • 175
  WebCTRL® action pane • 25
  WebCTRL® client • 9, 162
  WebCTRL® extensions for FrontPage • 199, 201
  WebCTRL® navigation • 25
  WebCTRL® navigation tree • 25
  WebDAV • 173, 186
  WebPRTL • 9
  whoson manual command • 146
  Windows service • 187
  Write Property alarm action • 83, 97
  Write to Database alarm action • 83, 98
  Write to File alarm action • 83, 102

X
  XLS • 122

Z
  zones • 55
  zooming in/out • 29